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Document Disclaimer
The information in this document has been carefully checked and is believed to be 
reliable. However, no responsibility can be assumed for inaccuracies that may not have 
been detected.

LeCroy reserves the right to revise the information in this document without notice or 
penalty.

Trademarks and Servicemarks
LeCroy, UWBTrainer, UWBTracer, UWBTracer MPI, CATC Trace, and BusEngine are 
trademarks of LeCroy. 

Microsoft and Windows are registered trademarks of Microsoft Inc.

Intel and Pentium are registered trademarks of Intel Corporation.

AMD Duron and AMD Athlon are trademarks of Advanced Micro Devices, Inc. 

All other trademarks are property of their respective companies.

Copyright
Copyright © 2007, LeCroy Corporation. All Rights Reserved.

This document may be printed and reproduced without additional permission, but all 
copies should contain this copyright notice.

FCC Conformance Statement Compliance with 
47 CFR 15.519 (a)(1)
This device complied with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation.

FCC Rule 47 CFR 15.519 (a)(1) states that “A UWB device operating under the 
provisions of this section shall transmit only when it is sending information to an 
associated receiver. The UWB intentional radiator shall cease transmission within 
10 seconds unless it receives an acknowledgement from the associated receiver that its 
transmission is being received. An acknowledgement of reception must continue to be 
received by the UWB intentional radiator at least every 10 seconds or the UWB device 
must cease transmitting. “

This equipment may only be operated indoors. Operation outdoors is in violation of 
47 U.S.C. 301 and could subject the operator to serious legal penalties.

Note: This device must be installed in a location that is not accessible to the general 
public. Install the device so that the antenna is more than 20 cm from unsuspecting 
personnel. Failure to install this device as described will result in a failure to comply with 
FCC rules for RF exposure and is discouraged. Only antennas approved with the device 
may be used. This device may not be co-located with other transmitters without further 
approval by the FCC.

Caution: Changes or modifications not expressly approved by the party responsible for 
compliance could void the operator’s authority to operate the equipment. 
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EU Declaration of Conformity
This equipment including all its options is in conformity with the provisions of the following 
EC directives(s), including all the latest amendments: 

73/23/EEC Low Voltage Directive

89/336/EEC EMC Directive

Conformity with Council Directive 73/23/EEC is based on: 

EN 61010-1: 2001 Safety requirements for electrical equipment for measurement, 
control and laboratory use

Conformity with Council Directive 89/336/EEC is based on: 

EN 61326/A3: 2003 EMC requirements for electrical equipment for measurement 
control and laboratory use

Emissions EN 55011/A2:2002 (Conducted and Radiated Emissions)

EN 61000-3-2/A2:2005 (Harmonic Current Emissions)

EN 61000-3-3/A2:2005 (Voltage Fluctuations and Flicker)

Immunity EN 61000-4-2/A2:2001 (Electrostatic Discharge) 

EN 61000-4-3/A1:2003 (RF Radiated Electromagnetic Field)

EN 61000-4-4:2004 (Electrical Fast Transient/Burst)

EN 61000-4-5/A1:2001 (Surge)

EN 61000-4-6/A1:2001 (RF Conducted Electromagnetic Field)

EN 61000-4-11:2004 (Mains Dips and Interruptions)

Warning: This is a Class A product. In a domestic environment this product may cause 
radio interference, in which case the user may be required to take adequate measures.
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WEEE Program

Part number: 730-0077-00

 

This electronic product is subject to  
disposal and recycling regulations that  
vary by country and region. Many  
countries prohibit the disposal of  
waste electronic equipment in  
standard waste receptacles. 
For more information about proper  
disposal and recycling of your LeCroy  
product, please visit  
www.lecroy.com/recycle. 
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Chapter 1:  Overview
This chapter describes the UWBTracer/Trainer™ product and Ultra-Wideband 
technology in general. 

1.1 UWBTracer/Trainer Ultra-Wideband Analyzers
The LeCroy UWBTracer/Trainer is a portable Ultra-Wideband (UWB) test and debug 
platform that combines non-intrusive recording with extensive decoding features. The RF 
(wireless) recording functionality is designed to record non-intrusively off-the-air WiMedia 
UWB traffic from one or more devices, while the MPI recording functionality is designed 
to connect to the specification-defined MAC-PHY Interface (MPI) bus between the MAC 
and the PHY subsystems in WiMedia-compliant devices and to capture the traffic 
between them. The WLP protocol uses the MUX sublayer and services of the WiMedia 
MAC for data networking. 

By leveraging years of experience in protocol analysis tools for emerging markets, 
UWBTracer/Trainer blends sophisticated functionality with practical features to allow 
designers and validation engineers to easily specify multi-level, conditional trigger 
scenarios to pinpoint intermittent problems in the UWB connection.

System-level validation requires non-intrusive monitoring. UWBTracer/Trainer ensures 
accurate data collection by providing transparent electrical taps. At the heart of 
UWBTracer/Trainer is the CATC BusEngine™ protocol processor that features a 
real-time recording engine for UWB MAC-to-PHY traffic.

UWBTracer/Trainer also supports remote operation over a LAN and unattended control 
of the analyzer with an Automation API. UWBTracer/Trainer includes an advanced 
search capability that allows to search for specific fields in the recorded trace and to 
navigate faster to places of interest inside the trace.

UWBTracer/Trainer features a real-time statistics display that continuously monitors and 
presents metrics for the recorded MAC-to-PHY traffic, providing a high-level view of 
network performance. 

For complete product information, please visit www.LeCroy.com.
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Table 1.1 summarizes key UWBTracer/Trainer features.

Table 1.1 UWBTracer/Trainer Features

Feature Benefit

Wireless capturing & recording Allows off-the-air (and non-intrusive) recording of UWB 
traffic

 MPI capturing & recording Probes the WiMedia specification-defined bus between the 
MAC and PHY layers, while remaining non intrusive. 
Suitable for three different popular connector types.

Simultaneous RF and MPI 
recording

Capable of recording one RF and one MPI channel at the 
same time and display a combined trace

Advanced Triggering Robust capability of setting complex triggering and filtering 
sequences and act in real-time on those settings on each of 
the channels.

Trace View Comprehensive viewing of the recorded traffic with 
convenient customization through the trace display options.

Advanced search Fast and comprehensive trace searches.

Collapsible/expandable header Increased drill-down on exchanges, sequences, or individual 
frames.

Real-time performance monitoring 
and statistics

Allows easy identification of throughput problems and 
anomalies.

Dynamically-allocated memory 
pool

(2 GB) Captures long time-windows for analysis and 
problem-solving.

Interchangeable Radios and room 
for future expansion

The modular design of the UWBTracer/Trainer™ and the 
CATC 5K platform permits interchanging modules and 
radios

WLP protocol Uses the MUX sublayer and services of the WiMedia 
MAC for data networking
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1.2 Ultra-Wideband Technology
UWB technology was available for over 40 years for military and civilian applications and 
was originally called either impulse radio or carrier-free communications. Today, the FCC 
definition for UWB is any radio technology with a spectrum that occupies greater than 20 
percent of the center frequency or a minimum of 500MHz. 

In 2002, the FCC allocated unlicensed radio spectrum from 3.1 GHz to 10.6 GHz 
expressly for enterprise and consumer applications. The FCC defined a specific 
minimum bandwidth of 500 MHz at a -10dB level. As current UWB implementations allow 
communication that requires high data rates over short distances, one immediate UWB 
application is WPAN (Wireless Personal Area Network).

The Multi-band OFDM technology, promoted by the WiMedia Alliance, is one of the 
technologies that can utilize the allocated band for UWB. The MB-OFDM transmits data 
simultaneously over multiple carriers spaced apart at precise frequencies. This approach 
provides benefits like high spectral flexibility and resiliency to RF interference and 
multi-path effects. 

The WiMedia UWB specifications are available from the WiMedia Alliance. The URL for 
the WiMedia website: 

http://www.wimedia.org

1.3 WiMedia UWB Specification Ecosystem
The WiMedia Alliance has developed specifications for ultra-wide-band (UWB) devices. 
The main goal of the WiMedia UWB specifications is to create a UWB “ecosystem” that 
allows easy and secure operation of UWB devices. 

The WiMedia UWB specifications have a first-generation data rate of 480 Mbps, which 
enables a multitude of innovative wireless devices. UWB devices that follow the 
WiMedia UWB specifications can co-exist in the same physical environment, even if they 
have unrelated applications. 

Markets for two major application types are emerging: 

• Certified Wireless-USB (WUSB)
• WLP
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1.3.1 Certified Wireless USB Overview
The WiMedia UWB specification first-generation data rate of 480 Mbps provides a basis 
for delivering WUSB devices that can perform comparably with USB 2.0 devices. 

The Certified Wireless-USB protocol maintains the same host-device model as the wired 
USB protocol, but the Certified Wireless-USB protocol makes many optimizations for 
operating efficiently on a wireless medium. 

The first Certified Wireless-USB-protocol products are various Wire Adapter devices, 
which operate as wired-to-wireless bridges. Host Wire Adapters (HWA) enable any PC 
with USB 2.0 to become a WUSB Host. Device Wire Adapters (DWA) are wireless hubs 
that can connect wired USB 2.0 devices to a WUSB Host. 

For Certified Wireless-USB-protocol devices, UWBTracer/Trainer provides full protocol 
decoding from low-level packets to high-level Wire Adapter transfers.

The WUSB specification is available from the USB Implementers Forum (USB-IF). The 
URL for the USB-IF website is:

http://www.usb.org/home

1.3.2 WLP Overview
WLP is a protocol that uses the services of the WiMedia MAC for data networking. 

The WLP protocol uses the MUX sublayer and service defined in the WiMedia MAC 
specification. The MUX sublayer combined with the WLP protocol corresponds to the 
logical link control sublayer of the standard ISO/OSI IEEE 802 reference model. 

For more information about the WLP protocol, MUX sublayer and service, and WiMedia 
MAC specification, see the WLP specification at www.WiMedia.org.
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Chapter 2:  Hardware Description
This chapter describes the CATC 5K-based UWBTracer/Trainer™ Analyzer and 
Exerciser and other components and accessories that accompany it.

2.1 CATC 5K Platform

CATC 5K Platform
The CATC 5K is a lightweight and modular platform, designed to be mobile and flexible. 
The two front slots can accommodate up to two plug-in modules with a variety of options. 
The CATC 5K platform is powered by a small external power supply. Quiet built-in fans 
provide all the necessary cooling.

Connection to Host Machine
The CATC 5K platform connects to a Windows®-based PC (the host machine) through a 
single USB cable. Though the system can operate over USB 1.1 protocol data rates, it is 
advisable to use a USB 2.0 connection between the Analyzer and the host machine to 
obtain faster upload of traffic.

2.2 UWBTracer/Trainer Analyzer and Exerciser
The basic UWBTracer/Trainer analyzer configuration includes a CATC 5K platform and a 
UWB Analyzer plug-in module (UW002MA or UW003MA) that is inserted into the 
right-side slot.

In addition, the USB Analyzer plug-in module (US007MA) can be inserted into the 
left-side slot and be used for capturing USB Association traffic, retrieving the information 
required for pairing two WUSB devices. See “USB Cable Association for Certified WUSB” 
on page 220 for more information.

The UWB Exerciser plug-in module can be inserted into the left-side slot and be used for 
traffic generation.
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2.3 System Components

Basic Components
The UWBTracer/Trainer™ basic package includes the following components:

• Installation CD-ROM, with the installation program and all documents
• UWBTracer/Trainer Getting Started manual, to help set up the system quickly
• CATC 5K Platform: See photograph on front cover. Also see “CATC 5K Front Panel 

with the UWB Analyzer Plug-in” on page 14 and “CATC 5K Rear Panel” on page 18.
• CATC 5K Power Supply and Power Cord
• Carrying case
• Vertical Stand 

Figure 2.1 Vertical Stand

• UWB Analyzer Module and RF Antenna

Figure 2.2 UWB Analyzer Plug-in Module with Antenna (UW002MA or 
UW003MA)
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• RF Coaxial Cable (SMA) [in Standard Cable Kit]
• USB cable for connecting the analyzer to a host machine 

Figure 2.3 USB cable and RF Coaxial Cable (SMA)

• Synchronization Cable for synchronizing multiple analyzers. The Synchronization 
Cable connects to the SYNC IN and SYNC OUT connectors located on the 
UWBTracer/Trainer rear panel (Figure 2.15). (For more information about setting up 
multiple analyzers, see Section 10.3, “Multiple Analyzer Synchronization” on page 
158.) 

Figure 2.4 Synchronization Cable and Trigger Cable

• Trigger Cable (TRIG-IN/TRIG-OUT BNC Y-cable) for connecting to external equip-
ment (for example, for triggering capturing in a LeCroy oscilloscope). 
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Optional Components
In addition to the basic package, optional components are available:
• USB Analyzer plug-in module for capturing USB Cable Association traffic 

(US007MA)

Figure 2.5 USB Analyzer Plug-in Module (US007MA)

• UWB Analyzer plug-in module with PHY (radio) from a different vendor  
(UW002MA or UW003MA)  
[see Figure 2.2]

• MPI Kit (please refer to the Data Sheet for detailed information)  
[see next page]



UWBTracer/Trainer  User Manual Chapter 2: Hardware Description

LeCroy Corporation  11

• UWBTrainer Exerciser plug-in module and RF Antenna

Figure 2.6 UWB Exerciser Plug-in Module with Antenna (UW005MGA)

Note:  To meet FCC requirements, the UWBTrainer exerciser and some models of 
the UWBTracer analyzer have reverse-polarity radio and antenna 
connectors. This configuration does not affect RF behavior in any way but 
does require that you configure a customer-supplied antenna with 
reverse-polarity connectors.
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MPI Kit
The MPI kit is designed for hooking to the MPI bus in two types of setups:
1. PHY subsystem connects to the MAC subsystem through a short (ribbon) cable.
2. PHY subsystem piggybacks directly on the MAC subsystem. The two subsystems 

connect through an adapter board without the use of cables.

Three types of connectors are common for current designs:
1. IDE 40-pin connector
2. Hirose 68-pin Connector
3. Hirose 60-pin Connector
The optional MPI Kit includes: 

Figure 2.7 MPI Kit

• Cable Adapter for Hirose 68-pin or IDE 40-pin Connectors 

Figure 2.8 Cable Adapter for Hirose 68-pin or IDE 40-pin Connectors
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• Probe Cable for IDE 40-pin Connectors and Hirose 68-pin Connectors (2) 

Figure 2.9 Probe Cable for IDE 40-pin Connectors and 
Hirose 68-pin Connectors

• Adapter Cable 

Figure 2.10 Adapter Cable (with external SCSI type connectors)

• Board Adapter for IDE 40-pin Connectors, Board Adapter for Hirose 68-pin Connectors, and 
Board Adapter for Hirose 60-pin Connectors 

Figure 2.11 Board Adapter for IDE 40-pin Connectors,  
Board Adapter for Hirose 68-pin Connectors, and  
Board Adapter for Hirose 60-pin Connectors
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2.4 UWBTracer/Trainer Front Panel Description
When powered ON, the CATC 5K Analyzer activates user-accessible controls and LEDs 
on front and rear panels of the platform. This section covers front panel features. The next 
section covers rear panel features.

Figure 2.12 CATC 5K Front Panel with the UWB Analyzer Plug-in

CATC 5K Platform
The indicators on the CATC 5K platform (Figure 2.12) are:

STATUS (status of the platform)
LED Description

 No light System is not powered on

 Green Blink Slow Initializing

 Blue System is operational

 Red Blink Fast System fault (contact Support)
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UWB Analyzer Plug-in Module

LEDs (status of the MPI or RF channel)

Connectors
The connectors are:

• MPI ADAPTER: Connector to MPI Adapter
• ANT: SMA Connector for Antenna

LED State MPI Channel  RF Channel
 No light Idle Does not detect PCLK or 

PHY_ACTIVE
Does not detect wireless 
frames

 Yellow Blink Fast Synching Trying to synchronize to 
MPI traffic and waiting for 
PCLK and PHY_ACTIVE

Trying to synchronize to 
RF traffic and waiting for 
wireless traffic

 Yellow Synched Synchronized: 
Capturing MPI traffic with 
PHY_ACTIVE signal high

Synchronized: 
Capturing wireless frames

 Red Blink Slow Recording 
Pre-Trigger

Recording 
Pre-Trigger traffic

Recording 
Pre-Trigger traffic

 Red Recording 
Post-Trigger

Recording 
Post-Trigger MPI traffic

Recording 
Post-Trigger wireless 
traffic
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USB Analyzer Plug-in Module for the 
USB Cable Association
In the UWBTracer/Trainer™ setup, the USB Analyzer plug-in module is used to capture 
USB Association traffic between pairs of WUSB devices that support the 
USB Cable Association Model described in the Certified Wireless USB specifications.

Figure 2.13 CATC 5K Front Panel with the UWB Analyzer and 
USB Analyzer Plug-in

USB Cable Association traffic capture uses CHAN 0 of the module.  
The second channel, marked CHAN 1, is for future expansion.

For instructions on how to set up and capture USB Cable Association traffic and use it for 
UWB traffic recording, see “USB Cable Association for Certified WUSB” on page 220.

LEDs (status of the USB Chan 0 channel)

Note:  For USB Chan 1, the LEDs are turned off because they are not used for the 
USB Cable Association traffic capture.

Connectors
The connectors are:

• CHAN 0 USB PORTS: For capturing USB Cable Association traffic
• CHAN 1 USB PORTS: Not currently used

LED State
 No light Idle

 Yellow Blink Slow Synched to Full/Low speed USB traffic

 Yellow Blink Fast Synched to High speed USB traffic

 Red Blink Fast a few times Connection Context traffic detected
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UWB Exerciser Plug-in Module
When powered ON, the UWB Exerciser activates user-accessible controls and LEDs on 
front and rear panels of the platform. This section covers front panel features. The next 
section covers rear panel features.

Figure 2.14 UWB Exerciser Plug-in Module

LEDs (status of the Exerciser RF channel)

Connectors
The connectors are:

• ANT: SMA Connector for Antenna
• AUXILIARY: Connector

LED State
 No light Idle

 Yellow Blink Fast Scenario running

 Yellow Blink Slow Scenario waiting for condition

 Yellow Solid Scenario paused

 Red Solid Scenario error
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2.5 UWBTracer/Trainer Rear Panel Description
From left to right, the rear panel contains the following components: 

Figure 2.15 CATC 5K Rear Panel

• SYNC IN/OUT: For synchronized multi-analyzer operation, the analyzers must be 
connected in a daisy-chain topology to each other using the green/purple cable.

• EXT DATA: For attaching the TRIG-IN/TRIG-OUT BNC Y-cable (Trigger Cable) to 
external instruments

• HOST: For connecting the analyzer through USB to the host machine
• POWER 12 VDC: For connecting the external power supply to the analyzer.  

Note: There is no power switch on the analyzer.

Warning!  Do not open the CATC 5K enclosure. No operator 
serviceable parts are inside. Refer servicing to LeCroy. 

2.6 Interchangeable Radios
Because WiMedia UWB specifications and technology are still evolving, a 
UWBTracer/Trainer™ analyzer (with its CATC 5K platform) can use interchangeable 
plug-in modules, each incorporating different PHYs (radios). 

Currently there are two UWB Analyzer plug-in modules that can be used with the 
UWBTracer: model UW002MA and model UW003MA.

Please note that each UWB Analyzer plug-in module requires different initialization 
sequences that are executed according to a script that must be downloaded to the 
analyzer using the Analyzer Setup menu and window, as described in Section 16.4, 
“BusEngine, Firmware, and Plugin Init Updates” on page 276.

After you plug the module into the correct slot and check that you have the correct 
BusEngine, Firmware, and initialization script installed, you can record traces.
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Section 2. UWBTracer/Trainer Analyzer 
Software
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Chapter 3:  Software Overview
The UWBTracer/Trainer™ software can: 

• Control recording of UWB traffic.
• Manage one or more Analyzers, which can be connected directly to the host 

machine or connected through the Analyzer network.
• View, analyze, and create reports about recorded traces. 

3.1 Installing the Software
For instructions about installing the software, refer to the 
UWBTracer/Trainer Getting Started manual.

3.2 Starting the UWBTracer/Trainer /Trainer Program
You can use the UWBTracer/Trainer /Trainer with or without the analyzer unit. When used 
without an analyzer, the program works as a trace viewer to view, analyze, and print trace 
files. 

To start the UWBTracer/Trainer /Trainer Program from the PC Start menu: 

Step 1 Select Start > Programs > LeCroy > UWBTracer > 
LeCroy UWBTracer  
to display the application main window (Figure 3.1). 

Figure 3.1 UWBTracer/Trainer Main Window
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3.3 Opening Sample Traces
A good way to gain familiarity with UWBTracer/Trainer is to open some of the provided 
sample files and explore the menus, pop-up menus, and reports. See Section 3.18 
"Directory Structure on Windows XP and Vista" on page 45.

3.4 Opening Older Trace Files
The UWBTracer/Trainer software has the capacity to open trace files created with earlier 
software versions. When an older trace file is opened, the program prompts you to 
convert the file to the current software version. See Section 3.18 "Directory Structure on 
Windows XP and Vista" on page 45.

3.5 Tool Tips
Throughout the application, Tool Tips provide useful information about buttons on the 
toolbar.

To display a Tool Tip, position the mouse pointer over an item of interest such as part of 
the trace or a button (Figure 3.2).

Figure 3.2 Tool Tip

3.6 Trace Tool-Tips
Many fields within the Trace display tool-tips when the mouse pointer is suspended over 
them. These tips may provide a simple legend for the cell or may give substantial added 
details about the field (Figure 3.3). 

Figure 3.3 Trace Tool Tip
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3.7 Menu Bar
Table 3.1 lists menus available from the Main window menu bar. Some menus and 
options are available only when a file is open.

Table 3.1 Menu Bar Menus 

Menu/Option Function

File

Open Opens a trace file or traffic generation file.
Close Closes the current trace or generation file.
Save As Saves all or a specified range of frames with a specified name.
Print Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing. 
Print Setup Sets options for the current or new printer.
Edit Comment Opens a dialog for entering a brief comment about the trace.
Export Packets to Text (Packet View Format): Saves all or part of a trace to a 

text file. Used to save traces to floppy disk and to send in e-mail. 
Packets to CSV Text: Saves trace as a comma-separated-values text 
file for use with Microsoft® Excel.
Packets to Ethereal/WireShark format: Exports WLP data 
frames in Ethereal/Wireshark format and opens the exported file 
in the Ethereal/WireShark application (free Ethernet analyzer 
software).

Packets to UWBTrainer script: Exports WLP data frames to a 
.uwbg file for use in UWBTrainer.

Decrypt Trace File Uses decryption parameters to decrypt trace file.
Remove Identifying 
Info from Trace 
Files

Allows you to select trace files from which to remove identifying 
information and save them with the names 
<original_name>_clean.uwb.

Exit Exits the UWBTracer/Trainer  program.

Setup

Display Options Opens a window that controls the recording process.
Recording Options Opens a window that controls display options.
Update Device Update BusEngine™ and Firmware manually 
Analyzer Network Opens a dialog box for browsing to local and networked analyzers. 

Within the dialog, click Add to browse. The dialog lists PCs that are on 
the LAN. If a PC has an analyzer attached to it, and if DCOM 
permissions have been set on the selected PC, clicking Select 
establishes a connection. 

All Connected 
Devices

Opens a dialog box with a list of analyzers connected to the host PC. 
Lets you select an analyzer and update the BusEngine, Firmware, and 
licensing information.
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Record

Start Causes the Analyzer to begin recording.
Stop Causes the Analyzer to stop recording.
Reupload Opens a window that controls partial uploading.

Report

File Information Displays information about the recording such as the number of frames 
and triggering setup.

Error Summary Displays the Errors report of the Traffic Summary, listing the numbers of 
each error type.

Timing Calculations Calculates timing between two frames.
Traffic Summary Summarizes the numbers and types of errors, packets, transactions, 

split transactions, and transfers that occurred in the open trace.
Device List Lists the DUTs, active devices, archive devices, and wireless USB in the 

Device List window by DUTs, Type, EUI-48, Address, Alias, 
Last Updated, and User Notes. 

Beacon/WUSB 
Timing Analysis

Opens the Timing Analysis window with a Beacon Period and/or 
WUSB Detail View.

Run Verification 
Script

Opens a window to allow you to run verification scripts  
over the open trace.

Search

Go to Trigger Positions the display to show the triggering event at the top.
Go to Frame/ 
Packet/Transaction/ 
Transfer

Positions the display to show a specific frame or decode level.

Go to Marker > Positions the display to the selected marked frame.
Go to > Positions the display to the specified item.
Find Allows searches by multiple criteria.
Find Next Looks for the next instance of an event specified with Goto or Find.
Search Direction Allows the search direction to be changed from Forward to Backward or 

Backward to Forward. 
Search Channel MPI or RF

Menu/Option Function
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View

Toolbars Displays list of available Tool bars.
Analyzer Network  
Chat Bar

Opens a dialog that allows users to conduct chat sessions over an IP 
LAN. In order to send and receive electronic text messages, each user 
must be working with a PC that is on an IP LAN and also attached to an 
analyzer.

Status Bar Switches display of the Status Bar ON or OFF.
Hide Traffic on 
Channels

Hides traffic on the channel (MPI or RF) selected from the popup list.

Hide Dec/Orig 
Traffic

Hides Decrypted or Original traffic, as selected from the popup list.

Hide Frame Types Hides Beacon, Control, Command, Data, and/or Agg Data frames.
Hide Reserved 
Field Warnings

Hides fields that have a Reserved Field Warning. 

Unhide Cells Unhides the cells (hidden by Display Options) selected from the popup 
list. 

Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed Frames within the window.
Apply Decoding 
Scripts

Decoding scripts set the values of the display and recording options for 
optimum views of trace information from specific vendors or classes of 
data. The menu allows you to select the vendor or class of data for the 
request recipients and endpoints listed in the Request Recipients and 
Endpoints menu. You can keep the settings across recordings.

Real-Time Statistics Displays trace statistics.

Window

New Window Opens another instance of the Main Window.
Cascade Displays all open Main windows in cascaded format.
Tile Horizontal Displays all open Main windows in tiled horizontal format.
Tile Vertical Displays all open Main windows in tiled vertical format.
Arrange Icons Arranges Main window icons at bottom of display area.
Windows Displays a list of open windows.

Help

Help Topics Opens online help.
Update License Opens a dialog box for entering license key information for the analyzer.
Display License 
Information

Opens a dialog box with information about the current status of the 
analyzer's license

About Displays version information about UWBTracer/Trainer .

Menu/Option Function
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3.8 Tool Bar
The Main window Tool bar provides quick access to most UWBTracer/Trainer  software 
functions. You can learn the function of each button by passing the mouse pointer over 
it. Button descriptions appear on the Status bar at the bottom of the window and as 
tooltips above each button. 

Figure 3.4 Main Window Toolbar

General Buttons

UWBTrainer Buttons

Open file Zoom In

Save As Zoom Out

Setup Recording Options Wrap

Setup Generation Options Find

Setup Display Options Next

Start Recording Find Next. Repeats last find.

Stop Recording Apply Decoding Scripts

Manual Trigger
Repeat Upload
(Reupload/Partial Upload)

Real-Time Statistics. Opens a 
window that shows realtime 
information on links activity.

Apply Decoding Scripts

UWBTrainer Export To Script
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Hide Buttons

Reports Buttons

Decode Buttons

Hide Unassociated Traffic Hide Beacon Frames

Hide Devices Hide Empty MMC Intervals

Hide Empty Super Frame Hide Channels (MPI or RF)

Show Only Beacons Hide Decoded/Original Traffic

Hide WLP Hide WUSB

Hide Nak’s Hide Rx/Tx W/O Data

Hide Frame Types

File Information Report. Opens a 
summary of general information 
about the trace file.

Traffic Summary. Opens a summary 
of protocol-related information in the 
trace file.

Error Report. Opens a summary of 
error information in the trace file.

Bus Utilization. Opens a window that 
shows packet length by time.

Timing and Bus Usage 
Calculations. Opens a calculator for 
measuring timing between frames

Device List Window

Run verification scripts. 
Opens a window to allow you to run 
verification scripts over the open 
trace.

Timing Analysis

View WiMedia Frame Level View WUSB Transaction Level

View WUSB Packet Level View WUSB Transfer Level

View Wire Adapter Segment Level View Wire Adapter Transfer Level

View WLP Frames View WLP Ethernet Protocol Units

View WLP IP Protocol Units
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3.9 Floating the Decode Toolbar
You can float any of the toolbars by dragging them from their current location at the top 
of the screen. If you float the decode toolbar, it arranges the decode buttons in their 
hierarchical order. Click the triangle to add or delete buttons. 

Figure 3.5 Decode Toolbar in Hierarchal Arrangement

3.10 Pop-Up Menus
Pop-up menus within the trace provide options for formatting the trace. 

Left Mouse Button
Left-clicking a header opens a menu for expanding fields, viewing data fields, and 
formatting the trace. The menu is context-sensitive and changes, depending on what part 
of the trace you have clicked. Figure 3.6 shows three examples. 

Figure 3.6 Trace Pop-Up Menus

Triangle to add or delete buttons
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Common options appear on most menus: 

• Format: Presents choices for changing the numerical formatting of the data fields 
throughout the trace.

• Color: Presents choices for changing the color of the data fields throughout the 
trace.

• Hide: Hides data fields throughout the trace. To re-display hidden fields, right-click 
anywhere in the trace and select Unhide Cells and then one of the options from the 
sub-menu.

Left-clicking the small triangle in the upper left corner of the PHY, MAC, Payload, or 
Timing data block expands the data block to show all fields.

Figure 3.7 Expanded Data Block

If you double-click a cell of a PHY, MAC, Payload, or Timing data block, the trace displays 
all the fields of the block (see Figure 3.7). If you double-click a cell of an expanded block, 
the trace displays the truncated block 

Right Mouse Button
If you right-click a cell in the trace, a pop-up menu allows changing display options, 
zooming in or out, wrapping the display, unhiding hidden cells, hiding the MPI or RF 
channel, hiding decrypted or original traffic, hiding fields with reserved field warnings, 
applying decoding scripts, and calculating real-time statistics (Figure 3.8). 

Figure 3.8 Trace Cell Pop-up Menu
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3.11 View Settings Tools
You can zoom in and out, and wrap the trace to fit within the screen by using the following 
buttons:

Zoom In
Increases the size of the displayed elements, allowing fewer (but larger) Frame fields per 
screen. 

• Click  on the Tool bar.

Zoom Out
Decreases the size of the displayed elements, allowing more (but smaller) Frame fields 
per screen. 

• Click  on the Tool bar.

Wrap
Adjusts the Trace View so that frames fit onto the next line if they are longer than the size 
of the window. Without wrap, you can use the horizontal scroll bar to see the hidden part 
of a frame.

• Click  on the Tool bar. 
In Figure 3.9, the timestamp extends off the right edge of the screen. 

Figure 3.9 Trace With Wrap Turned OFF

In Figure 3.10, the entire frame appears in the window.

Figure 3.10 Trace With Wrap Turned ON
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3.12 Adding Comments to the Trace
You can create, view, or edit the 100-character comment field associated with each Trace 
file.

Step 1 From the File menu, select Edit Comment to display the Edit Trace 
Comment dialog box. 

Figure 3.11 Edit Trace File Comment Dialog Box

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

3.13 Set Marker
The Set Marker feature allows frames to be marked so you can navigate back to events 
of interest. Markers also provide you with a way of tagging events so you can perform 
timing calculations between them. A marker can be applied to any display entity (frame, 
WUSB packet, WUSB transfer, and so on). 

The Set Marker command works in conjunction with the Go to Marker feature. Once you 
have marked a frame, you can navigate back to it by selecting Search > Go to Marker, 
and then selecting the marker of interest from the list.

To set a marker on a frame: 

Step 1 In the trace, click the MPI field for the frame number you wish to mark.

Step 2 From the pop-up menu that appears, Select Set Marker (Figure 3.12). 

Figure 3.12 Setting a Frame Marker
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Step 3 The Edit Marker for Frame # dialog box appears (Figure 3.13).

Figure 3.13 Edit Marker for Frame Dialog Box

Step 4 Enter your comment. 

Step 5 Click OK.

Step 6 A marked frame is indicated by a vertical red bar along the left edge of 
the Frame # block (left side of Figure 3.14). 

Figure 3.14 A Marked Frame
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3.14 Edit or Clear Marker
To clear a marker or edit comments associated with a Frame marker: 

Step 1 Click Frame # for the chosen packet to display a pop-up menu 
(Figure 3.15). 

Figure 3.15 Editing a Frame Marker

Step 2 To edit the marker comment, select Edit Marker.to display the Edit 
Marker for Frame # comment window (Figure 3.13).

Step 3 Edit the comment.

Step 4 Click OK.

Step 5 To clear a marker, click Clear marker in the frame pop-up menu 
(Figure 3.15). The vertical red Marker bar disappears.
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3.15 Timing Calculations on Markers
You can use markers as reference points to calculate timing between events. To do a 
timing calculation:

Step 1 Click the MPI field of the frame number that you want to use as the first 
point of reference in the time calculation.

Figure 3.16 MPI Field Options

Step 2 In the pop-up that appears (Figure 3.15), select Time from Marker to 
display the Timing and Bus Usage Calculator. The first point is in the 
From Frame field. 

Figure 3.17 Timing Calculator Dialog Box
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Step 3 In the All Markers window, select the marker that you want to use as the 
second (To MPI) point of reference in the time calculation. 

Figure 3.18 All Markers Window

Step 4 The time between the two markers appears in the Timing Calculator 
dialog box. 
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3.16 Status Bar
The Status bar is located at the bottom of the Main window. Depending on the current 
activity, the bar can be divided into as many as four segments (see Figure 3.20): 

1. Notifications and Help (connection, disconnection, and other messages)

2. Progress Bar and Progress Report (see “Recording Progress” on page 38)

3. Status (of the MPI and RF channels)

4. Search Direction (Forward or Backward)

Figure 3.19 Status Bar Segments

The left-most segment shows a message that an Analyzer with serial number 1434 was 
disconnected from the application

The status bar shows only the status of a single analyzer. If you place the cursor on the 
status bar, a tooltip pops up (Figure 3.20) and displays the status of all the analyzers 
connected to the application. In this example, three analyzers are connected to the 
application. 

To select a different device from the list in the tooltip and display its status in the status 
bar, double-click Segment 3, the Status segment. The Status bar then displays 
information about the next device displayed in the tooltip list. Double-click Segment 3 
again to cycle through all the devices displayed in the tooltip list.
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Figure 3.20 shows six examples of the Status bar, each displaying different states of the 
analyzer devices:

Figure 3.20 Status Bar Examples

Status Bar Example 1: No analyzer is connected to the application.

Status Bar Example 2: An analyzer with serial number 1069 was connected to the 
application and has both its MPI and RF recording channels in the IDLE state. 

Status Bar Example 3: An analyzer with serial number 1069 is Ready. The MPI channel 
detects PCLK and is attempting to synchronize to the data. The RF channel is in the IDLE 
state.

Status Bar Example 4: An analyzer with serial number 1067 was disconnected from the 
application. Its MPI Channel is synchronized to the MPI data and PCLK. Its RF channel 
is attempting to synchronize to wireless traffic.

Status Bar Example 5: An analyzer with serial number 1064 is Ready. The MPI channel 
is synchronized to the MPI traffic and is recording. The RF channel is recording but has 
lost synchronization and is attempting to regain synchronization.

Status Bar Example 6: An analyzer with serial number 1569 is Ready. The MPI channel 
is in the IDLE mode, not synchronized to PCLK. The RF channel is synchronized to 
wireless traffic and is recording.
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Recording Progress
When you begin recording, the left-most segment of the Status bar displays a recording 
Progress Indicator (left side of Figure 3.21). 

Figure 3.21 Example: Status Bar at Different Recording States

Keep the following in mind when reading the Progress Indicator:

• A black vertical line illustrates the location of the trigger position you selected in the 
Recording Options window. The pre-trigger progress is displayed in the field to the 
left of the trigger position. 

• When the trigger position is reached, the progress indicator wiggles as it waits for 
the trigger. 

• After the trigger occurs, the field to the right of the trigger fills in the post-trigger color 
specified in the Display Options window.

• When recording is complete, the upper half of the Progress Indicator fills in white, 
indicating the progress of the data upload to the host computer.

Some other key points about the Progress Indicator:

• If a trigger event occurs during the before-trigger recording, the before-trigger color 
changes to the after-trigger color to indicate that not all the expected data was 
recorded pre-trigger. 

• When you click Stop before or after a trigger event, the Progress Indicator adjusts to 
begin uploading most recently recorded data.

• If you wish to abort an upload that is in progress, click the Stop button again.
• The Progress Indicator fills with color in proportion to the specified size and actual 

rate at which the hardware is writing and reading the recording memory. However, 
the Progress Indicator is normalized to fill the space within the Status bar.
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Recording Status
During recording, current recording status is displayed in the next segment of the Status 
bar (Figure 3.21). When recording is begun, one of the following messages flashes 
(depending on options selected in the Recording Options window):

• Trigger?
• Triggered!
• Uploading
After recording stops, the following occurs:

• Flashing message changes to Uploading data–x% done (x% indicates the per-
centage completion of the data uploading process). 

• Traffic data is copied to disk (overwriting any previous version of this file) using the 
default file name data_xxx.uwb, where xxx is derived from the unit’s serial number. 
You can specify the file name in the Recording Options window.

When the data is saved, the Recorded Data file appears in the Main display window, and 
the Recording Status window is cleared. 

• If the recording resulted from a trigger event, the first frame following the trigger (or 
the frame that caused the trigger) is initially positioned second from the top of the 
display.

• If the recording did not result from a trigger event, the display begins with the first 
frame in the traffic file.

Recording Activity
During recording, the next segment of the Status bar (Figure 3.21) displays recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Search Status
The rightmost segment of the Status bar (Figure 3.21) displays current search direction: 
Fwd (forward) or Bwd (backward). 
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3.17 Exporting Trace File Information
See Chapter 3, See Section 3.18 "Directory Structure on Windows XP and Vista" on page 
45.

Exporting Packets to Text (Packet View Format)
You can save all or part of a trace to a text file. This option enables you to save traces to removable 
storage devices and to send traces as e-mail attachments.

Step 1 When a trace has WUSB frames, select 
File > Export > Packets to Text.

Step 2 Save the exported file.

Exporting Packets to CSV Text
You can save a trace as a comma-separated-values text file for use with Microsoft® Excel.

Step 1 When a trace has WUSB frames, select 
File > Export > Packets to CSV Text.

Step 2 Save the exported file.

Exporting Packets to Ethereal/WireShark Format
You can export WLP data frames in Ethereal/Wireshark format and open the exported file 
in the WireShark/Ethereal application (free Ethernet analyzer software).

Step 1 When a trace has WLP frames, select 
File > Export > Packets to Ethereal/Wireshark format.

Figure 3.22 Export Packets to Ethereal/Wireshark format
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Step 2 Enter parameters in the Export to WireShark/Ethereal format dialog box.

Figure 3.23 Export to Wireshark/Ethereal format

Step 3 In the Export Options section, enter the frame numbers 
From Frame To Frame.

You can Reset Range to Whole Trace.

Step 4 Enter or Browse for the export file name in the 
Save exported data in file field.

Step 5 In the WireShark/Ethereal Options section, select whether or not to 
Open trace  in WireShark/Ethereal after exporting is done.

Step 6 Enter the Path to WireShark/Ethereal.
Step 7 Select whether or not to Launch WireShark/Ethereal in Full Screen.

Step 8 Click Start Export to export and save the file.

If you selected that option, the WireShark/Ethereal application opens with the 
exported file displayed.
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Exporting Packets to UWBTrainer Script
You can export data frames to a .uwbg file for use in UWBTrainer. In the export dialog 
box, you can select the frame range and the channel (if more than one channel is in use).

Note: Only frames visible in the Trace View are exported.

To restrict the exported frames, you may use any of the Hiding mechanisms to hide the 
frames you do not want to export. These mechanisms include: 

• Executing a Find All search
• Using the quick filters from the application toolbar
To export frames from a specific source (such as a WUSB Host):

Step 1 Open a trace file, then open the Find dialog.

Step 2 In the Search For field (at the top), select WiMedia Frames.

Step 3 In the Event Groups section, select MAC: Source Addresses.

Step 4 In the MAC: Source Addresses (Hex) section, select the address of the 
WUSB Host to be exported.

Step 5 Check the Find All box.

Step 6 In the Combining Specified Event Groups section, select the 
Intersection option.

Figure 3.24 Example Find Dialog for Exporting to a UWBTrainer Script

Step 7 Click OK to open a new window showing only the matching frames.
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Step 8 To export the displayed frames, click the Export To Script button , or 
select File > Export > Packets to UWB Trainer script.

Figure 3.25 Export Packets to UWBTrainer Script Command

Step 9 Enter parameters in the Export to UWBTrainer Exerciser Script dialog 
box.

Figure 3.26 Export to UWBTrainer Exerciser Script Dialog
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Step 10In the From Frame field, enter the starting frame number.

Step 11 In the To Frame field, enter the ending frame number.

Note: If the trace has few frames, you can click Reset Range to Whole Trace 
to use all the frames.

Step 12If the trace has more than one channel, in the Channel field, select the 
channel or use the default channel.

Step 13Enter or Browse for the export file name in the 
Save exported data in file field.

Step 14Click Start Export to export and save the file.
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3.18 Directory Structure on Windows XP and Vista
The UWBTracer/Trainer application stores files in a specific directory structure under the 
C:\Program Files\LeCroy\UWBTracer directory. It also stores files in Windows-specific 
locations that differ for Windows® XP and Windows Vista (which uses UAC). 

In particular, Windows XP has a Documents and Settings\All Users folder, and 
Windows Vista has a Users\Public folder, which are not equivalent. 

The Windows XP All Users folder is not readily available to users and is for storing 
shared files, to which normal user folders point using shortcuts.

The Windows Vista Users\Public folder and its subdirectories:

• Are available to all users logged onto a system (not just the person who installed the 
application).

• Are not hidden.
• Are always present, because it is provided by the Windows Vista OS installation.
• Are readable and writable by all users.
• Do not require Administrator privileges.
Methods of using shared folders differ for the two operating systems, so the 
UWBTracer/Trainer application stores files on them differently, as described in the next 
two sections.

Windows XP
All Files
For UWBTracer/Trainer on Windows XP, all application and user files (such as sample 
files, user files, default files, and scripts) are in the 
<drive>\Program Files\LeCroy\UWBTracer directory folder and its subdirectories:

• Automation
• Documents
• Generation
• Sample Files
• Scripts (and versioned Scripts directories, such as Scripts3.00.307)
• x64
• x86
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Windows Vista
User-modifiable Files
For UWBTracer/Trainer on Windows Vista, user-modifiable files are in the 
Windows Explorer <drive>\Users\Public\Public Documents\LeCroy\UWBTracer\ 
folder, which is the same as the Command Tool 
<drive>\Users\Public\Documents\LeCroy\UWBTracer\ folder.

The Command Tool name is the correct folder name when using scripts.

The Users\Public\Public Documents\LeCroy\UWBTracer folder contains files that the 
user can modify, such as default.rec and default.opt, or the application creates at 
runtime, such as debug files and device lists. It also has the directories:

• Automation
• Generation
• Sample Files
• Scripts (and versioned Scripts directories, such as Scripts3.00.307)
Application Files
For UWBTracer/Trainer on Windows Vista, read-only application files (like the 
application, bus engines, firmware, user manuals, help files, and read-me) are in the 
<drive>\Program Files\LeCroy\UWBTracer folder. It has the directories:

• Documents
• x64
• x68
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Chapter 4:  Reading Traces
This chapter describes how to read and manipulate trace displays.

4.1 Trace Display Overview
UWBTracer/Trainer  trace viewing software makes extensive use of color and graphics to 
fully document the captured (decoded) traffic (Figure 4.1). 

Figure 4.1 Trace Display Example

Frames are shown on separate time-stamped rows, with their individual fields both 
labeled and color coded. You can collapse data fields to save space in the display, and 
you can zoom in and out in the display. Pop-up Tool Tips annotate fields with detailed 
information about their contents.

The display software can operate independently of the hardware and so can function as 
a stand-alone trace viewer that may be freely distributed. 

4.2 Changing Trace Level Views
You can select the trace viewing level in the Display Options window General tab Trace 
Viewing Level section (see Chapter 6, “Display Options”) or with the Trace Viewing Level 
icons in the Tool bar (Figure 4.2). 

Figure 4.2 Trace Viewing Level Buttons

Note:  To find frames, packets, transactions, segments, or transfers, scroll through 
the trace or use the Search > Find command (see Chapter 9, “Searching 
Traces”).
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4.3 Trace Level Views for WUSB
You can display traces at these viewing levels, listed from lowest to highest: 

• Frame (WiMedia Frame or MAC-PHY Interface equivalent) [default] (WM)
• WUSB Packet (WUSB PKT)
• WUSB Transaction (USB TRA)
• WUSB Transfer (USB XFR)
• WUSB Wire Adapter Segment (WA SEG)
• WUSB Wire Adapter Transfer (WA XFR)

Frame Level
The Frame view is the default decode level. It shows the WiMedia Frame Raw Payload 
and PHY/MAC Headers. An example MPI Frame level is in Figure 4.3. 

Figure 4.3 Trace View: Frame Level
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WUSB Packet Level
Click the WUSB PKT button to show the WUSB Packet Level view. An example packet 
level is in Figure 4.4. 

Figure 4.4 Trace View: WUSB Packet Level

The WUSB Packet Level is now a special way to decode the Frame Level. You can show 
or hide MAC Frame raw payload PHY/MAC headers when WUSB Packets are displayed. 
You cannot expand WUSB packets.

WUSB Transaction Level
Click the USB TRA button to show the WUSB Transaction Level view. An example 
transaction level is in Figure 4.5. 

Figure 4.5 Trace View: WUSB Transaction Level
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WUSB Transfer Level
Click the USB XFR button to show the WUSB Transfer Level view. An example transfer 
level is in Figure 4.6.

Figure 4.6 Trace View: WUSB Transfer Level

WUSB Wire Adapter Segment Level
Click the WASEG button to show the WUSB Wire Adapter Segment Level view. An 
example wire adapter segment level is in Figure 4.7. 

Figure 4.7 Trace View: WUSB Wire Adapter Segment Level

WUSB Wire Adapter Transfer Level
Click the WAXFR button to show the WUSB Wire Adapter Transfer Level view. An 
example wire adapter transfer level is in Figure 4.8. 

Figure 4.8 Trace View: WUSB Wire Adapter Transfer Level
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4.4 Trace Level Views for WLP
You can display traces at these viewing levels, listed from lowest to highest: 

• WiMedia Frames [default]
• WLP Frames (WLP)
• WLP Ethernet Protocol Units (WN ETH)
• WLP IP Protocol Units (WN IP)

WiMedia Frame Level
The WiMedia Frame view is the default decode level. It shows the WiMedia Frame Raw 
Payload and PHY/MAC Headers. An example WiMedia Frame level is in Figure 4.9. 

Figure 4.9 Trace View: WiMedia Frame Level

WLP Frame Level
Click the WLP button to show the WLP Frame view. An example WLP Frame level is in 
Figure 4.10. 

Figure 4.10Trace View: WLP Frame Level



Chapter 4: Reading Traces UWBTracer/Trainer  User Manual

52 LeCroy Corporation

WLP Ethernet Protocol Unit Level
Click the WN ETH button to show the WLP Ethernet Protocol Unit Level view. An example 
WLP Ethernet Protocol Unit Level is in Figure 4.11. 

Figure 4.11 Trace View: WLP Ethernet Protocol Unit Level

WLP IP Protocol Unit Level
Click the WN IP button to show the WLP IP Protocol Unit Level view. An example 
transaction level is in Figure 4.12. 

Figure 4.12Trace View: WLP IP Protocol Unit Level
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Chapter 5:  Searching Traces
This chapter describes how to search for trace events.

5.1 Trace Search Overview
UWBTracer/Trainer™ has several search commands that let you navigate a trace view 
to search for key events, such as errors and triggers. The commands are on the Search 
menu (Figure 5.1).

To view the search options, click Search in the Menu bar. 

Figure 5.1 Search Menu

You can: 

• Change the Search Direction to Forward or Backward
• Select the MPI Channel, RF Channel, or All Channel

5.2 Go to Trigger
To display a trigger event, select Go to Trigger from the Search menu.

The trace view is repositioned with the first frame following the trigger event (or the frame 
that caused the trigger) at the top of your screen.
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5.3 Go to Frame/Packet/Transaction/Transfer
To display a specific frame or decode level, follow these steps:

Step 1 From the Search menu, select: 
Go to Frame/Packet/Transaction/Transfer
to display the Go to PLCP/Packet/Transaction/Transfer dialog box (Figure 5.2): 

Figure 5.2 Go To PLCP/Packet/Transaction/Transfer Dialog Box

Step 2 Select the trace level view in the Go to field from the drop-down list. 

Step 3 Enter the number of the frame, packet, transaction, segment, or transfer.

Step 4 Click OK.
The trace view shows the selected item at the top of the main window.
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5.4 Go to Marker
To instruct the analyzer to display a marked frame, follow these steps:

Step 1 From the Search menu, select Go to Marker (Figure 5.3). 

Figure 5.3 Selecting Go to Marker

Step 2 Select a frame or packet number from the listed markers. Alternatively, 
select All Markers to open the All Markers dialog box (see figure 5.17, 
“All Markers Window”), select a marker, and then click Select. 
The trace view displays the selected item at the top of the main window.

Note:  The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
Frame are added or edited with the Set Marker feature. 
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5.5 Go to
The Go to feature takes you directly to an item in the trace. After you select Go to, select 
the item from the listed items (Figure 5.4). 

Figure 5.4 Go to Items List
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Figure 5.5 Go to Frame Types List

Figure 5.6 Go to Beacon Info Elements List

Figure 5.7 Go to Errors List

Figure 5.8 Go to Secure Header Items List
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Figure 5.9 Go to WUSB Packets List

Figure 5.10Go to WUSB Transactions List

Figure 5.11 Go to WUSB WA Transfers List

Figure 5.12Go to WLP Frames List
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Figure 5.13Go to WLP Ethernet Protocols List

Figure 5.14Go to WLP IP Protocols List
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Figure 5.15Go to WiMedia Payload Data Pattern List

You can enter an ASCII or Unicode (as ASCII characters) search string. For HEX, you 
can select a Bitmask, Mask (in hexadecimal), and Match (in hexadecimal) for each of 16 
bits.
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5.6 Find
Find is a utility that allows you to conduct searches of one or more events in a trace. Find 
allows you to search for any of the WUSB and WLP hierarchical levels within the trace.

To use Find: 

• Select Find... under Search on the Menu bar
OR

• Click  in the Tool Bar.

You see the Find window (Figure 5.16).

Figure 5.16Find Window, Frames Checkboxes
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Areas in Find Window
The Find window has three areas: Event Groups pane, a Context area to the right of the 
Event Groups pane (whose contents vary depending on items in the pane), and a 
Direction/Origin area at the right in the window.

Event Groups Pane
The left area allows you to specify the events to find in the search. 

Figure 5.17Find Events Window, Search For Drop-down List
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Use the Search For drop-down list to select the event type:

• WiMedia Frames
• WUSB Packets
• WUSB Transactions
• WUSB Transfers
• Wire Adapter Segments
• Wire Adapter Transfers
• WLP Frames
• WLP Ethernet Protocol Units
• WLP Internet Protocol Units

For each Search For event, you can select as many checkboxes as desired (for multiple 
search events).

For WLP Frames: 

Figure 5.18Find Events Window, WLP Frames Checkboxes
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For WUSB Packets: 

Figure 5.19Find Events Window, WUSB Packets Checkboxes
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For WUSB Transactions: 

Figure 5.20Find Events Window, WUSB Transactions Checkboxes
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For WUSB Transfers: 

Figure 5.21Find Events Window, WUSB Transfers Checkboxes
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For Wire Adapter Segments: 

Figure 5.22Find Events Window,  Wire Adapter Segments Checkboxes
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For Wire Adapter Transfers: 

Figure 5.23Find Events Window, Wire Adapter Transfers Checkboxes
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For WLP Frames: 

Figure 5.24Find Events Window, WLP Frames Checkboxes
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For WLP Ethernet Protocol Units: 

Figure 5.25Find Events Window, WLP Ethernet Protocol Units Checkboxes
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For WLP Internet Protocol Units: 

Figure 5.26Find Events Window, WLP Internet Protocol Units Checkboxes

You also can combine specified event groups, meaning you can use logical relationships 
in your search: OR, AND, and NOT: 

• Union: OR relationship. A Find operation searches for frames that include any of 
the items selected in the Event Groups pane.

• Intersection: AND relationship. A Find operation searches for only those frames 
that match all the items selected in the Event Groups pane.

• Exclusion: NOT relationship. A Find operation searches for frames that do not 
match any of the items selected in the Event Groups pane. 



Chapter 5: Searching Traces UWBTracer/Trainer  User Manual

72 LeCroy Corporation

Context area
The central area provides further selection criteria for the Event Group active in the Event 
Groups pane. For example, in Figure 5.16, the MAC Destination Addresses Event Group 
is currently active (selected). The context area lets you select a range of MAC addresses. 
In Figure 5.27, the PHY Data Rates is the active Event group. A different display appears 
in the context area. 

Figure 5.27Find Events Window: PHY Data Rates Active

Direction/Origin
The radio buttons and checkboxes in the right part of the Find window let you specify 
where you want to start the search and search direction: 

• Direction: You can search forward or backward in the file.
• Origin: You can choose the point-of-origin for the search: Top of the screen, Last 

match, Start of file, or End of file.
• Find All: You can extract every instance of the search criteria into a separate view.
• Search in Hidden: You can search in frame elements that are hidden in the display 

as well as frame elements that are visible.
• Channel Selection: If available, choose the MPI Channel, RF Channel, or Both.
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Chapter 6:  Display Options
You can select what information to display in Trace Views using the Display Options 
window or the display options buttons on the Tool bar (see Section 3.8, “Tool Bar” on 
page 26).

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click  on the Tool Bar.

Figure 6.1 Display Options Window: General Page

You can select General and Color/Format/Hiding display options. The following sections 
describe these display options.
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6.1 Display Options: General
You specify the main Trace View information types and settings using General tab of 
Display Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100% to 
200%.

• Enable Tips: Pops up text when you position the cursor over a field.
• Wrap: Wraps lines of traffic information instead of truncating lines at the right edge 

of the display.
• Right click cell context menu: By default, clicking the left mouse button on a field 

heading displays a context-sensitive pop-up menu providing commands about the 
field and clicking the right mouse button pops up a menu with display options. After 
selecting this option, clicking the right mouse button on a field heading displays the 
context-sensitive pop-up menu and clicking the left mouse button does nothing.

• Hierarchy Lines: Displays lines on the left side of Trace View showing the hierarchy 
from Packets to Transactions to Transfers if you show higher-level decodes. 

Figure 6.2 Hierarchy Lines

• Timestamp At The Beginning: Aligns the Timestamp field in a column on the left 
side of the Trace View. Selecting this option allows easier comparison with previous 
or following timestamps.

• Calculate Delta Time from the Previous Frame: Compute the time difference from 
the previous frame.

• Hide WiMedia PHY-MAC headers for decoded frames: Hide the headers of 
decoded frames.

• Trace Viewing Level: Displays WiMedia Frame, WUSB Packet, 
WUSB Transaction, WUSB Transfer, Wire Adapter Segment, 
Wire Adapter Transfer, WLP Frame, WLP Ethernet Protocol Unit, and 
WLP Internet Protocol Unit.

• Error Report: Displays the Errors section of the Traffic Summary window. 
• Traffic Summary: Displays the Traffic Summary window, showing all reports, 

including Packets, Transactions, Transfers, and Errors. 
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• Bus Utilization: Displays the Bus Utilization window, including Packet length, Bus 
usage, and Bus usage by device. 

• Real-Time Statistics: Displays the Real-Time Statistics window, including Data 
Packet Count, Data Payload Throughput, and Bus Usage. 

• Fonts: Sets the font type and bold or italic style for Fields and Data.
• Configuration Name: You can name the current set of Display Options values for 

use with an .opt file. (The options file can have a different name.)
• Restore Factory Presets: Sets all Display Options values to the installed values. 

6.2 Display Options: Color, Format, and Hiding
To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab. 

Figure 6.3 Display Options Window: Color, Format, and Hiding Page
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Setting Colors
The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter 
any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it (see Figure 6.2). 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field 

To customize colors, use the Custom tab.

Note:  You cannot change color of an Invalid Data (packet error) field. It is 
permanently set to red.

Changing Field Formats
For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Bin (binary), Dec (decimal), and Hex 
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame, 
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of 
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Data) in the Group and Color column and expand it. 

Select a data type (such as Payload) in the Group: 

Figure 6.4 Group and Color Pane: Display Units Selected

Select a format in the Format section. The following formats are available for Payload: 

Figure 6.5 Formats for Payload
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If available, select Bit Order in the Format section. The options are MSB to LSB or LSB 
to MSB.

Hiding Fields
To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hiding section of the Format section.

Figure 6.6 Hidden Check Box

6.3 Saving Display Options 
You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

• To save the current Display Options values in an options file for use in future 
sessions, click Save. Enter a file name without a file name extension. The program 
adds the .opt extension. (The file must have an .opt file name extension.)

• To load a previously saved .opt file, click Load and select a file name.
• To save the current Display Options values in the default.opt options file for use as 

the default display options, click Save as Default. (Do not delete the default.opt 
file.)

• To apply the current Display Options values, click Apply. The Display Options 
window remains open.

• To apply the current Display Options values and close the Display Options window, 
click OK.

• To cancel unsaved changes to display values and exit the Display Options window, 
click Cancel. 

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45



Chapter 6: Display Options UWBTracer/Trainer  User Manual

78 LeCroy Corporation

                                                       [blank page]
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Chapter 7:  Decoding USB/WUSB 
Requests

7.1 Class and Vendor Definition Files
LeCroy analyzers use script files to decode class and vendor requests. The script files 
are read when the application is initialized. After reading, the Analyzer decodes class and 
vendor requests as instructed by the files.

Decoding uses .dec decoder files, which describe Class or Vendor requests in a C-like 
language. Each .dec file stores an endpoint or request decode. When the application 
starts, these files are loaded dynamically. Subdirectories are supported.

For information about legacy script decoding, see Appendix C “Legacy Script Decoding” 
on page 287.

Note: The .dec files listed in the following table are in the Scripts directory under the 
installation directory. See Section 3.18 "Directory Structure on Windows XP and Vista" on 
page 45: 

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID

Audio Class decoding 2.0
     AudioClass\Audio1.0Requests.dec
     AudioClass\Audio2.0Requests.dec

Audio 01h

Communications and CDC Control
Direct Line Control Model
Abstract Control Model
Telephone Control Model
Multi-Channel Control Model
CAPI Control Model
Ethernet Networking Control Model
ATM Networking Control Model
Wireless Handset Control Model
Device Management Model
Mobile Direct Line Model
OBEX Model
Communication Device Subclass/EEM
     Communications\CommRequests.dec
     Communications\CommInterrupt.dec
     Communications\CommCDCEEM.dec

CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID

02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h

01h
02h
03h
04h
05h
06h
07h
08h
09h
0Ah
0Bh
0Ch
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HID (Human Interface Device)
HUT (HID extension)
Monitor (HID extension)
Physical Interface  
     (force-feedback extension to HID)
Point of Sale Devices (HID extension)
Power (HID extension)
     Hid\hid.dec
     Hid\Hid_Req.dec

HID
HID
HID
HID 

HID
HID

03h
Extension
Extension
Extension 

Extension
Extension

  

Physical
     Hid\hid.dec
     Hid\Hid_Req.dec

HID 05h

Still Imaging Class
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

06h 01h 01h

Printer
     Printer\Printer_req.dec

Printer 07h 01h xxh

Mass Storage Mass Storage 08h

SCSI/Bulk Protocol
     MassStorageClass\MS_BulkOnly_Requests.dec
     MassStorageClass\MS_BulkOnlySCSIInEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec

Mass Storage
   SCSI Bulk

08h

UFI (floppy)/CBI Protocol
     MassStorageClass\MS_UFI_CBI_Requests.dec
     MassStorageClass\MS_UFI_CBI_BulkInEndp.dec
     MassStorageClass\MS_UFI_CBI_BulkOutEndp.dec
     MassStorageClass\MS_UFI_CBI_InterruptEndp.dec

MassStrg Class
   UFI CBI

08h

Hub support
     HubClass\HubClassRequests.dec
     HubClass\HubClassStatusEndpoint.dec

Hub Class 09h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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Picture Transfer Protocol (PTP)
[Photographic and Imaging Manufacturers
Association (PIMA) 15740 and ISO 15740]
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

Extension

Communications Device Class (CDC) Data
     Communications\CDCDataBulkIn_wCTE.dec
     Communications\CDCDataBulkIn_wPW.dec
     Communications\CDCDataBulkIn_wPW_wCTE.dec
     Communications\CDCDataBulkOut_wCTE.dec
     Communications\CDCDataBulkOut_wPW.dec
     Communications\CDCDataBulkOut_wPW_wCTE.dec
     Communications\CDCDataIsochIn_wCTE.dec
     Communications\CDCDataIsochIn_wPW.dec
     Communications\CDCDataIsochIn_wPW_wCTE.dec
     Communications\CDCDataIsochOut_wCTE.dec
     Communications\CDCDataIsochOut_wPW.dec
     Communications\CDCDataIsochOut_wPW_wCTE.dec

0Ah 00h

Smart Card (CCID)
     SmartCard\CCIDBulkIn.dec
     SmartCard\CCIDBulkOut.dec
     SmartCard\CCIDInterrupt.dec
     SmartCard\CCID_req.dec
     SmartCard\ICCDBulkIn.dec
     SmartCard\ICCDBulkOut.dec
     SmartCard\ICCDInterrupt.dec
     SmartCard\ICCD_req_Ver.A.dec
     SmartCard\ICCD_req_Ver.B.dec

CCID and ICCD 0Bh

Video Class (UVC) decoding 1.1 (currently at 1.0)
VIDEO CONTROL
VIDEO STREAMING
VIDEO INTERFACE COLLECTION
     VideoClass\VideoBulkIn.dec
     VideoClass\VideoBulkOut.dec
     VideoClass\VideoInterrupt.dec
     VideoClass\VideoIsochIn.dec
     VideoClass\VideoIsochOut.dec
     VideoClass\Video1.0Requests.dec
     VideoClass\Video1.1Requests.dec

Video
Video
Video

0Eh
0Eh
0Eh
0Eh

01h
02h
03h

00h
00h
00h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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You can create your own .dec file for a Class or Vendor Request. For more information 
on the format of these Script Decoder files and the Script Decoding language, read the 
Script Decoder Manual.
You can show or hide the full MAC Payload or MAC/PHY headers  
(see See Section 4.3 "Trace Level Views for WUSB" on page 48).

Wireless Controller
BT
UWB
Remote Network Driver Interface Specification (RNDIS)
Host Wire Adapter
Device Wire Adapter
Device Wire Adapter isochronous interface
     WireAdapter\WA_DataInEndpoint.dec
     WireAdapter\WA_DataOutEndpoint.dec
     WireAdapter\WA_NotifEndpoint.dec
     WireAdapter\WA_Requests.dec
     WireAdapter\WA_Radio_Requests.dec
     WireAdapter\WA_RadioNotifEndpoint.dec

HCI
WA Radio Control
Remote NDIS
Wire Adapter Class
Wire Adapter Class
Wire Adapter Class

E0h
E0h
E0h
E0h
E0h
E0h
E0h

01h
01h
01h
02h
02h
02h

01h
02h
03h
01h
02h
03h

Miscellaneous Device Class
Interface Association Descriptor 
 

Wire Adapter Multifunction 
     Peripheral programming interface
Cable Based Association Framework (CBAF) Requests 

     Standard\StandardRequests.dec
     IEEE\IEEECompanies.dec
     Virtual\VirtualDATAIn.dec
     Virtual\VirtualDATAOut.dec
     Virtual\VirtualUARTIn.dec
     Virtual\VirtualUARTOut.dec
     AssociationFrameworks\  
          WUSB_CableBasedAssociation.dec

Standard,  
   so no decoder 
   method needed
Wire Adapter Class 

Association 
   Frameworks

 

EFh
EFh 
 

EFh 

EFh 

 

02h 
 

02h 

03h 

 

01h 
 

02h 

01h 

 

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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7.2 Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address and/or endpoint 
or interface in a trace file. Once assigned, the decoding occurs automatically when you 
display transactions.

Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display 
the Request Recipient and Endpoints dialog box: 

Figure 7.1 Request Recipient and Endpoints Dialog Box

The Recipient field shows all Class and Vendor Request Recipients found in the 
trace file. The display shows the Host, Address, and Type (Class or Vendor) for 
the recipient. On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu. 

Figure 7.2 Class/Vendor Decoding Groups Menu

The drop-down menu lists the defined Class/Vendor request decoding groups. 
The Class/Vendor Decoding Groups are:

• No Decoding
• Audio 1.0 Class Requests
• Audio 2.0 Class Requests
• Audio Class Requests
• Communication Class Requests
• HID Class Requests
• Hub Class Requests
• Mass-Strg Bulk-Only Requests
• Mass-Strg Class UFI CBI Requests
• Printer Class Requests
• Still Image/PTP/MTP/PictBridge Class Requests
• Standard Requests
• Video Class Requests
• Wire Adapter Radio Control Requests
• Wire Adapter Class Requests

Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.
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Step 8 Click OK.

Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the 
Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoints tab to display the Endpoints dialog box: 

Figure 7.3 Endpoints Dialog Box

The Endpoint field (Endp) shows all Endpoints found in the trace file. The 
displays shows the Host, Address, and Direction for the recipient. On the right 
are the names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

Figure 7.4 Class/Vendor Endpoint Coding Menu

The Class/Vendor Endpoint Decoding options for an OUT endpoint are: 

• No Decoding
• CCID Bulk Out Message
• Display DATA
• Mass Strg Bulk-Only SCSI Out Endp
• Mass Strg UFI_CBI Bulk Out Endp
• Still Image/PTP/MTP/PictBridge Bulk Out
• Video Bulk Out
• Video Isoch Out
• Virtual UART
• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are: 

• No Decoding
• CCID Bulk In Message
• Communication Class Interrupt Notification
• Display DATA
• HID In Endp
• Hub Class Status Change Endp
• Mass Strg Bulk-Only SCSI In Endp
• Mass Strg CBI Interrupt Endp
• Mass Strg UFI_CBI Bulk In Endp
• Mass Strg UFI_CBI Interrupt Endp
• Still Image/PTP/MTP/PictBridge Bulk In
• Still Image/PTP/MTP/PictBridge Interrupt
• Video Bulk In
• Video Interrupt
• Video Isoch In
• Virtual UART
• Wire Adapter Radio Notif Endp
• Wire Adapter Data Transfer In Endp
• Wire Adapter Notif Endp

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would like to 
map.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding
Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the 
following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif
To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB/WUSB Device Request 
menu. 

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request 
Recipient and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box:  

Figure 7.5 Request RPipes Dialog Box

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Host, WAddress, and Type (Class or 
Vendor) for the recipient. On the right are the names of Class/Vendor Decoding 
groups currently assigned to recipients. If blank, no decoding is assigned for a 
recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request 
Recipients.
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Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.

Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the 
Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog 
box: 

Figure 7.6 Endpoint RPipes Dialog Box

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Host, Address, and Direction for the recipient. On the right are the names of 
Class/Vendor Endpoint Decoding groups currently assigned to endpoints. If 
blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to 
map.

Step 8 To retain a mapping from trace to trace DURING an application session, 
select the Keep Across Recordings checkbox.

Step 9 Click OK.

7.3 General Options
Decoding uses control transfers called USB/WUSB Device Requests. Device Requests 
depend on the Device Class and Vendor specifications.

Decoding USB/WUSB Device Requests
To decode a USB/WUSB Device Request: 

Step 1 Left-click the Control Transfer field of the USB/WUSB Device Request 
to display the USB/WUSB Device Request menu: 

Figure 7.7 UWB Device Request menu

Note The menus shown in this section are context-sensitive. You may see 
slightly different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use 
this option to reanalyze all transactions.

Step 3 To move to the next Control Transfer field, click Find Next Occurrence.
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Step 4 To expand data fields for one row, use Expand WUSB Trans Out, 
Expand WUSB Trans In, Expand This WUSB Transfer, or Expand 
WUSB Xfer.

Step 5 To collapse data fields for one row, use Collapse WUSB Trans Out, 
Collapse WUSB Trans In, Collapse This WUSB Transfer, or Collapse 
WUSB Xfer.

Step 6 To expand all data fields of the same type, use Expand All WUSB Trans 
Out Fields, Expand All WUSB Trans In Fields, Expand All WUSB 
Transfers, or Expand All WUSB Xfer.

Step 7 To collapse all data fields of the same type, use Collapse All WUSB 
Trans Out Fields, Collapse All WUSB Trans In Fields, Collapse All 
WUSB Transfers, or Collapse All WUSB Xfer.

Note: You can also change the format, color, and hidden status of fields, using 
the same methods as in Display Options. (See Chapter 6, Display 
Options.)
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Decoding Standard Requests
To decode a standard request: 

Step 1 From the USB/WUSB Device Request menu, select Decode Standard 
Request to display the View Fields for Standard Request text box: 

Figure 7.8 Standard Request Text Box

Step 2 To find a word in the text box, click the Find button. Enter the word in the 
Find What field. To use a case-sensitive search, check Match Case. To 
find only the exact word, check Match Whole Word Only. You can 
search Up or Down. To search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As 
button, enter a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same 
request type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of 
the Standard Request. 



UWBTracer/Trainer  User Manual Chapter 7: Decoding USB/WUSB Requests

LeCroy Corporation  93

For field definitions, please refer to the Universal Serial Bus Specification, version 2.0. 
The USB specification is available from the USB Implementers Forum (USB-IF) at: 

Decoding Class Requests
Examples of a class request are Mass-Strg Class UFI CBI Requests, PTP Still Image 
Class Requests, Video Class Requests, and Wire Adapter Class Requests. 

To decode a class request: 

Step 1 From the USB/WUSB Device Request menu, select 
Decode ... Request to display the View Fields for ... Class Requests 
text box.

Figure 7.9 shows a Wire Adapter Class Requests decoding:

Figure 7.9 View Fields for Wire Adapter Class Requests Request Text 
Box

USB Implementers Forum 
1730 SW Skyline Blvd.  
Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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Figure 7.10 shows a Mass Storage Bulk-only Request: 

Figure 7.10 View Fields for Mass Storage Bulk-only Class Requests 
Text Box

Decoding Vendor Requests
To decode a vendor request: 

• Select Decode ... Request to display the View Fields for ... Vendor Requests text 
box.

An example of a vendor request is UWBTracer™ Command Set. 

Decoding Undefined USB/WUSB Device Requests
A Decoding Request may not belong to any of the defined decoding groups (Standard, 
Class, or Vendor).

Decoding using Endpoint Information
To decode using the endpoint information: 

Step 1 Left-click the Bulk/Int Transfer field to display the Bulk/Int Transfer 
(IN/OUT transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.
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Figure 7.11 shows a Wire Adapter Data Transfer In Endp decoding: 

Figure 7.11 View Fields for Wire Adapter Data Transfer In Endp Text Box

Figure 7.12 shows a Wire Adapter Data Transfer Out Endp decoding: 

Figure 7.12 View Fields for Wire Adapter Data Transfer Out Endp Text Box
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Figure 7.13 shows a Wire Adapter Data Transfer Out Endp decoding: 

Figure 7.13 View Fields for Wire Adapter Data Transfer Out Endp Text Box

Figure 7.14 shows a Wire Adapter Notif Endp decoding: 

Figure 7.14 View Fields for Wire Adapter Notif Endp Text Box

Figure 7.15 shows a Mass Storage Bulk-only SCSI In Endpoint decoding: 

Figure 7.15 View Fields for Mass Storage Bulk-only SCSI In Endp Text Box
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Figure 7.16 shows a Mass Storage Bulk-only SCSI Out Endpoint: 

Figure 7.16 View Fields for Mass Storage Bulk-only SCSI Out Endp 
Text Box

Changing the Layout of Decode Requests
In the View ... Fields windows, the Decoding Information and the Descriptor information 
blocks (following the Request Summary information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, bDescriptorType, wTotalLength
• Length in bits
• Offset in bits
• Decoded: hex value typically equal to Hex Value
• Hex Value: hex value typically equal to Decoded
• Description: short description of field
To change the layout of decode requests display: 
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Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box: 

Figure 7.17 View WUSB Xfer Fields Dialog Layout Dialog Box

Step 2 To display the available columns of data, use the checkboxes for 
Length, Offset, Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields 
specified for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check Use 
these settings when View Fields dialog opens.
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Chapter 8:  Decoding WLP Frames and 
Protocols

8.1 Overview
The WLP protocol defines four types of frames, each identified by a frame type field: 

• Data frames
• Standard data frames
• Abbreviated data frames

• Control frames
• Association frames
Data frames can carry high-level protocol data payloads, such as IP, ARP, and TCP.

The LeCroy UWBTracer/Trainer software can decode:

• All the WLP frame types at the WLP level (using the WLP button on the transaction 
toolbar)

• IP and ARP Ethernet protocol data units carried inside WLP data frames (using the 
WI ETH button on the transaction toolbar)

• TCP and UDP Internet Protocol (IP) protocol units carried inside WLP data frames 
(using the WI IP button on the transaction toolbar)

The WLP levels are a special way to decode WiMedia frames, so you cannot expand the 
WLP levels. 

You can show or hide the full MAC Payload or MAC/PHY headers  
(see “Trace Level Views for WLP” on page 51).

8.2 Decoder Script Files
The UWBTracer/Trainer analyzer software uses script files to decode WLP frames. The 
script files are read when the application is initialized. Once read, the Analyzer then 
decodes WLP frames using script-based decoders.

Script-based decoders are compiled from .dec decoder files, which describe a decoding 
program in a C-like language. The .dec files are in the Scripts directory under the 
application directory. 

Each .dec file stores a decoding routine that is used to decode some kind of recorded 
traffic. When the application starts, these files are loaded dynamically. 

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.
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The WLP protocol script folder tree starts in the MUXProtocols folder in the  
C:\Program Files\LeCroy\UWBTracer\Scripts directory.

Figure 8.1 WLP Script Folder

Subdirectories are supported.

The WLP subfolder contains all script files necessary to decode the WLP protocol and 
the high-level protocols based on WLP. 

Figure 8.2 WLP Subfolder
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The Ethernet subfolder contains the script files necessary to decode IP and ARP 
Ethernet-based protocols.

Figure 8.3 Ethernet Subfolder

The IP subfolder contains the script files necessary to decode the TCP and UDP 
IP-based protocols. 

Figure 8.4 IP Subfolder
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Chapter 9:  Reports
Reports assist you in analyzing traffic recorded by the analyzer. The available reports 
are: 

• File Information: To view general information about the trace file.
• Error Summary: To view a count of errors in a trace file.
• Timing Calculations: To view timing measured between two markers or counters 

set within the trace file.
• Traffic Summary: To view a summary of protocol-related information in the trace 

file summary information about a selected group of items in the trace file (such as a 
count of particular frame or packet types).

• Device List: Lists the DUTs, active devices, archive devices, wireless USB, and 
WLP devices by DUTs, Type, EUI-48, Address, Alias, Last Updated, and 
User Notes

• Timing Analysis Views: Analyzes Beacon, WUSB, and Superframe timing.
• Run Verification Scripts: To run verification scripts over the open trace, perform 

custom trace analysis, and create custom reports. (Fore more information, see the 
LeCroy UWBTracer Verification Script Engine Manual.)

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.

Reports are available from the Report menu and from buttons on the Tool bar. 

Figure 9.1 Report Menu

This chapter also describes:

• Real Time Statistics: Summarizes the occurrences of frame types and error types 
in a trace file for all connected devices.

• Bus Utilization: Displays information on bandwidth use for the recording channels.



Chapter 9: Reports UWBTracer/Trainer  User Manual

104 LeCroy Corporation

9.1 File Information
To view general trace information, such as time a trace was made, version of the analyzer 
firmware, and BusEngine™ used, select Report > File Information to display the File 
Information window (Figure 9.2).

Figure 9.2 File Information Window

To view the Recording Options settings, select the Open Recording Options in a dialog 
link to display the Recording Options window.
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9.2 Error Summary
To view a count of errors, select Report > Error Summary to display the Traffic 
Summary window (Figure 9.3). 

Figure 9.3 Error Summary Display

The right pane displays the error counts.

Note:  You cannot change the types of errors included in the summary.
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9.3 Timing Calculations
The timing calculator measures timing between any two specified frames. To run the 
Timing Calculator:

Step 1 From the Report menu, select Timing Calculations.

Step 2 Select the range From Frame To Frame, and then click the Calculate 
button to display the results. 

Figure 9.4 Timing and Bus Usage Calculator
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9.4 Traffic Summary
To view a summary of protocol-related information, select Report > Traffic Summary to 
display the Traffic Summary window (Figure 9.5).

In the left pane, select or expand a WiMedia or WLP report or Errors to display the items 
and counts of the report in the right pane. 

Figure 9.5 Traffic Summary Window



Chapter 9: Reports UWBTracer/Trainer  User Manual

108 LeCroy Corporation

Traffic Summary Buttons
The Traffic Summary toolbar provides a shortcut to commands that control the traffic 
summary (Figure 9.6). 

Figure 9.6 Traffic Summary Toolbar

Table 9.1 describes the Traffic Summary buttons.

Table 9.1Traffic Summary Buttons

Using the Traffic Summary
To use the traffic summary window, you need to know how to select the items for which 
you want a summary, to set a range for the summary, and to use navigational features.

Selecting Traffic Summary Items
As described, you use the left pane of the Traffic Summary window to select the item for 
which you want to show a summary in the right pane.

For example, suppose you want to show the count of all MPI Frames in the trace. To do 
so, select MPI frames in the left pane (Figure 9.7). A count of the number of MPI frames 
appears in the right pane. In this example, there are three MPI Control frames and three 
MPI Data frames. 

Figure 9.7 Selecting an Item for the Traffic Summary

Save. Saves the traffic summary to 
a file in HTML format.

Text. Displays the traffic summary in 
text format.

Email/Send. Sends the traffic 
summary in HTML format via an 
email.

Options/View. Opens a menu that 
allows you to set the way trace file 
items are counted for the traffic 
summary.

Print. Prints the traffic summary.
Select Range. Sets a range of items 
to be counted in the trace file.
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You can select multiple items in the left pane, each resulting in a separate summary in 
the right pane (the summaries follow each other sequentially) (Figure 9.8). To select more 
than one item, hold down the CTRL key as you select items in the left pane. 

Figure 9.8 Selecting Multiple Items for the Traffic Summary

Setting Traffic Summary Display Options
You can control the appearance of the traffic summary display using the Options button 
on the Traffic Summary tool bar. When you click the button, the Options drop-down menu 
appears (Figure 9.9). 

Figure 9.9 Traffic Summary Options Menu

Grid Lines: Enables/disables grid lines to the display.

Row Selection: Enables/disables row highlighting in the right pane.

Tight Columns: Enables/disables narrow columns in the display.
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Event Navigation: Displays a menu that allows you to set parameters for using traffic 
summary to navigate in the trace (trace navigation is described later in this section) 
(Figure 9.10). 

Figure 9.10 Event Navigation Submenu

In the Event Navigation menu, the Skip hidden items option means you cannot navigate 
to hidden items in the trace. Show hidden items means if you navigate to a hidden item, 
the item is shown in the trace. Prompt each time means you can navigate to a hidden 
item, but UWBTracer/Trainer™ prompts you to indicate whether or not you want the item 
to appear in the trace.

Setting Traffic Summary Range
You can select a range within the trace file for which items are displayed in the traffic 
summary. All occurrences of the item outside of the range are not included in the 
summary. You can set the range with respect to particular frame or packet types. Your 
choice of these types is context-sensitive and is determined by the current trace decode 
level (MPI trace level view, WUSB packet level view, and so on).

In the following example, suppose you have trace decode level set to WUSB packet level 
view and suppose the trace contains six MPI frames. 

To collect statistics from the third through fifth MPI frames (inclusive):

Step 1 With the trace file open, select Traffic Summary from the Report menu 
(or click the Traffic Summary button on the Main tool bar). The Traffic 
Summary window appears.
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Step 2 Select MPI frames in the left pane of the Traffic Summary window. The 
summary for MPI frames appears in the right pane.

Step 3 Click the Select Range button on the Traffic Summary tool bar 
(Figure 9.11). 

Figure 9.11 Selecting Traffic Summary Range

Step 4 The Select Range dialog box appears (Figure 9.12). 

Figure 9.12 Select Range Dialog Box

Step 5 In the Select Range dialog box, select WiMedia Frame as the protocol 
unit. Enter 3 as the start point of the range (Figure 9.13). 

Figure 9.13 Setting Range to Start on Third Frame

Step 6 The Traffic Summary window now shows statistics for Frame 3 through 
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Frame 16876 of the trace (Figure 9.14). 

Figure 9.14 Traffic Summary for Three MPI Frames

Using the Display to Navigate Within the Trace File
You can use the Traffic Summary window to navigate to a specific frame or packet in the 
trace file. For example, suppose you want to go to the second MPI Data frame. 

To navigate:

Step 1 With the trace file open, select Traffic Summary from the Report menu 
(or click the Traffic Summary button on the Main tool bar). The Traffic 
Summary window appears.

Step 2 Select MPI frames in the left pane of the Traffic Summary window. The 
summary for MPI frames appears in the right pane.

Note:  In this example, the trace contains three MPI Control frames and three MPI 
Data frames.

Click the count in the total column for Data frames (Figure 9.15). 

Figure 9.15 Selecting the Row for Data Frames

Step 3 The Go box becomes active at the top of the right pane (Figure 9.16). By 
default, it is set at the first MPI Data frame (MPI 1), shown at the top in 
the trace. 

Figure 9.16 First MPI Data Frame at Top of Display
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Step 4 In the Go box, enter 2 to indicate that you want to go to the second MPI 
Data frame in the trace (Figure 9.17). 

Figure 9.17 Set Go Box to Second MPI Data Frame

The trace display adjusts so that the second Data frame appears at the top of the display 
(MPI 3), shown at the top of the trace (Figure 9.18). 

Figure 9.18 Set Go Box to Second MPI Data Frame 
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9.5 Real-Time Statistics
To display a summary of the occurrence of various types of protocol units in a trace file, 
select Report > Traffic Summary from the Report menu. A Traffic Summary window 
appears, showing the traffic data (Figure 9.5).

To display information on links activity in real-time, select Report > Real-Time Statistics 
from the Report menu. The Real-Time Statistics window shows frames, errors, and 
events occurrences (Figure 9.19). 

Figure 9.19 Real-Time Statistics window

The window has two areas:

• Graph Area (left side of window): Provides graphs that show occurrences of 
particular frames, errors, and events. 

• General Statistics Area (right side of window): Provides displays that show signal 
strength, link quality, number of frames, and signal status. All data that is displayed 
is calculated as averages over a sampling period.

Changing Devices
The window can display information from multiple analyzer devices. You toggle displays 
for each device by clicking on tabs in the General Statistics area. For example, as shown 
in Figure 10.19, the SN567 tab is selected. The display currently shows information for 
the SN567 device. To switch the display to information for the SN566 device, click the 
SN566 tab. 
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Changing Channels
The window can display information from the MPI or RF channel. In the Channel field at 
the top of a device tab, select MPI or RF from the drop-down list. Figure 9.19 shows the 
MPI channel of the SN566 device.

Tool Bar
The Real-Time Statistics window tool bar provides quick access to key functions of the 
window (Figure 9.20). 

Figure 9.20 Real-Time Statistics Tool Bar

Table 9.2 describes the Real-Time Statistics buttons.

Table 9.2Real-Time Statistics Toolbar Buttons

Save Vertical Zoom out

E-mail "Click and Drag" Zoom Area

Print Synchronize Graph Areas

Full Screen Graph Areas

View Settings Start Real-Time Statistics

Horizontal Zoom in Stop Real-Time Statistics

Horizontal Zoom out Reset Graphs and Counters Display

Vertical Zoom in
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Graph Area
The graph area displays two graphs: occurrences of frames and occurrences of errors. 
You can set the properties of each through a Graph Area Properties dialog box. To bring 
up the dialog box for either of the two graph types:

Step 1 Place the cursor in a graph area, then right-click to display a pop-up 
menu (Figure 9.21).

Figure 9.21 Real-Time Graphs Pop-Up Menu

Step 2 Click Properties to display the Graph Area Properties dialog box for the graph.
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Graph Properties for Frame Occurrences
Figure 9.22 shows the Graph Properties dialog box for the Frame Occurrences graph, at 
the Data Frames panel. You can select from graphs that show statistics about different 
frame types: Beacons, Control Frames, Command Frames, Data Frames, Aggregated 
Data Frames, and Device-specific and General Events.You can change the Appearance 
and Color. Graphs for each analyzer in the analyzer network (SN566, SN567 and so on) 
are listed separately. When you add a new analyzer to the analyzer network, a new set 
of graphs is added to the list. 

Figure 9.22 Graph Area Properties for Data Frames

Buttons
By default, all checkboxes are selected.

To remove a frame type from the display, deselect the frame type checkbox.

To add a frame type for a device, click New and select the device and frame type.

To delete a frame type for a device, highlight the frame type, then click Delete.

To restore the default settings for all frames, click Restore defaults.
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Device-specific and General Events
Figure 9.23 shows the Graph Properties dialog box for the Frame Occurrences graph at 
the Device-specific and General Events panel.

Figure 9.23 Graph Area Properties for Device-specific and General Events

You can change the Appearance and Color.

For Device-specific Events, the panel shows the device number and ID or Name. Events 
can be Channel Change or Beacon Change. 

For General Events, the events can be USB Connection Context Valid, USB Connection 
Context Failed, USB Pairwise Temporal Key Valid, or USB Pairwise Temporal Key 
Failed.
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Graph Properties for Error Occurrences
Figure 9.24 shows the Graph Area Properties dialog box for the Error Occurrences 
graph. There are two types of error graphs: Device-specific Errors and General Errors. 
You can change the Appearance and Color. 

Device-specific Errors
Device-specific Errors can be associated with specific UWB devices. 
The Device-specific Errors that you can monitor are:

• PHY Payload Error
• PHY Unsupported Rate

Figure 9.24 Graph Area Properties for Device-specific Errors
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General Errors
General Errors cannot be associated with specific UWB devices. Currently, there is one 
General Error that you can monitor through this graph:

• Header Error

Figure 9.25 Graph Area Properties for General Errors
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General Statistics Area
The right side of the Real-Time Statistics window shows the General Statistics area. The 
following figure (Figure 9.26) shows MPI information. 

Figure 9.26 Real-Time Statistics Window: General Statistics Area for MPI 
Information

It has the following displays: 

• Number of analyzer devices connected: Each one has a tab in the display.
• Channel: MPI or RF
• Accumulators: Running count of total frames displayed during the statistics collec-

tion period.
• RSSI By Device: Histogram showing received signal strength for UWB devices.
• LQI By Device: Histogram showing link quality for up to eight UWB devices.
• MPI Wire Activity: Signal state on the MPI bus:

• Purple bar: Signal high
• Green bar: Signal low
• Red arrow: Signal toggled at least once during latest signal period
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The following figure (Figure 9.27) shows MPI information. 

Figure 9.27 Real-Time Statistics Window: General Statistics Area for RF 
Information

It has the following displays: 

• Number of analyzer devices connected: Each one has a tab in the display.
• Channel: MPI or RF
• Accumulators: Running count of total frames displayed during the statistics collec-

tion period.
• RSSI By Device: Histogram showing received signal strength for UWB devices.
• LQI By Device: Histogram showing link quality for up to eight UWB devices.
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9.6 Bus Utilization
The Bus Utilization window displays information on bandwidth use for the recording 
channels.

To open the Bus Utilization window, select Report > Bus Utilization or

click the  button. 

Figure 9.28 Bus Utilization Window
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:

Figure 9.29 Bus Utilization Buttons

The buttons have the following functions: 

Save As - Saves the 
graphs as a bitmap file 
(*.bmp)

Vertical zoom in

Email - Creates an email 
with a *.bmp file 
attachment of the graphs

Vertical zoom out

Print
"Click and Drag" zoom mode - Click 
diagonally to select and zoom in on part 
of the graph

Full screen Select Range

View settings - opens a 
sub-menu with options for 
formatting the display. 
See “View Settings Menu” 
below.

Synchronize graph areas - If two or more 
graphs are displayed, this button 
synchronizes the graphs to one another. 
Once synchronized, the positioning 
slider of one graph moves the other 
graphs.

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and percentage 
of bus utilized.

Horizontal zoom out
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View Settings Menu
Clicking the View settings button  causes a menu to open with options for 
formatting the display. 

Figure 9.30 View Options: View Settings Menu

• Orient Horizontally: changes the orientation of bus usage to horizontal. After 
selecting this option, the menu has Orient Vertically.

• Tile Vertically: tiles the two graphs vertically (i.e., side by side). After selecting this 
option, the menu has Tile Horizontally.

• Show Markers: Places "tick" marks along the x axis of each graph.
• Show Plumb Line
• Status: Opens a submenu with the following options:

• Bar: Displays a status bar at bottom of graph.
• Tooltip: Causes a tooltip to appear if you position your mouse pointer over 

part of the graph and leave it there for a couple of seconds.
• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a submenu with the following options:
• Both Axes: Displays both X and Y axis gridlines
• X Axis: Displays X axis gridlines
• Y Axis: Display Y axis gridlines
• No Grid: Turns off gridlines

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors - Opens a dialog box for setting the colors and fonts used in the 
graphs:

Figure 9.31 View Options: Fonts and Colors

Graph Areas Menu
The Graph Areas menu allows you to view different information types in the Bus 
Utilization window. 

Step 1 Click the  button to display the Graph Areas menu: 

Figure 9.32 Graph Areas Menu

Step 2 Select the data you want to appear in the Graph Areas window: Packet 
length, Data length, RSSI & LQI, and/or Data Throughput. 
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To change the properties in the Bus Utilizations graph: 

Step 1 In the Graph Areas menu, click New to display the Graph Area 
Properties dialog box. 

Figure 9.33 Graph Area Properties Dialog Box

Step 2 Select the graph or click New to make a new graph.

Step 3 Enter a graph title in the Title field.

Step 4 Select the Type: Packet length, Data Payload length, RSSI, LQI, or Data 
Throughput.

Step 5 Select the Appearance: single or multiple color bars or lines, or thick 
lines. If you selected bars, select the Color.

Step 6 Click OK.
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9.7 Device List
The Device List window lists the DUTs, active devices, archive devices, wireless USB, 
and WLP devices by DUTs, Type, EUI-48, Device Address, Alias, Last Updated, 
Association, and User Notes. 

Figure 9.34 Device List Window

(For information about encryption keys, association data, and 4-way handshakes, see 
Section 11.5, “Secured Traffic” on page 167.)

For information about the recording options related to decryption and security, see 
Section 12.2, “Recording Options: RF” on page 178.

Options
You can display the list in HTML View or Grid View using the  button. 

If the Device List is displayed in HTML View, you can print the list. (Do not print from 
Grid View.)

You can import a UWB Device List Saved File (extension .dl). 
You can save the Device List as a CSV file.
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Adding a WiMedia Device
You can add a WiMedia device and change its settings, temporal key, 
connection context, or WSS group.

Edit General Settings
To add a WiMedia device: 

Step 1 In the Device List window, click the Add New Device  button to 
display the Add New Device dialog box at the General Settings tab: 

Figure 9.35 Add New Device Dialog Box General Settings Tab

Step 2 In the Add New Device dialog box, select the Device Type as 
WiMedia Device, Wireless USB Host, Wireless USB Device, or 
WLP Device. 

Step 3 Enter the EUI-48 in 12-digit hexadecimal. 

Step 4 Enter the Device Address in 4-digit hexadecimal. 

Step 5 (optional) Enter an Alias (up to 54 characters). 

Step 6 (optional) Enter any User Notes (up to 76 characters). 

Step 7 (optional) Select the DUTs checkbox if applicable. 
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Edit Temporal Keys
Because you can program the encryption keys, UWBTracer/Trainer supports traffic 
decryption from any WiMedia device.

UWBTracer/Trainer can decrypt traffic in real-time for up to 32 different PTK values.

To decrypt secured traffic using PTK values, in the Device List dialog box, program the 
PTK values.

If decryption is enabled in Recording Options, when an encrypted frame with a matching 
TKID is seen, UWBTracer/Trainer decrypts the encrypted portion of the frame payload.

To add connection contexts for a WiMedia Device, use the Temporal Key tab. The WUSB 
Settings and WLP Settings tabs are not available.

To add temporal keys:

Step 1 Select the Temporal Key tab.

Figure 9.36 Temporal Key Tab
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Step 2 Click Add to display the Add Temporal Key dialog box. 

Figure 9.37 Add Temporal Key Dialog Box

Add a temporal key by specifying TKID (temporal key ID) in 6-digit hexadecimal 
and  TK (temporal key) in 32-digit hexadecimal.

Note: To complete the settings needed to decrypt traffic with a temporal key, you 
must also add the Host’s MAC (16-bit) Address.

Click OK to return to the Temporal Key tab.

Step 3 Click OK to exit the Add New Device dialog box.

Edit WUSB Device or Host Connection Context using 
WUSB Settings
For Certified WUSB, UWBTracer/Trainer can derive temporal keys (PTK) in real-time 
from in-band WUSB Four-Way-Handshakes. UWBTracer/Trainer continuously monitors 
the WUSB traffic and derives a new temporal key (PTK) whenever a new WUSB 
Four-Way-Handshake process occurs. UWBTracer/Trainer can track 
Four-Way-Handshakes for up to 32 different WUSB Connection Contexts. 

Note:  If you have multiple Four-Way-Handshakes for different pairs of devices, 
make sure that the Host completes the Four-Way-Handshake process with 
one device at a time. 

To decrypt secured traffic using connection context, in the Device List dialog box, 
program the WUSB Connection Context (CDID, CHID, CK) that exists between the 
WUSB Host and a WUSB Device. UWBTracer/Trainer tracks the WUSB 
Four-Way-Handshake between the Host and the Device and derives the PTK.
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Wireless USB Host
To add connection contexts for a Wireless USB Host device: 

Step 1 Select the WUSB Settings tab. 

Figure 9.38 Add New Device Dialog Box WUSB Settings Tab for 
Wireless USB Host

Step 2 Enter the CHID (connection host ID) in 32-digit hexadecimal.

Step 3 Click Add to display the Add Connection Context dialog box. 

Figure 9.39 Add Connection Context Dialog Box

Step 4 Add a connection context by specifying CDID (connection device ID) in 
32-digit hexadecimal and  CK (connection key) in 32-digit hexadecimal.

Step 5 Click OK to return to the WUSB Settings tab.

Step 6 Click OK to return to the General Settings tab.
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Wireless USB Device
To add connection contexts for a Wireless USB Device device: 

Step 1 Select the WUSB Settings tab. 

Figure 9.40 Add New Device Dialog Box WUSB Settings Tab for 
Wireless USB Device 

Step 2 Enter the CDID (connection device ID) in 32-digit hexadecimal.

Step 3 Click Add to display the Add Connection Context dialog box  
(see Figure 9.39). 

Step 4 Add a connection context by specifying a CHID (connection host ID) in 
32-digit hexadecimal and a CK (connection key) in 
32-digit hexadecimal.

Step 5 Click OK to return to the Device Type Specific Settings tab.

Editing a WUSB Device
To edit a WUSB device, select the device in the Device List, then click  
 
the Edit Device  button. 

You can edit only the Alias, User Notes, and DUTs checkbox of the device data in the 
Edit Device dialog box General Settings tab. 

You can edit only the list of hosts or devices in the WUSB Settings tab. 
CDID and CHID are both editable.
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Join or Remove WLP Device from Existing WSS Group using WLP 
Settings
To add connection contexts for a WLP Device: 

Step 1 Select the WLP_Settings tab. 

Figure 9.41 Add New Device Dialog Box WLP Settings Tab

Step 2 Use check boxes to indicate if the WLP device is a Device, Bridge, 
and/or Remote Bridge.

Step 3 Indicate the WSS’s that the WLP device has joined and not joined, using 
the Add and Remove buttons.

Step 4 Click OK to return to the Device List.
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Adding a WSS Group
To add a WSS group: 

Step 1 In the Device List window, select the WLP_Devices line.  

Step 2 In the Device List window, click the Add New Device  button to 
display the Add New WSS dialog box: 

Figure 9.42 Add New WSS Dialog Box

Step 3 Enter the WSS Version in 2-digit hexadecimal.

Step 4 Enter the WSS ID in 32-digit hexadecimal. The WSS ID Hash Value is 
automatically calculated based on the WSS ID entered.

Step 5 Enter the WSS Name (up to 255 characters).

Step 6 Enter the Broadcast Address in EUI48 format.

Step 7 Enter the Master Key in 32-digit hexadecimal.

Step 8 Use the check box to indicate if the WSS is secured.

Step 9 Click OK to return to the Device List.
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Editing a WSS Group
To edit a WSS Group, select the device in the Device List, then click  
 
the Edit Device  button. 

Figure 9.43 Edit WSS Device Dialog Box

You can edit only the WSS Version, WSS Name, Broadcast Address, Master Key, and 
Secured checkbox of the device data in the Edit WSS dialog box. 

Delete Device
To delete a device, select the row in the Device List, then click the Delete Device  
button.
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9.8 Running Verification Scripts
You can perform custom post-process analysis of the open trace by running a 
verification script over the trace. A verification script instructs the UWBTracer/Trainer 
application to send trace and analysis information to the script. A verification script also 
contains script code (written using LeCroy Script Language) used to process trace data 
and output that data in different formats.

For information about the available scripts, see Appendix C “WiMedia Platform 
Compliance Tests” on page 289.

Note:  You may write your own verification scripts to perform custom verification 
and analysis. For information on how to write a verification script, see the 
UWBTracer Verification Script Engine Reference Manual.

To run a verification script over a trace:

Step 1 Select the UWBTracer/Trainer™ main menu item 
Report > Run verification scripts or click the 
Run verification scripts button on the main tool bar (if it is not hidden):

Figure 9.44 Run Verification Scripts Command
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The Run verification scripts dialog opens, from which you choose, then run, one 
or several verification scripts:

Figure 9.45 Run Verification Scripts Dialog
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Step 2 Push the button Run scripts after you select scripts to run. VSE starts 
running the selected verification scripts, shows script report information 
in the output windows, and presents the results of verifications in the 
script list: 

Figure 9.46 Run Verification Scripts Run
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Step 3 Right-clicking in the script list displays some additional operations over 
selected scripts: 

Figure 9.47 Run Verification Scripts Options

Run verification script(s): Start running selected script(s).

Edit script: Edit selected scripts in the editor application specified in Editor settings.

New script: Create a new script file using the template specified in Editor settings.

Show Grid: Show/hide a grid in the verification script list.

Show Description window: Show/hide the script description window (Shortcut key F2).

Show Output: Show/hide the script output windows (Shortcut key F3).

Settings: Open a special Setting dialog to specify different settings for VSE.
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Step 4 After choosing Settings, the Settings dialog appears: 

Figure 9.48 Run Verification Scripts Settings Dialog
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9.9 Timing Analysis Views
You can perform a Beacon, WUSB, or Superframe timing analysis.

To display an empty Timing Analysis window, 

select Report > Beacon/WUSB Timing Analysis or 

click the Timing Analysis button .

Figure 9.49 Empty Timing Analysis Window

Frame WUSB Detail View in Timing Analysis Window
To select a frame for timing analysis and display the WUSB Detail in the Timing Analysis 
window, left-click the frame header, such as WM Frm 0, to display a drop-down menu:

Figure 9.50 Left-Click Frame Menu



UWBTracer/Trainer  User Manual Chapter 9: Reports

LeCroy Corporation  143

Then select Show in Timing Analysis View to display the WUSB Detail View. 

Figure 9.51 WUSB Detail View in Timing Analysis Window
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Timing Analysis Buttons
The Timing Analysis toolbar has function to select, zoom, synchronize, insert, and 
display. To learn the function of each button, pass the cursor over it to display button 
descriptions on the Status bar at the bottom of the window and tooltips above each 
button. 

Zoom
Using the toolbar buttons, you can:

• Zoom in
• Zoom out
• Select an item and zoom by dragging
• Drag the horizontal axis to zoom

Synchronizing
You can synchronize views and graphs by Time using the Sync by Time button .

Selecting a Time
Using the toolbar buttons, you can select using a:

• Pointer: To select a frame and see details about it in the Text Panel.
• Hand: Click and drag to pan the view.

Inserting a Time Marker
To insert a time marker, click the Insert Time Markers button , point to a location in the 
view, then click and drag to display the time span between the locations of interest.

Zoom In Zoom Out

Zoom by Selection Zoom by Horizontal Drag

Pointer Mode Hand Panning

Insert Time Markers Sync by Time

Full Screen Add/Remove Views
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Views
Using the toolbar buttons, you can add or remove the Beacon Period, Wireless USB, and 
Superframe Grid   Views:

Beacon Period View
The Beacon Period view provides in-depth analysis of a beacon group. Beacons are 
displayed in time-order, and their BPOIE contents are shown graphically. The Prior BP 
column allows easy comparison between what the analyzer receives and what the 
devices receive.

Figure 9.52 Beacon Period View

Row Descriptions
In the left column are the following row descriptions:

• Dur: Duration (in nanoseconds) of the beacon frame in that slot.
• Slot: The “calculated” beacon slot number in the superframe, derived from the 

timing of the slowest device, counting up to the last slot that had some activity.
• T: Slot start time, which is the BPST plus the microsecond offset of each slot relative 

to the BPST.
• SF#: Super Frame Number

Beacon Information
To select a beacon, click in a beacon in the view. A solid blue rectangle indicates a 
selected beacon frame.To display information about the selected beacon frame, display 
the Selected Text Panel by right-clicking in the view to display a popup menu and 
selecting Selected Text Panel. 
To display information about a beacon, display the Current Text Panel by right-clicking in 
the view to display a popup menu and selecting Current Text Panel. Move the cursor 
over a beacon in the view. A dashed blue rectangle indicates the “under mouse” beacon 
frame. 

You can compare the selected and current MAS information.
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Display Options for Beacon Period View
Right-click the Timing Analysis window Beacon Period View to display the 
Timing Analysis Display Options for Beacon Period View menu:

Figure 9.53 Timing Analysis Display Options for Beacon Period View 
Menu

The options are:

• Show Chart Title: Display or hide the left vertical blue bar that says 
WUSB Detail View or Beacon Period View.

• Show Legend: Display or hide the list of colors for Beacon Specification, Alien 
Beacon Specification, Invalid Beacon Specification, Slowest Device Indicator, Prior 
BP, Movable, Invalid, Unoccupied, Occupied and Invalid, Occupied and Movable, 
Occupied and Nonmovable

• Show Selected Text Panel: Display or hide the Selected Item window in the lower 
right corner.

• Show Current Text Panel: Display or hide the Item Under Cursor window in the 
lower right corner.

• Show SuperFrame Axis: Display or hide the bottom bar that shows the 
SuperFrame index.

• Show Time Axis: Display or hide the tan time axis at the bottom of the window.
• Show Slots Axis: Display or hide the green slots axis at the bottom of the window.
• Show Duration Axis: Display or hide the duration bar at the top of the window.
• Show Title Axis: Display or hide the Traffic and Transaction Group headings at the 

left of the window.
• Property Dialog: Allows you to set time synchronization and select the display 

options for the Beacon Period, WUSB Detail, and Superframe Grid views (see 
previous section for screenshot).
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• Property Dialog: Allows you to set time synchronization and select the display 
options for the Beacon Period, WUSB Detail, and Superframe Grid views.

Figure 9.54 Timing Analysis Property Dialog
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Wireless USB View
The Wireless USB view provides a graphical depiction of the timing between the WUSB 
packets in a transaction group and between transaction groups. The top row (starting with 
MMC and In in Figure 9.55) depicts the timing and duration of the actual received packet. 
The bottom row (starting with MMC, DNTS, and DT in Figure 9.55) shows the scheduled 
time windows (CTAs), which are extracted from the MMC packets. The bottom MMC 
depicts the “start time” of the top MMC, which is really very short, as a fading colored 
block for clarity. 

Figure 9.55 WUSB Detail View

Block Information
To select a block, click it in the view. A solid blue rectangle indicates a selected block.To 
display information about the selected block, display the Selected Text Panel by 
right-clicking in the view to display a popup menu and selecting Selected Text Panel. 
To display information about a block, display the Current Text Panel by right-clicking in 
the view to display a popup menu and selecting Current Text Panel. Move the cursor 
over a block in the view. A dashed blue rectangle indicates the “under mouse” block. 

You can compare the selected and current block information.
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Display Options for WUSB Detail View
Right-click the Timing Analysis window WUSB Detail View to display the 
Timing Analysis Display Options for WUSB Detail View menu:

Figure 9.56 Timing Analysis Display Options for WUSB Detail View Menu

The options are:

• Show Chart Title: Display or hide the left vertical blue bar that says 
WUSB Detail View or Beacon Period View.

• Show Legend: Display or hide the list of colors for MMC, DR, DT, DNTS, Reserved, 
IN, OUT, DN, HSK, Unknown

• Show Selected Text Panel: Display or hide the Selected Item window in the lower 
right corner.

• Show Current Text Panel: Display or hide the Item Under Cursor window in the 
lower right corner.

• Show Channel Time Axis: Display or hide the time axis at the top of the window.
• Show Trans Group Axis: Display or hide the group axis at the bottom of the 

window.
• Show Title Axis: Display or hide the Traffic and Transaction Group headings at the 

left of the window.
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Superframe Grid View
The Superframe Grid view provides a high-level illustration of traffic in each superframe. 
Each frame has a 16x16 grid. Each cell of the grid represents one MAS in the 
superframe. Reservation patterns are color-coded by owner/target, potential reservation 
conflicts, traffic patterns, and throughput characteristics within reservations. 

Figure 9.57 Superframe Grid View

Figure 9.58 Superframe Grid View Zoomed
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MAS Information
To select an MAS, click it in the view. A solid blue rectangle indicates a selected MAS. 
To display information about the selected MAS, display the Selected Text Panel by 
right-clicking in the view to display a popup menu and selecting Selected Text Panel.
To display information about an MAS, display the Current Text Panel by right-clicking in 
the view to display a popup menu and selecting Current Text Panel. Move the cursor 
over an MAS in the view. A dashed blue rectangle indicates the “under mouse” MAS.

You can compare the selected and current MAS information.

MAS Rectangle
An MAS rectangle has the following color codes:

• Pink filling rectangle: Indicates Beacon Period.
• Green line: Indicates amount of MAS traffic.
• Red line: Indicates number of MAS errors.
• Yellow filling rectangle: Indicates DRP Conflict.
• Blue or other color filling most of rectangle: Indicates type of MAS.

Display Options for Superframe Grid View
Right-click the Timing Analysis window Superframe Grid View to display the 
Timing Analysis Display Options for Superframe Grid View menu:

Figure 9.59 Timing Analysis Display Options for Superframe Grid View 
Menu

The options are:

• Show Chart Title: Display or hide the left vertical blue bar that says Superframe 
Grid View.

• Show Legend: Display or hide the list of colors for MAS Traffic, MAS Error 
Indication, Beacon Period, DRP Conflict.

• Show Superframe Axis: Display or hide the frame numbers.
• Show Selected Text Panel: Display or hide the Selected Item window at the right.
• Show Current Text Panel: Display or hide the Item Under Cursor window at the 

right.
• Property Dialog: Allows you to set time synchronization and select the display 

options for the Beacon Period, WUSB Detail, and Superframe Grid views (see 
previous section for screenshot).



Chapter 9: Reports UWBTracer/Trainer  User Manual

152 LeCroy Corporation

Working with Timing Analysis Fields
The Timing Analysis fields are:

• IFS: Inter-frame spacing between previous frame and this frame
• DRP Tm: Follows DRP reservation rule or not
• Frm Duration: Frame duration
• Delta Time: Time between starts of frames on the same channel
• Beacon Slot Frame: SuperFrame (SF) index or Beacon Slot and Slot Offset 

relative to expected BPST
• BPST Delta: Time between BPST in previous and current SuperFrames
• BPST: BPST in current SuperFrame
• Timestamp: Time at beginning of preamble
Left-click a timing analysis field to display a drop-down menu. 

Figure 9.60 Left-Click Timing Analysis Fields Menu

To show or hide the timing analysis fields, select Expand Timing Analysis, Expand All 
Timing Analysis Fields, or Collapse All Timing Analysis Fields.

To show or hide the selected field, select  
Show/Hide ... when Timing Analysis is Collapsed.

To change the position of the field, select Move left or Move right within header.
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Chapter 10:  Connecting to Analyzers
If you have one or more analyzers, you can link them directly to the host machine through 
USB connections or through an IP LAN connection to a remote host machine.

If you have more than one analyzer, you must synchronize the analyzers. You must 
synchronize local and remote analyzers using the SYNC IN and SYNC OUT cable 
connectors and SYNC cables, as described in Section 10.3, “Multiple Analyzer 
Synchronization” on page 158. 

Note:  UWBTracer/Trainer™ will not work with unsynchronized multiple analyzers. 

10.1 Direct USB Connections
You can control multiple analyzers from a single UWBTracer/Trainer application by 
connecting the analyzers to the PC using USB cables. UWBTracer/Trainer lets you toggle 
among the analyzers.

Attach USB cables between each analyzer and the host PC as shown in Figure 10.1. 

Figure 10.1Connecting Multiple Analyzers by USB Cables

To synchronize recordings among the analyzers, connect SYNC cables to the analyzers’ 
SYNC IN and SYNC OUT connectors as described in Section 10.3, “Multiple Analyzer 
Synchronization” on page 158.

After you have connected the analyzers and started them, you can add, remove, or 
reconnect an analyzer using Setup > Analyzer Network ... 

Note:  You cannot run two copies of the UWBTracer/Trainer software on 
simultaneously on a PC. You can only toggle among the analyzers using 
Setup > Analyzer Network ...
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You can display information about the analyzer, update the BusEngine/Firmware 
(see Section 16.4, “BusEngine, Firmware, and Plugin Init Updates” on page 276), update 
the license (see Section 16.5, “License Information” on page 278), or go to Recording 
Options (see Chapter 7) using Setup > All Connected Devices...

Figure 10.2Analyzer Network’ and All ‘Connected Devices…’ menus

USB Connected Analyzers Configuration
Configuration for two or more USB connected analyzers is minimal. In the following 
example, two analyzers are linked via USB to a host PC. You connect to one of the two 
analyzers.

Step 1 Start the analyzers and the UWBTracer/Trainer software.

Step 2 From the menu, select Setup > All Connected Devices to open the 
Analyzer Devices dialog box. 

Figure 10.3Analyzer Devices Dialog Box

Step 3 To select an analyzer, check the relevant Analyzer checkbox on the left. 

Step 4 Click Close to close the dialog box and select the analyzer.  
The UWBTracer/Trainer software on your screen now controls the 
selected analyzer.
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Note: You can update the Firmware, BusEngine, and License from this dialog by 
checking an analyzer and then clicking the appropriate button on the right.  
You can also directly open and set Recording Options for any of the analyzers by 
checking one or more analyzers and then clicking the Recording Options button 
to open the Recording Options dialog. The settings you create apply to all 
selected analyzers.

10.2 Remote Access over an IP LAN
You can run a UWBTracer/Trainer application on a remote PC from a second 
UWBTracer/Trainer application on a local PC if both PCs are on a network. You must 
install UWBTracer/Trainer on both host PCs and connect the PCs using an IP local area 
network (LAN).

Attach a USB cable between each analyzer and its host PC, and connect the hosts PCs 
on an IP LAN, as shown in Figure 10.4. 

Figure 10.4Connecting Multiple Analyzers by USB Cables on a Network

To synchronize recordings among the analyzers, connect SYNC cables to the analyzers’ 
SYNC IN and SYNC OUT connectors as described in Section 10.3, “Multiple Analyzer 
Synchronization” on page 158.

After you have installed UWBTracer/Trainer on both PCs, connected the analyzers, and 
started everything, you can toggle to the remote analyzer using Setup > Analyzer 
Network ...

Note:  You cannot run two copies of the UWBTracer/Trainer software on 
simultaneously on a PC. You can only toggle among the analyzers using 
Setup > Analyzer Network ...
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Remote Analyzers Over an IP Network Configuration
To configure UWBTracer/Trainer to remotely control an analyzer over an IP LAN, you use 
the Analyzer Network dialog to browse to the host controlling the analyzer and add both 
the host and its PC to the dialog.

Step 1 From the menu, select Setup > Analyzer Network to open the 
Analyzer Network dialog box and list host PCs and their analyzers. The 
listed devices are either currently connected or were connected before. 

Figure 10.5Analyzer Network Dialog Box

Step 2 Remove any host (other than the Local Machine) from the list by 
selecting the host and then clicking Remove. You should keep in the list 
only the host(s) that you are planning to immediately use.
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Step 3 To add a host and analyzer to the list, click Add to open a Add Analyzer 
Network Node dialog box.

Figure 10.6Add Analyzer Network Node Dialog Box

Step 4 Browse to the host that has an analyzer attached to it and double-click it 
to add the host to the Analyzer Network dialog.

Step 5 Click Close to close the dialog box.

Step 6 Select Setup > All Connected Devices ... to open the Analyzer Devices 
dialog box. 

Step 7 Uncheck all boxes except the one for the remote analyzer to which you 
wish to connect.

Step 8 Click Close to close the dialog box and establish a connection to the 
selected analyzer.
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10.3 Multiple Analyzer Synchronization
A single UWBTracer/Trainer™ software application instance can record from multiple 
analyzers. You can connect the analyzers locally to the host machine running the 
UWBTracer/Trainer application or connect them to remote host machines running the 
UnitAgent application. These sections describe how to configure the analyzer network 
and choose parameter settings for multiple analyzers.

Connecting Analyzers for Synchronized Recording
To merge traces from different channels and analyzers into a single trace file when you 
view the traces from multiple analyzers, you must synchronize the timestamps for the 
analyzers. Configuring each analyzer for multiple channel recording using multiple 
analyzers, and setting up the analyzer network as shown below, allows timestamp 
synchronization.

To synchronize timestamps across analyzers, you must connect the analyzers in a ring 
network. A ring allows transmission of clock information and commands between 
CATC 5K analyzers that have the CATC 5K protocol (UnitAgent) for communicating 
between analyzers. This protocol allows two or more analyzers connected in a ring to 
function like a single multichannel analyzer. A ring of analyzers with this protocol can 
perform:

• Timestamp synchronization: All analyzers count time from the same time value at 
the beginning of recording.

• Cross triggering: If one analyzer finds a triggering event, it can trigger all the other 
analyzers synchronously.

To make a ring network, connect SYNC cables to the SYNC IN and SYNC OUT 
connectors on the backs of the CATC 5K analyzer platforms by matching the color codes 
(and text labels) on the cable ends and the connectors, as shown in Figure 10.7. 

Figure 10.7SYNC IN and SYNC OUT Connector/Cable Color Coding
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Figure 10.8 shows how to connect two analyzers in a ring network for synchronized 
recording. 

Figure 10.8Connecting Two Analyzers for Synchronized Recording

Figure 10.9 shows how to connect three analyzers in a ring network for synchronized 
recording. 

Figure 10.9Connecting Three Analyzers for Synchronized Recording
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Recording Multi-Trace Files
After you connect SYNC cables to allow synchronization, perform the following steps to 
record multiple trace files:

Step 1 Perform Steps 1 and 2 as described above in “USB Connected 
Analyzers Configuration” on page 154 to open the Analyzer Devices 
dialog box.

Step 2 In the Analyzer Devices dialog box, verify that the checkboxes are 
checked for the cascaded analyzers.

Step 3 Click Close to close the dialog and select the analyzers.

Step 4 Test the setup by recording some traffic. If the analyzers are not 
connected by SYNC cables, an error message prompts you to correct 
the problem.

Step 5 The UWBTracer/Trainer software displays traffic from each analyzer in 
adjacent windows. 

10.4 Network Chat
Analyzer Network Chat is a utility that allows users to conduct chat sessions over an 
IP LAN. 

To send and receive electronic text messages, each user must be working with a PC that 
is attached to an analyzer and each PC must, in turn, be connected to an IP LAN. 

To start a chat session: 

Step 1 Select View > Analyzer Network Chat Bar from the menu to open the 
Analyzer Network Chat dialog: 

Figure 10.10Analyzer Network Chat Dialog Box

Step 2 Click the cell at the bottom of the window and type any text.

Step 3 Click Send. The sent text appears in the top of the window next to your 
prompt.
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Chapter 11:  Setting Up for Recording

This chapter describes how to connect the triggering cable for external triggering, how to 
connect the probe cables and their cable adapters, and how to set up for wireless 
recording.

11.1 External Triggering Setup
With each analyzer, LeCroy includes a TRIG-IN/TRIG-OUT BNC Y-cable 
(see Figure 2.4) that allows you to export a trigger signal to, and receive a trigger signal 
from, external equipment. 

The Trigger Cable connects to the EXT DATA connector located on the 
UWBTracer/Trainer rear panel, as shown in Figure 11.1. 

Figure 11.1 EXT DATA Connector and Cable
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11.2 Connecting Cables and Adapters
Figure 11.2 shows the connections among CATC 5K, UWB Analyzer, connectors, cable 
adapter, and 68-pin, 60-pin, and 40-pin probe cables. 

Figure 11.2 Example UWBTracer Device Connections Diagram 
for Recording MPI Traffic from Devices using the IDE 40-pin 
Cable Adapter
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To use the Cable Adapter to connect with an IDE 40-pin connector:
Step 1 Turn of the power on the analyzer and the device-under-test

Step 2 Connect the middle connector on the IDE 40-pin Probe Adapter to the 40-pin 
connector on the Cable Adapter.

Step 3 Connect one of the end connectors on the IDE 40-pin Probe Adapter to the PHY 
subsystem.

Step 4 Connect the other end connector on the IDE 40-pin Probe Adapter to the MAC 
subsystem.

Step 5 Connect the Adapter Cable (SCSI) to the MPI ADAPTER connector on the 
UWBTracer plug-in.

Step 6 Connect the Adapter Cable (SCSI) to the TO ANALYZER connector on the 
Cable Adapter unit.

Step 7 Turn on the power, then start capturing data.

To use the Cable Adapter to connect with a Hirose 68-pin connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 68-pin Probe 
Cable and the 68-pin connector on the Cable Adapter.

To use the Board Adapter to connect with a IDE 40-pin connector:
Step 1 Turn off the power on the analyzer and the device under test.

Step 2 Connect one side of the IDE 40-pin Board Adapter to the connector on the MAC 
subsystem. 

Step 3 Connect the PHY subsystem to the other IDE 40-pin connector on the Board 
Adapter.

Step 4 Connect the Adapter Cable (SCSI) to the MPI ADAPTER connector on the 
UWBTracer plug-in.

Step 5 Connect the other side of the Adapter Cable (SCSI) to the connector on the 
Board Adapter.

Step 6 Turn on the power, then start capturing data.

To use the Board Adapter to connect with a Hirose 68-pin 
connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 68-pin Board 
Adapter.

To use the Board Adapter to connect with a Hirose 60-pin 
connector:
Follow the same steps as for the IDE 40-pin connector, but use the Hirose 60-pin Board 
Adapter.



Chapter 11: Setting Up for Recording UWBTracer/Trainer  User Manual

164 LeCroy Corporation

11.3 RF Recording Setup
For wireless recording, the UWB Analyzer uses the UWB radio on the UWB analyzer 
plug-in. The plug-in module must be inserted into the right-side slot of the CATC 5K 
platform. 
There are two options for eavesdropping UWB traffic:
• Wireless RF recording
• Wired RF Recording

Wireless RF Recording
Using the provided RF antenna, the analyzer can capture over-the-air wireless traffic. 
Perform the following steps:
Step 1 Make sure the antenna provided with the UWBTracer analyzer is tightly 

connected to the connector marked ANT.

Step 2 Position the analyzer and devices under test at an equal distance from each 
other, 10 inches apart (Figure 11.3). 

Figure 11.3 Wireless RF Recording

Note: RF signals and noise from external devices might affect wireless recording, as 
might the transmit and receive patterns of antennas on the analyzer and devices under 
test. If the recorded trace has many corrupted UWB frames, try the following:

• Try different positions of the devices and analyzer.
• Place the devices and analyzer as close as possible to each other and at equal 

distance (but not less than 10 inches apart).
• Remove any potential RF radiators from the test environment or find an RF-quiet 

location. 
• Turn antenna in different directions
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Wired RF Recording
Wired RF Recording can be used when the test setup requires isolation from external RF 
interference or when the effects of the antennas need to be negated. In this setup, coaxial 
cables are used to connect the analyzer to the devices under test.

To match the transmit power of the radios to the receive power ratings (because 
low-impedance wires are now used), use attenuators to lower the signal strength so that 
the input stages of the PHYs are not saturated (Figure 11.4). The –20 dB attenuators are 
given as an example. You might need to use different attenuators depending on the 
characteristics and signal strength of the radios in use.

Figure 11.4 Wired RF Recording

Note:  The attenuator values shown are only examples. You may need to 
use different values according to the PHYs used, their signal 
strengths, and your setup.
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11.4 Preparing for Wireless Traffic Generation
For wireless traffic generation, the UWB Exerciser uses the UWB radio on the 
UWB Exerciser plug-in. The plug-in module must be inserted into the left-side slot of the 
CATC 5K platform. 
There are two options for UWB traffic generation:
• Wireless RF traffic generation
• Wired RF traffic generation

Wireless Traffic Generation
Using the provided RF antenna, the Exerciser can capture over-the-air wireless traffic. 
Perform the following steps:
1. Make sure the antenna provided with the UWBTracer/Trainer analyzer is tightly connected to 

the connector marked ANT.
Note: To meet FCC Part B requirements, UWBTrainer is equipped with reverse polarity radio 
and antenna connectors. This configuration does not affect RF behavior in any way but does 
require that a customer-supplied antenna is configured with reverse polarity connectors.

2. Position the UWBTracer/Trainer system facing the devices under test (at least 10 inches 
apart). 

Wired Traffic Generation
You can use coaxial cabling to connect the wireless device directly to the UWBTrainer 
generator, as illustrated below. Because antennas are not used, external interference 
should not affect the recording. 
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11.5 Secured Traffic
The UWBTracer/Trainer™ system can perform real-time decryption for encrypted traffic. 
The system can record the decrypted traffic and make real-time triggering/filtering 
decisions based on the decrypted traffic.

The UWBTracer/Trainer system decrypts traffic using temporal keys, which it can obtain 
by two methods: 

• Derivation Using Certified WUSB Four-Way-Handshake Protocol
• Direct Programming
You can program a combined total of 32 different Connection Contexts and Temporal 
Keys using these two methods.

For information about the recording options related to decryption and security, see 
Section 12.2, “Recording Options: RF” on page 178.

For more information about the Device List, see Section 9.7, “Device List” on page 128. 

Temporal Key Derivation Using Certified WUSB 
Four-Way-Handshake Protocol
Certified WUSB hosts and devices allow you to derive a temporal key. To derive a 
temporal key from a Certified WUSB host or device, you must add a valid Connection 
Context to a WUSB host or device. 

Note: Use the Direct Programming method to decrypt traffic between two WiMedia 
devices that are not running the Certified WUSB protocol.

A Connection Context includes a connection host ID (CHID), connection device ID 
(CDID), and connection key (CK). Entering the CHID and CDID into the analyzer memory 
provides the analyzer with the “numeric association” connection context keys.

The UWBTracer/Trainer system uses a Connection Context to follow the 
Four-Way-Handshake protocol between a host and device and consequently derive a 
Pair-wise Temporal Key (PTK). The UWBTracer/Trainer system then uses the PTK to 
decrypt traffic between the host and device. 

The UWBTracer/Trainer system derives a new PTK whenever a new 
Four-Way-Handshake protocol takes place between a host and device. Therefore, the 
UWBTracer/Trainer system can only handle one Four-Way-Handshake at a time:

• If multiple Four-Way-Handshakes are interleaved, the UWBTracer/Trainer system 
cannot track them. 

• If multiple Four-Way-Handshakes are serialized, so that one finishes completely 
before the next one starts, the UWBTracer/Trainer system can track them.

Note:  The Connection Context from the USB Plug-in Module appears in the 
Device List.
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To add a Connection Context to a WUSB host or device:

Figure 11.5 Device List Dialog Box

Step 1 If the WUSB host or device already appears in the Device List dialog 
box, double-click it to open the Edit Device dialog box at the 
General Settings tab: 

Note:  The Connection Context from the USB Plug-in Module will appear in the 
Device List.

To add a device to the Device List, click the Add New Device toolbar button to 
display the Add New Device dialog box.

Figure 11.6 Opening the Add New Device Dialog Box
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Step 2 In the Add New Device or Edit Device dialog box, set the Device Type to 
Wireless USB Host or Wireless USB Device.

Figure 11.7 Manually Adding a New Device

Then fill in the other fields on the General Settings tab, using the correct format. 
Check the DUT checkbox for the device.

Figure 11.8 Add New Device Dialog Box General Settings Tab Fields
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Step 3 Select the WUSB Settings tab, then enter the correct CHID for the WUSB host 
or CDID for the WUSB device:

Figure 11.9 Device Type Specific Settings Tab with CHID or CDID

Step 4 Click the Add button to open the Add Connection Context dialog box, then enter 
the correct CDID for the WUSB host or CHID for the WUSB device and enter CK, 
and then click OK:

Figure 11.10 Entering CDID or CHID and CK

Step 5 Repeat Step 4 for each additional Connection Context you want to specify.

Step 6 Click OK to save changes and return to the General Settings tab.

Step 7 Repeat Steps 2 through 6 for each device you want to track.

Step 8 Click OK to save changes and exit the Add New Device or Edit Device dialog 
box.
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Step 9 Make sure the WUSB host or device has the DUT box checked:

Figure 11.11 DUT Checkbox

Step 10 Click the Program Security Data toolbar button to send changes to the 
analyzer:

Figure 11.12 Program Security Data Toolbar Button

Temporal Key Direct Programming
In this method, you add a Temporal Key ID (TKID) and Temporal Key (TK) to the device 
attributes when you add or edit a device in the Device List. 

The UWBTracer/Trainer system decrypts traffic using the Temporal Key whenever a 
match is found with the TKID and the device address (DevAddr) of the device. 

This method can be used for programming both Pair-wise Temporal Keys (PTK) and 
Group Temporal Keys (GTK).

Note: You must use the Direct Programming method to decrypt traffic between two 
WiMedia devices that are not running the Certified WUSB protocol.

To add a Temporal Key directly to a WUSB host or device: 

Step 1 If the device already appears in the Device List (see Figure 11.5), 
double-click it to open the Edit Device dialog box.

If the device is not in the Device List, click the Add New Device toolbar button 
(see Figure 11.6) to display the Add New Device dialog box (see Figure 11.7).

Step 2 Enter information in the correct format in the fields on the General Settings tab 
(see Figure 11.8). 

Check the DUT checkbox for the device.
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Step 3 Select the Temporal Key tab:

Figure 11.13 Temporal Key Tab

Step 4 Click the Add button to open the Add Temporal Key dialog box, then enter the 
correct TKID and TK for the device in the proper format, and then click OK:

Figure 11.14 Entering TKID and TK

Step 5 Repeat Step 4 for each additional Temporal Key you want to specify.

Step 6 Click OK to save changes and return to the General Settings tab.

Step 7 Repeat Steps 2 through 6 for each device you want to track.

Step 8 Click OK to save changes and exit the Add New Device or Edit Device dialog 
box.

Step 9 Make sure that the device has the DUT box checked (see Figure 11.11).

Step 10 Click the Program Security Data toolbar button (see Figure 11.12) to send 
changes to the analyzer.
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Chapter 12:  Recording Options
The recording options are the parameters for the recording session. You set the 
recording options to obtain only the trace information you need. 

To use the Recording Options window: 

• From the Setup menu, select Recording Options.
OR

• From the Tool bar, select the Recording Options  button to display the 
Recording Options window (Figure 12.1).

The Recording Options window has the tabs: 

• General: General recording characteristics, including buffer size, recording type, 
and Trace filename and path

• MPI: Specific recording characteristics
• RF: Specific recording characteristics
• USB Assoc: USB_Cable_Association traffic
• Recording Rules: Sets triggers and filters.

Note:  The settings you configure apply to all recordings made by the analyzer.

You can save and load recording options. The following sections describe the General, 
MPI, RF, USB Assoc., and Recording Rules tabs.
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12.1 Recording Options: General
The General page has boxes for System Operating Mode, Recording Type, Options, 
Options Name, Buffer, Trigger Position, and Trace Filename and Path. 

Figure 12.1 Recording Options: General Page

System Operating Mode
You can select the combination of analyzers, exerciser, and USB platforms. Selecting a 
mode changes the tabs presented in the Recording Options dialog.

• [Rec. Chan #1: MPI] [Rec. Chan #2: RF]
• [Rec. Chan #1: MPI] [Rec. Chan #2: RF] [Supports USB Association Capturing]
• [Rec. Chan #1: RF] [UWBTrainer supported]
• [Rec. Chan #1: MPI] [UWBTrainer supported]
• [Rec. Chan #1: Probe UWBTrainer] [UWBTrainer supported]
• [Rec. Chan #1: RF]
• [Rec. Chan #1: RF] [Rec. Chan #2: RF]
Note: In a two-unit setup, two separate analyzers link together by BNC on the back of the 
units to form a single, logical analyzer. (See Chapter 2 for the cabling for a two-unit 
setup.)
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Recording Type
Recording begins when you click the Start Recording button  on the Tool bar or 
select the Record > Start command. Maximum recording size is set in the Buffer Size 
box. 

The Recording Type box options control how UWBTracer/Trainer  ends a recording: 

• Snapshot: Recording ends when the length reaches the selected 

buffer size or you click the Stop Recording button . 
• Manual Trigger: Recording continues until you press the Trigger button (on the 

front panel). After you press the Trigger button, recording continues until the 
post-trigger buffer is full or you click 

the Stop Recording button  on the Tool bar.
• Event Trigger: Recording continues until a (user-defined) trigger event occurs. 

After the event occurs, recording continues until the post-trigger buffer is full.

Note:  See the Readme file on the software installation CD for current information 
on triggering support.

Options
The options checkboxes appear on the upper right side of the Recording Options 
window: 

• Beep When Trigger Occurs: Makes the computer connected to the UWB-
Tracer/Trainer  beep three times when a Trigger condition is first detected.

• Save External Interface Signals: Records signals from data pins on the breakout 
board.

• External Trigger Input: Allow triggers from the trigger cable.

Misc Button
To generate an additional binary file at the end of recording: 

Step 1 Select the Misc button to display the General: Miscellaneous dialog 
box.

Step 2 Select the Store into Raw Data Debug File checkbox. 

The file is stored in the root (c:\) directory. The file name is 
BusEngineRawTracexxxx.dat, where xxxx is the serial number of the analyzer. Use the 
file to provide additional information if you want to report a problem to LeCroy Technical 
Support.

Warning!  :The Raw Data Debug binary file can have a very large size. 
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Buffer Size
The program records the entire trace and stores it in the analyzer buffer before uploading 
it to the host PC. The buffer size determines the maximum size of a recording. 

Use the Buffer Size slide bar to set the recording buffer size from 1.6 MB to 2048 MB 
(Figure 12.2). 

Figure 12.2 Recording Options: Buffer Size Slider

Note:  With a regular license, maximum recording buffer size is 1024 MB. You need 
a unit with a 2-GB license to have a maximum recording buffer size of 
2048 MB.

Trigger Position
The program uses Trigger Position when the recording type is Manual Trigger or Event 
Trigger.
Use the Trigger Position slide bar to set the percentage of the buffer size used for 
post-trigger recording (Figure 12.3). 

Figure 12.3 Recording Options: Trigger Position Slider

This action sets the location of the trigger within the buffer. For example, if the buffer size 
is 16 MB and the trigger position slide bar is at 75%, 12 MB of the buffer (75%) is 
post-trigger and 4 MB is pre-trigger. If the buffer size is 16 MB and the trigger position 
slide bar is at 5%, 0.8 MB of the buffer (5%) is post-trigger and 15.2 MB is pre-trigger. 

When a trigger occurs in a recording, recording continues until the post-trigger buffer is 
full. The complete trace contains the most recent pre-trigger information up to the 
pre-trigger buffer size, followed by the post-trigger information up to the post-trigger 
buffer size.
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Options Name
You can name the current set of recording options in the Options Name field. 

By default, the UWBTracer/Trainer™ application uses the default.rec recording 
options file located in the application directory. You can save the current recording 
options in an options file in the application directory or save the recording options as the 
default file by replacing the default.rec file. 

To create a new recording options file: 

Step 1 Click the Save button to display the Save As dialog box.

Step 2 Enter a file name. You can use the same name or a different name than 
the name in the Options Name field. Do not add a file name extension. 
The program automatically appends a .rec extension.

To save the current options as the default file: 

• Click the Save as Default button.

Trace Filename and Path
You can save the trace file recording in the Trace Filename and Path box. See Section 
3.18 "Directory Structure on Windows XP and Vista" on page 45.

To create a trace file: 

Step 1 Click Change Default Location to display the Specify Trace File Name 
dialog box.

Step 2 Browse to or enter a trace file path and name, then click Save.
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12.2 Recording Options: RF
An RF tab appears if you selected any of the following system operating modes:

• [Rec. Chan #1: MPI] [Rec. Chan #2: RF]
• [Rec. Chan #1: MPI] [Rec. Chan #2: RF] [Supports USB Association Capturing]
• [Rec. Chan #1: RF] [UWBTrainer supported]
• [Rec. Chan #1: RF]
• [Rec. Chan #1: RF] [Rec. Chan #2: RF]
You can set RF recording options. The RF tab controls the RF recording channel. 

For RF recording, select the RF checkbox at the top left of the RF tab in the lower left 
corner of the window.

Note:  If you are in RF scan mode and MPI traffic is present, uncheck the MPI option  
to reserve a buffer for scan results.

Figure 12.4 Recording Options Window: RF Tab Defaults
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Channel Sync Mode
For the analyzer to capture RF traffic, you must synchronize the RF transmission of at 
least one device under test (DUT). Use the Channel Sync Mode section to set the 
parameters required for synchronizing to a device.

Two modes of operation can be set: 

• Sync to Channel: Directs the analyzer to attempt to synchronize to a specific 
channel. In this mode, you can only select a single channel in the Select Sync  
Channel window displayed after you click the Set button.

• Scan Channels: Directs the analyzer to scan the first channel for a specified period 
of time, then repeat for the remaining channels. In this mode, you can select 
multiple channels in the Select Sync Channel window displayed after you click the 
Set button. The system stops recording automatically after all selected channels 
have been scanned.

To select the channel or channels, click Set to display the Select Sync Channel(s) dialog 
box: 

Figure 12.5 Select Sync Channels Dialog Box

The dialog box lists the Channel, Band Group/TF Code, and Band IDs.

Select a checkbox on the left to select a channel. When you are finished selecting 
channels, click OK.

Note:  Empty packets may be created in either Scan mode.
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Scan Time per Channel
Set the scan period for each channel. The range is 0 to 64,000 milliseconds. The default 
is 1000 milliseconds. You can set this option only when the Channel Sync Mode is set to 
"Scan Channels."

Loss-of-Sync Timeout
Set the timeout period to use when out-of-synchronization occurs. The range is 
0 to 64,000 milliseconds. The default is 10,000 milliseconds.

Force Resynchronization
Resynchronizes the analyzer receiver PHY with the signal from the devices under test.

If the RF channel is already synchronized to transmitted data from a DUT, this setting 
forces the analyzer to terminate the synchronization and then try to resynchronize when 
a new recording begins.

Note:  If the analyzer is in "Scan Channels" Channel Sync Mode and you modify the 
channel setting, the software sets the Force Resynchronization flag 
internally.



UWBTracer/Trainer  User Manual Chapter 12: Recording Options

LeCroy Corporation  181

Device Tracking
After the analyzer is initialized/synchronized to a device on a channel, if the DUT changes 
channels, the analyzer can follow a specific DUT to the other channel or it can stay on 
the same channel and follow a beacon switch or a burst preamble of the DUT(s). The 
device tracking options are:

• Follow Channel Change: The analyzer follows the specified DUT to a different 
channel if the DUT changes to a different channel.

• Follow Beacon Switch: The analyzer stays on the same channel and follows a  
beacon switch of any of the DUT(s) if the specified DUT changes to a different chan-
nel.

• Follow Burst Preamble: The analyzer stays on the same channel and follows a 
burst preamble of any of the DUT(s) if the specified DUT changes to a different 
channel.

Devices to Track
Several DUTs may share the same channel to which the analyzer is synchronized. You 
can set the analyzer to follow one or a subset of those DUTs.

To select a subset of the devices, you can select from a list of DUTs. Alternatively, you 
can filter a subset from the set of devices by setting the MAC Address Mask and the 
SrcID (Source ID) Mask. Only the devices matching the properties you set will be in the 
subset of devices.

To set the devices to track, select Any Device or Only DUT. If you select Only Device, 
select the device from the list of devices. The MAC Addr (Address) Mask and the 
SrcID (Source ID) Mask are listed in hexadecimal.

Encrypted/Decrypted Recording
You can show secured decrypted traffic, original (secured or not secured) traffic only, or 
both types of traffic:

• Decrypted (Secured) + Non-Secured Traffic Only: Records all non-secure 
frames; records secure frames, and stores decrypted payload.

• Original (Secured or Non-Secured) Traffic only: Records all non-secure and 
secure frames unchanged.

• Both: Interleaves Decrypted and Original Traffic.
For information about setting decryption connection contexts and temporal keys, see 
Section 9.7, “Device List” on page 128. 

(For information about encryption keys, association data, and 4-way handshakes, see 
Section 11.5, “Secured Traffic” on page 167.)
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12.3 Recording Options: MPI
An MPI tab appears if you selected any of the following system operating modes:

• [Rec. Chan #1: MPI] [Rec. Chan #2: RF]
• [Rec. Chan #1: MPI] [Rec. Chan #2: RF] [Supports USB Association Capturing]
• [Rec. Chan #1: MPI] [UWBTrainer supported]
You can set MPI recording options. 

For MPI recording, select the MPI checkbox at the top left of the MPI section in the lower 
left corner of the window. 

Signal Capture
By default, a trigger occurs on the negative edge of the PCLK clock pulse. If recording 
data is corrupt, you can set a trigger to occur on the positive edge of the PCLK clock pulse 
by deselecting the Samples on Negative Edge of PCLK checkbox in the Signal Capture 
section in the lower left corner of the window.

To continue recording during reset, select the Continue capturing MPI signals during 
PHY Reset Cycle checkbox in the Signal Capture section in the lower left corner of the 
window.
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PHY Timing
You must manually set the correct delay values for the PHY on the probed MPI. You can 
typically find these values on the PHY datasheet: 

• SyncDelay: Delay from the end of the last symbol of the Frame Synchronization 
Sequence of the preamble waveform in the local antenna to the time when the PHY 
asserts PHY_ACTIVE, in nanoseconds.

• PhyActiveDelay: Delay from the end of the last symbol of the frame received in the 
local antenna and PHY_ACTIVE de-assertion, in nanoseconds.

Note:  For RF, you do not need to set the PHY Timing parameters because the 
software knows these values for the UWBTracer/Trainer PHY module.

Encrypted/Decrypted Recording
You can show secured decrypted traffic, original (secured or not secured) traffic only, or 
both types of traffic:

• Decrypted (Secured) + Non-Secured Traffic Only: Records all non-secure 
frames; records secure frames, and stores decrypted payload.

• Original (Secured or Non-Secured) Traffic only: Records all non-secure and 
secure frames unchanged.

• Both: Interleaves Decrypted and Original Traffic.
For information about setting decryption connection contexts and temporal keys, see 
Section 9.7, “Device List” on page 128. 

(For information about encryption keys, association data, and 4-way handshakes, see 
Section 11.5, “Secured Traffic” on page 167.)
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12.4 Recording Options: USB Assoc.
An USB Assoc. tab appears if you selected the following system operating mode:

• [Rec. Chan #1: MPI] [Rec. Chan #2: RF] [Supports USB Association Capturing]

Note:  For capturing the USB Cable Association traffic (as defined in the 
Certified Wireless USB specifications) so it can be used to decrypt 
WiMedia UWB traffic, the USB Analyzer plug-in module (US007MA) has to 
be installed. For information on how to set up the system,  
see Section 13.2 “USB Cable Association for Certified WUSB” on page 220.

Because the USB Analyzer plug-in module is always active and ready for capture, the 
only setting needed is to choose the speed. Set the speed of the traffic recorded by the 
Analyzer in the USB Association Capture Settings recording options on the USB Assoc. 
page (Figure 12.6).

Figure 12.6 USB Assoc. Dialog Box

By default, the USB Association Capture Settings are disabled. Check the 
USB Assoc Capture Settings checkbox to enable capture.
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If you enable capture, select the Channel 0 Speed: 

• Auto-Detect: By default, the Analyzer discovers the speed at which traffic is 
running on the device and labels packets accordingly.

• Low: For use with known Low speed devices, the Analyzer records only at 
Low speed.

• Full: For use with known Full speed devices, the Analyzer records only at Full 
speed.

• High: For use with known High speed devices, the Analyzer records only at 
High speed.

Use the default setting Auto-Detect unless you have problems with your recordings.

Rarely, the auto-detection circuitry causes Full Speed devices to fail to enumerate on 
plug-in. To solve this problem, change the Analyzer speed to Full speed.

For other recording problems, change the Analyzer speed to Low, Full, or High to debug 
the problem. For example, if a device is producing numerous errors at a particular speed, 
set the recording to that speed to check that the Analyzer is not misreading the error 
packets and labeling them with the wrong speed (this possibility is highly unlikely and is 
used here only as an illustration of setting manual speeds). 

Manually setting the recording speed guarantees that the Analyzer always records 
packets at that speed. 

Notes on High Speed Recordings
Erroneous chirp blocks can be recorded on an idle bus when the device has its 
FS terminations on while the Host has HS terminations connected. This causes a small 
differential voltage ("tiny-J") on the USB bus that causes false chirp detection. 

This condition occurs during speed negotiation: 

• On an HS bus, the condition is momentary just before the device chirps.
• On a CS bus, the condition occurs both before and after the device chirp (until 

the end of Reset). Do not use HIGH speed to record signals on a classic 
speed bus.

• The Analyzer stops recording anything for 2.5 milliseconds following an FS_K 
state (which is at least 2 microseconds long). Stopping recording avoids 
presenting any useless information while the high-speed probe settles down.
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12.5 Recording Options: Recording Rules
Use the Recording Rules page (Figure 12.7) to set triggers and filters. 

Figure 12.7 Recording Options Window: Recording Rules Page

The page has the following areas: 

• Toolbar: Contains buttons that control the Recording Rules page.
• Available Events Area: Area where you can park Event buttons that you intend to 

use in the Main Display area.
• Main Display Area: Area where you configure trigger and filter rules. You configure 

rules by dragging Event buttons from the Available Events area and then assigning 
actions to those buttons. 

• Config Status Indicator: A button that indicates if the rule is valid or invalid. If a 
trigger or filter rule is configured correctly, the button is green and indicates Config is 
Valid. If a rule is not configured correctly, the button is red and indicates Config is 
Invalid.

Toolbar

Main 
Display 
Area

Config
Status
Indicator 

Available 
Events 
Area
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Pop-Up Menus: When you right-click a button or area in the Recording Rules page, a 
context-sensitive pop-up menu appears that lets you do operations that relate to that 
button or area.

Figure 12.8 Recording Options Window: Popup Menus

Properties Dialogs: When you click the Show/Hide Properties Dialog button for an 
event, action, or state, a dialog allows you to perform the same operations as in the 
pop-up menus. (See “Events and Event Properties” on page 198 and “Actions and Action 
Properties” on page 199.)
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Recording Rules Toolbar
The Recording Rules toolbar (Figure 12.9) buttons (Table 12.1 ) control the Recording 
Rules page. 

Figure 12.9 Recording Rules Toolbar

Table 12.1 Recording Rules Buttons 

Note:  If you have a wheel on the mouse, you can zoom by holding down the CTRL 
key and rolling the mouse wheel.

New Event. Creates a new 
event in the Available 
Events area.

Zoom Out. Makes the 
display appear 
smaller.

Delete Event. Deletes the 
selected event.

Show/Hide Channels. 
Shows or hides the 
channel icon on the 
Event button.

Undo. Undoes the change 
made to Recording Rules 
page. The Undo buffer 
has unlimited size.

Show/Hide Properties 
Dialog. Shows or 
hides the properties 
dialog of the selected 
event, action, or state.

Redo. Restores changes 
done to the Recording 
Rules page.

This display appears 
when the current 
Recording Rules 
configuration can be 
executed by the 
hardware.

Zoom In. Enlarges the 
display (see note). There 
are five zoom levels. The 
default level is the middle 
one.

This display appears 
when the current 
Recording Rules 
configuration cannot 
be executed by the 
hardware.

Apply Recording Rules to 
MPI Recording Channel

Apply Recording 
Rules to RF Recording 
Channel
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Recording Rules Page: How It Works
You can think of the Recording Rules page as a workspace for creating recording rules 
(rules that determine how the analyzer records traces). Recording rules are combinations 
of events and actions. 

In UWBTracer/Trainer terms, an event and the action or actions associated with it form a 
rule state. One or more states are encapsulated in a sequence.

Note:  There can be from one to 512 states within a sequence. You can associate 
one or more events with each state, and you assign each event a different 
action or the same action.

A sequence that has only one state is called a single-state sequence. The analyzer 
continuously watches for each event in the sequence and executes the corresponding 
action if the event is detected.

A sequence that has multiple states is a multi-state sequence. The states are arranged 
in a hierarchy, with a top state and successively lower states. Only one state in a 
multi-state sequence is active at a time. The analyzer does not go to a successive state 
unless it is directed to do so by the previous state.

Sequences are described in detail in "Using Sequences" later in this chapter.

Briefly, creating a rule involves the following steps: 

Step 1 Creating Event buttons in the Available Events area.

Step 2 Drag-and-drop of Event buttons to the appropriate areas (cells) in the 
Main Display area.

Step 3 Assigning an action or actions to each Event button.
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Creating Event Buttons
To create a rule, first create one or more Event buttons. As you create Event buttons, they 
appear in the Available Events area. You then can drag-and-drop them into the Main 
Display area.

To create event buttons: 

Step 1 Click the New Event button at the left side of the toolbar to display the 
New Event pop-up menu (Figure 12.10) for MPI or RF. 

Figure 12.10 Creating a New Event

Step 2 Select an event (Figure 12.11). 

Figure 12.11 Selecting Event Type
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The event appears in the Available Events area (Figure 12.12). 

Figure 12.12 Event Button Appears in Available Events Area

Dragging a Button to the Main Display Area
After you create an Event button in the Available Events area, you can drag the button to 
the Main Display area and drop it in the appropriate cell (a cell is a grayed-out rectangle 
with a dashed line around it). You can think of each cell as a target for drag-and-drop of 
an Event button.

There are two types of cell that might appear: Sequence cell and State cell. In the Main 
Display area, they are labelled as follows: 

• Sequence cell: Drag an event here to add a new sequence.
• State cell: Drag an event here to add another state.
If there currently are no events in the Main Display area, a single sequence cell appears 
at the top of the area (Figure 12.12). 
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To drag-and-drop the Event button: 

Step 1 Place the mouse cursor on the Event button in the Available Events 
area. Click the left mouse button.

Step 2 Drag the button to the cell. When the button is in the cell, a dashed 
highlight line appears around the cell (Figure 12.13). 

Figure 12.13 Drag-and-Drop Event Button to Cell

Step 3 Drop the button in the cell (release the left mouse button). The Event 
button appears in the cell (Figure 12.14). 

Figure 12.14 Event Button in Cell

As shown in Figure 12.14, the default label for the first cell is “Sequence 0, State 1." As 
described later in this section, you can change that label using the Properties pop-up for 
that cell. 

As Figure 12.14 also shows, two new cells appear under the first cell. The first of these 
new cells is a state cell that allows you to create another state in rule Sequence 0 (to 
make Sequence 0 a multi-state sequence).

The second of the new cells is to create a separate sequence, which would be labelled 
Sequence 1.
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Assigning an Action
After you have dropped the Event button in a cell in the Main Display area, you can assign 
an action to the event. 

Note:  If you do not assign an action to an Event button, the analyzer ignores the 
event.

To assign an action to an Event button: 

Step 1 Right-click the Event button to display a pop-up menu (Figure 12.15). 

Figure 12.15 Selecting Action From Event Button Pop-Up

Step 2 Select Specify Action, and then choose an action from the submenu. 
The menu closes, and the action is assigned (Figure 12.16). 

Figure 12.16 Action Assigned to Event
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Note:  You can also set actions within the Properties dialog for each event. 
Double-click the Event button to open the Properties dialog, then select the 
Actions tab and set your actions.

Recording Rules Pop-Up Menus
The Recording Rules window has context-sensitive pop-up menus that are associated 
with the following types of object: cells, events, and actions.

Cell Pop-up Menu
If you click a cell in the Main Display area that has an Event button contained in it, the 
Cell pop-up menu appears (Figure 12.17). 

Figure 12.17 Sequence Pop-Up Menu

The Cell pop-up menu has the following options.

• New Event: Displays the same menu that you get when you click the New Event 
button on the toolbar.

• Properties: Displays the Properties dialog for the selected cell.
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Action Pop-up Menu
If you click an Action button in the Main Display area, the Action pop-up menu appears 
(Figure 12.18). 

Figure 12.18 Action Pop-Up Menu

The Action pop-up menu has the following trigger and filter options: 

• Trigger: Sets or clears Trigger action.
• Filter In: Sets or clears Filter In action. If Filter In is set, you cannot use Filter Out (it 

is disabled).
• Filter Out: Sets or clears Filter Out action. If Filter Out is set, you cannot use Filter 

In (it is disabled).

Note:  Examples that show use of filters are provided later in this chapter.
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Advance the Sequence: Creates an event sequence consisting of the event you clicked 
on and an event in a successive state of the sequence. A thick arrow appears from the 
selected event and points downward. 

Figure 12.19 Advance the Sequence

In other words, the Advance the Sequence button is the link between two states in a 
multi-state sequence. The Advance the Sequence arrow tells the analyzer to go to the 
next state if it detects the event at the tail (origin) of the arrow.

The Action pop-up menu has the following restart and trigger options: 

• Restart the Sequence (not shown): Restarts the sequence. Note that this option is 
context-sensitive and only appears if you have created a multi-state sequence. A 
thick arrow appears from the selected event and point upward towards the first 
event in the sequence.

• Restart All: Restarts all rules in all sequences and in the global state and displays 
an arrow and a Restart All button. This action precludes selecting Advance the 
Sequence and Restart the Sequence.

• External Trigger Pulse HIGH: Sends an output signal with a Pulse High format 
through the output ports on the back of the UPAS. Pulse High is the default format. 
Pulse High causes the analyzer to transmit a 5-volt, 40-nanosecond signal.

• External Trigger Pulse LOW: Sends an output signal with a Pulse Low format 
through the output ports on the back of the UPAS. Pulse Low causes the analyzer to 
transmit a 0-volt, 40-nanosecond signal.

• External Trigger Pulse TOGGLE: Causes the analyzer to transmit a signal that 
toggles at a trigger event between a continuous 5 volt signal and a continuous 0 volt 
signal.

• Properties: Displays the Action Properties dialog for the selected action.
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Event Pop-up Menu
If you click an Event button in the Main Display area, the Event pop-up menu appears 
(Figure 12.20). 

Figure 12.20 Event Pop-up Menu

The Event pop-up menu has the following options: 

• Specify Action(s): Opens the Actions submenu, allowing you to assign an action to 
the event. Options on this submenu are the same as those on the Action pop-up, 
described previously.

• Add Counter: Adds a counter to count a specified number of times the event 
occurs before the analyzer executes the corresponding action.

• Move Event to: Moves the selected event to a different position in the Recording 
Rules window.

• Copy Event to: Copies the selected event to a different position in the Recording 
Rules window.

• Delete This Event: Deletes the selected Event. Alternatively, you can use the 
Delete button on the toolbar or keyboard to delete events.

• Properties: Displays the Event Properties dialog for the selected event.
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Events and Event Properties
Recording rules are associations between events and actions. These associations 
determine how trace recording occurs. Table 12.2 lists UWBTracer/Trainer supported 
events for MPI.

Table 12.2 UWBTracer/Trainer Events

Figure 12.21 Event Properties First Tab

Event Description

MPI Bus States Occurrence of selected MPI bus states (only for MPI channel)
MPI Serial Data Occurrence of specified MPI serial data (only for MPI channel)
WiMedia Conditions Occurrence of empty frames
Errors Occurrence of RX frame errors, aborted frames, FCS, errors, or 

length mismatch
WiMedia Frame Occurrence of a customizable frame pattern
WiMedia Frame Type Occurrence of specified WiMedia frame type:  

Beacon, Control, Command, Data, Aggregated Data
WiMedia Control Frame Occurrence of specified WiMedia Control frame: 

Imm-ACK, B-ACK, RTS, CTS, UDA, UDR, App Specific
WiMedia Command Frame Occurrence of specified WiMedia Command frame: 

DRP Rsv Req, DRP Rsv Resp, Probe, PTK, GTK, Range, 
App Specific

WUSB Device Notification Occurrence of specified WUSB Device Notification: 
DN_Connect, DN_Disconnect, DN_EPRdy, DN_RemoteWakeup, 
DN_MASAvailChanged, DN_Sleep, DN_Alive

WUSB MMC Packet Occurrence of WUSB MPC packet
WUSB Data Packet Occurrence of WUSB Data packet
WUSB Data Packet 
Host/Addr/Endp/Dir

Occurrence of any combination of the following fields:  
HOST, ADDR, ENDP, DIR

WUSB PID Occurrence of DATA, IDATA, HNDSHK, DN
WUSB ACK Code Occurrence of ACK, NAK, STALL
Timer Occurrence of timer expiration
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Actions and Action Properties
The following table lists UWBTracer/Trainer supported actions. 

The Set External Trigger button allows you to set the characteristics of the 
External Trigger signal. 

Figure 12.22 Action Properties (Event Properties Second Tab)

Event Description

Trigger Start recording.
Filter In Include in the trace file the event specified (and no others).
Filter Out Exclude from the trace file the event specified.
Advance the Sequence Go to the next state in this sequence 

(sequence in which this action is located).
Restart All Restart all sequences.
External Trigger Pulse HIGH Send HIGH pulse on external trigger output.
External Trigger Pulse LOW Send LOW pulse on external trigger output.
External Trigger Pulse TOGGLE Send HIGH-LOW pulse on external trigger output.
Properties Opens the Event Properties dialog box.
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External Trigger Signal Setting
The External Trigger Signal dialog allows you to view and set characteristics of the 
external trigger signal for each of the connected analyzer devices.

If an analyzer device is connected to the host machine, you can:

• View the current signal level and force it to HIGH or LOW.
• View the changes to the signal, if any, when a recording session starts.
• View the signal action when a trigger event occurs.
• Set the pulse width of the signal (only if the action is set to Pulse HIGH or 

Pulse LOW.

Figure 12.23 External Trigger Signal Dialog for Toggle Action and 
HIGH Signal Current Level
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Figure 12.24 External Trigger Signal Dialog for Pulse LOW Action and 
LOW Signal Current Level
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Figure 12.25 External Trigger Signal When No Analyzer Devices Are 
Connected to the Software
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The following table describes the External Trigger Signal behavior, which depends on the 
selected action and the current output signal level: 

Figure 12.26 External Trigger Signal Behavior Table
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Using a Single-State Sequence
As described previously, a sequence can be single-state or multi-state. A single-state 
sequence is a simple combination of events and actions. You cannot create looping or 
branching conditions with this type of sequence. 

A multi-state sequence allows you to branch successively to (advance to) lower states in 
the sequence or to loop to the front of the sequence (restart the sequence). 

Following are four typical examples of single-state sequences. 

Example 1: Creating a Simple Event Trigger
In this example, recording is triggered by detection of a WUSB ACK code.

Step 1 Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > ACK (Figure 12.27). 

Figure 12.27 Example 1: Creating the Event

Step 2 An ACK Event button appears in the Available Events area.

Step 3 Drag the button to the sequence cell at the top of the Main Display area.
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Step 4 Right-click the button. From the Action pop-up menu, select Trigger 
(Figure 12.28). 

Figure 12.28 Example 1: Assigning the Action

Figure 12.29 shows the completed event-action sequence. 

Figure 12.29 Example 1: Complete Rule
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Example 2: Creating an Event Counter
In addition to setting triggers and filters, you can set counters. A counter is an action that 
lets you set a trigger based on a count of events. To continue the previous example, for 
instance, you can create a rule that triggers on the tenth occurrence of a WUSB ACK.

Step 1 From example 1, the ACK is the first event in the state (Figure 12.29).

Step 2 Right-click the ACK event button in the cell. The Event pop-up menu 
appears.

Step 3 From the Event pop-up menu, select the Add Counter option 
(Figure 12.30). 

Figure 12.30 Example 2: Adding a Counter

The Event properties dialog box appears. (See “Events and Event Properties” 
on page 198 and “Actions and Action Properties” on page 199.). The set 
counter box is at the lower left. 

Step 4 By default, the counter box is set to a value of 2. For this example, reset 
the box to 10. 

Step 5 Close the Event properties dialog box. The counter value 10 now 
appears in the ACK Event button (Figure 12.31). The trigger occurs after 
the analyzer detects the tenth occurrence of an ACK. 

Figure 12.31 Example 2: Complete Rule
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Example 3: Creating an OR Condition
When you assign two or more Event buttons in state cell to the same action, the analyzer 
watches for all the events and does the action for the event that the analyzer sees first. 
Neither event has precedence over the other. There is a logical OR association among 
the events.

The following example assumes you want to trigger when the analyzer detects a WUSB 
NAK or the tenth occurrence of a WUSB ACK.

Step 1 From example 2, the ACK with counter is the first event in the state 
(Figure 12.31).

Step 2 Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > NAK.

Step 3 A NAK Event button appears in the Available Events area. Drag the 
button to the first cell and drop it below the ACK button (Figure 12.32). 

Figure 12.32 Example 3: Creating a Second Event
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Step 4 Right-click the NAK button. From the Action pop-up menu, select 
Trigger (Figure 12.33). 

Figure 12.33 Example 3: Assigning the Action

Figure 12.34 shows the completed event-action sequence. 

Figure 12.34 Example 3: Complete Rule
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Example 4: Creating an Event Filter
A filter causes the analyzer to filter in or filter out specified events from the recording. By 
default, all events are filtered in. However, you might want to preserve recording memory 
so that you can extend recording session time. To do so, you can filter out events that do 
not interest you (or filter in only those events that interest you). 

Note:  Keep in mind that when you filter out events, they are not recorded in the 
trace file. It is not the case that the events are present in the file but hidden.

The following example assumes you want recording to occur only if the analyzer detects 
an MPI error.

Step 1 Click the New Event button. From the drop-down menu, select MPI 
Errors to create an MPI Errors button in the Available Events area.

Step 2 Drag-and-drop the MPI Error button into the first cell in the Main Display 
area.

Step 3 Right-click in the Action box to the right of the MPI Error button. The 
Action pop-up menu appears (Figure 12.35). 

Figure 12.35 Example 4: Assigning the Action
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Step 4 From the Action pop-up menu, select the Filter In option.

Recording is now set to only record frames with MPI errors (Figure 12.36). 

Figure 12.36 Example 4: Complete Rule

Using a Multi-State Sequences
Multi-state sequences allow you to create conditions that branch down to successive 
states or loop back to the beginning of the sequence. They are more complex than 
single-state sequences but very powerful.

Example 5: Creating a Looping Sequence
Following is a typical example of a multi-state sequence. In this example, the analyzer 
waits for a WUSB Data packet (first state). When it detects a Data packet, the analyzer 
waits for a corresponding ACK packet and starts a timer (second state). 

If an ACK is received before the timer expires, the sequence restarts. If an ACK is not 
received before the timer expires, recording is triggered.

Step 1 Click the New Event button. From the drop-down menu, select WUSB 
PID > DATA to create a Data button in the Available Events area.

Step 2 Drag-and-drop the Data button into the first cell in the Main Display area.
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Step 3 Right click in the Action box to the right of the Data button. The Action 
pop-up menu appears (Figure 12.37). 

Figure 12.37 Example 5: Advancing the Sequence

Step 4 From the Action pop-up, select Advance the Sequence.

Step 5 An arrow appears next to the Data button (Figure 12.38). The arrow 
points to the cell for the second state in this sequence. 

Figure 12.38 Example 5: First State Complete



Chapter 12: Recording Options UWBTracer/Trainer  User Manual

212 LeCroy Corporation

Step 6 Click the New Event button. From the drop-down menu, select Timer to 
create a Timer button in the Available Events area (Figure 12.39). 

Figure 12.39 Example 5: Creating an Event, Second State

Step 7 Drag-and-drop the Timer button into the second cell in the Main Display 
area (Figure 12.40). 

Figure 12.40 Example 5: Dragging to the Second State Cell
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Step 8 Right-click the Timer event to open its Properties dialog box 
(Figure 12.41). 

Figure 12.41 Example 5: Bringing Up the Timer Dialog Box

Step 9 In the Properties dialog box for the timer, set the timer to 100 
microseconds (Figure 12.42). 

Figure 12.42 Example 5: Setting the Timer
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Step 10Click the New Event button. From the drop-down menu, select WUSB 
ACK Code > ACK to create an ACK button in the Available Events area 
(Figure 12.43). 

Figure 12.43 Example 5: Creating Another Event, Second State

Step 11Drag-and-drop the ACK button into the second cell in the Main Display 
area.

Step 12Assign Restart the Sequence as the action for the ACK event. An arrow 
appears that points from the ACK back to the Data event. 

Figure 12.44 Example 5: Complete Rule
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Using Independent Sequences
UWBTracer/Trainer supports up to two independent sequences. By default, they are 
labeled Sequence 0 and Sequence 1. 

The two sequences operate in parallel and have no effect on each other with the following 
exception. Either of the two sequences can contain the action Restart All. This action 
restarts both sequences in the Main Display area.

Example 6: Creating Independent Sequences
The following example adds a second sequence to Example 6. The second sequence 
triggers recording if any MPI error is detected.

In this example, there are two conditions that trigger recording. The first condition is 
defined by sequence 0. The second condition is defined by sequence 1. 

Figure 12.45 Example 6: Two Independent Sequences
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Chapter 13:  Recording
This chapter describes how to conduct recording sessions.

13.1 Making a Recording

Before Starting a Recording
Before starting a recording, verify the following: 
• Test environment has been set up and configured correctly. 
• Latest BusEngine™ and firmware versions have been downloaded to the analyzer 

(Chapter 13).
• Recording Options settings are appropriate (see Chapter 11).
• Analyzers participating in the recording are linked to the software application locally 

or through a network (see Chapter 10).

Starting a Recording
To start a recording session manually, click the Recording  button in the main 
tool bar or select Record > Start.

Stopping a Recording
To manually  stop the recording process, click the Stop  button or select 
Record > Stop.

Note:  If Recording Options is set to the Snapshot recording type, recording 
stops automatically when the recording buffer is full.

After stopping a recording, the recorded traffic automatically uploads from the analyzer 
to the host PC, where it is saved as a trace file in the default location. You can set the 
default location of a saved trace file in the General tab of the Recording Options window 
(see “Trace Filename and Path” on page 177). 
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Interrupting Uploading
During upload, you can interrupt the upload process by pressing the Stop button, or by 
selecting Record > Stop, to display  the Abort or Continue Uploading dialog box:

Figure 13.1 Abort or Continue Uploading Dialog Box

The Abort or Continue Uploading dialog box has the following options: 

• Stop: Stop upload but keep the data that has been uploaded already.
• Continue: Continue upload.
• Flush: Stop upload and discard any data that has been uploaded.
• Partial: Reupload part of the recorded buffer.The Partial Upload button is enabled 

only when you have data to upload. 
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Reuploading
When you click Partial Upload, the Upload Again with New Buffer Settings dialog box 
appears, which allows you to select a portion of data to upload again. You can also 
reupload part of the recorded buffer by clicking  on the Tool Bar or selecting the 
Record > Reupload command to open the Upload Again with New Buffer Settings dialog 
box 

Figure 13.2 Upload Again with New Buffer Settings Dialog Box

In the Upload Again with New Buffer Settings dialog box, select the part of the recording 
buffer you want to upload by dragging the left and right arrow sliders, then clicking the 
Upload Selection button. You can also choose to reupload the full buffer by clicking the 
Full Buffer button.

Note: The partial uploading mechanism is not precise. In some cases, some of the last 
packets may be not uploaded. If you need those packets, upload the whole buffer. 
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13.2 USB Cable Association for Certified WUSB
The Certified Wireless USB specifications define two types of methods of associating 
(also known as pairing): 

• Numeric association: Also called in-band because it uses WUSB wireless 
communication.

• Cable: Uses other means to associate two WUSB devices.Currently, only one 
out-of-band association method is supported in the specification. This is 
USB Cable Association, which uses a USB cable to connect two devices and 
allow them to associate.

The UWBTracer/Trainer™ analyzer can capture and use the USB Cable Association 
traffic for recording and decrypting Certified Wireless USB traffic. This is done with the 
help of the optional USB Analyzer plug-in module (US007MA), which should be inserted 
into the left-side slot. (The right-side slot has one of the UWB Analyzer plug-in modules.)

The USB plug-in module is active and waits for USB traffic from the moment the analyzer 
is powered on and ready for recording. By default, the module is configured to auto-detect 
the USB speed. If you want to set the speed manually, you can use the recording options 
settings (see Section 12.4, “Recording Options: USB Assoc.” on page 184).

Figure 13.3 USB Cable Association Cabling

Host
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Capturing USB Cable Association Traffic
To capture the USB Cable Association traffic:

Step 1 Make sure the analyzer is in operational state.

Step 2 Hook one device to one of the USB ports marked as CHAN 0 and leave 
the other device not connected. (Please note that CHAN 1 is not 
operational for this function.)

Step 3 Make sure the devices are ready for association.

Step 4 Connect the second WUSB device to the other USB port marked as 
CHAN 0.

At this point the association traffic capture of USB traffic between the two devices is done 
automatically. 

When detecting the connection context data passed between the two devices, the 
analyzer stores the information in a table in memory and passes it to the UWB recording 
channels. The analyzer can store multiple connection contexts for different pairs and use 
them in real-time for decrypting WUSB traffic.

When a recording is terminated, the entire connection context table is uploaded to the 
application software and stored in the Device List archive. This allows the analyzer to 
retrieve the connection context information from the application and use it in further 
recording sessions. If the Connection Context between two devices is already stored in 
the application and the devices were NOT re-associated, there is no need to repeat the 
association process.

Note:  

• We assume here that the association procedure is done "automatically' once the 
two WUSB devices are connected through a USB cable. If not, you may need to 
initiate the association process manually.

• To capture the association traffic, the system is not required to be in a recording 
state. However, to allow the real-time use of the captured connection context 
information for decrypting the UWB traffic, the Analyzer must be at least 
synchronized to the devices that were associated.
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Section 3. UWBTrainer Exerciser 
Traffic Generation
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Chapter 14:  Traffic Generation Overview
After the UWBTracer/Trainer™ and DUT have been cabled and powered on, you can test 
the setup by generating some traffic. The following steps show how to configure the 
Exerciser to generate and run a training sequence.

14.1 UWBTrainer Overview
UWBTrainer™ creates and runs traffic generation files using the UWB Exerciser. You 
download the compiled script to the device and run the script from the UWBTrainer. 

Using scripts, packets can be transmitted one after another or with certain timing or 
event-based pauses between them. This allows the UWBTrainer to act as a pattern 
generator with specific formatting and transmission rates. 

The traffic generator can emulate hosts and endpoint devices. Traffic generation can be 
used to transmit known errors, allowing you to observe how your device handles faulty 
link conditions.

Script execution can be throttled using Wait commands inserted directly into the script. 
Waits can be time based, require receipt of certain packet types, or can even require 
User input from the GUI.



Chapter 14: Traffic Generation Overview UWBTracer/Trainer User Manual

226 LeCroy Corporation

14.2 Traffic Generation Files
The .uwbg traffic generation files are text files consisting of a series of commands from 
a scripting language (see the UWBTrainer Generation Script Language Reference 
Manual or UWBTrainer Generation Script Language online help), and one or more 
Include statements linking other generation files into the current file. 

Figure 14.1 Traffic Generation File Example

UWBTrainer offers two mechanisms for creating traffic generation scripts: 

• Script Editor: Allows you to create and edit a generation script (.uwbg extension) 
to define any type of traffic.

• Graphical Scenario Editor: Allows you to build simple scripts using elements and 
links. Saving the graphical scenario (.ugg extension) creates a generation script file 
(.uwbg extension). A graphical scenario is suitable for basic scripts.

You can also create a traffic generation file by exporting the data from a trace into a traffic 
generator file. 

To edit a generation file, use the UWBTrainer Script Editor. 

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.
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Language Syntax
Syntax for the UWBTrainer™ Generator Script files is:

COMMAND = MODIFIER
{
  PARAM1 = VALUE1
  …
  PARAMn = VALUEn
}

For some commands, the list of the parameters is optional.

All literals are not case sensitive. 

All default values are zeros unless otherwise noted.

Integer literals represent numeric values with no fractions or decimal points. 

Hexadecimal, decimal, and binary notation are supported:

• Hexadecimal numbers must be preceded by 0x: 0x2A, 0x54, 0xFFFFFF01
• Decimal numbers are written as usual: 24, 1256, 2
• Binary numbers are denoted with 0b: 0b01101100, 0b01, 0b100000

It is possible to use expressions, for example, (i - 239).
String literals are surrounded by double quotes.

Array data types are represented by integer or string literals surrounded by “(“ and “)” 
characters, and separated by comma “,”, for example, (2,23,4).
Single-line comments are supported and should be preceded semicolon “;”.
Multi-line comments are also supported. Multi-line comments begin with a “/*” 
combination, and end with the reverse “*/” combination.

Note: For command descriptions and script examples, see the UWBTrainer Generation 
Script Language Reference Manual or the UWBTrainer Generation Script Language 
online help.
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14.3 Starting the UWBTrainer Program
You can use UWBTrainer with or without the analyzer unit. When used without an 
analyzer, the program works as a trace viewer to view, analyze, and print trace files.

To start UWBTrainer: 

Step 1 While running UWBTracer/Trainer, select the UWBTrainer button to 
display the LeCroy UWBTrainer Protocol Exerciser window 
(Figure 14.2). 

Figure 14.2 UWBTrainer Main Window
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14.4 Menu Bar
Table 14.1 lists menus available from the UWBTrainer Main window menu bar. Some 
menus and options are available only when a file is open.

Table 14.1 Menu Bar Menus 

Menu/Option Function

File

New Graphical 
Scenario

Displays a window in which you can create a graphical scenario.

New Text Scenario Displays a window in which you can create a text scenario.
Open Opens a trace file or traffic generation file.
Save Saves the open file.
Save As Saves all or a specified range of frames with a specified name.
Close Closes the current trace or generation file.
Print Prints part or all of the current trace or traffic generation file.
Print Preview Produces an on-screen preview before printing. 
Print Setup Sets options for the current or new printer.
Exit Exits the PETracer program.

Edit

Undo Revert to the state before the most recent action.
Redo Cancel the most recent Undo.
Cut Delete the selected item. 
Copy Place the selected items in a buffer for pasting later.
Paste Insert the Copy items at the location of the cursor.
Toggle Bookmark Show or hide the current bookmark (only for text scenarios).
Next Bookmark Go to the following bookmark (only for text scenarios).
Previous Bookmark Go to the preceding bookmark (only for text scenarios).
Clear All 
Bookmarks

Delete all bookmarks (only for text scenarios).

Find Allows searches by multiple criteria (only for text scenarios).
Replace Search for an item and replace it with the entered text (only for text 

scenarios).
Find Next Looks for the next instance of an event specified with Goto or Find (only 

for text scenarios).
Go to Positions the display to the specified item (only for text scenarios).
Select All Selects all text (only for text scenarios)
Show Properties Displays the properties of the object (only for graphical scenarios)
Build (This menu is only available for text scenarios.)
Compile Check the script for errors.
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View

Main Toolbar Displays the Main toolbar.
Views Toolbar Displays the Views toolbar.
Script Toolbar Displays the Script toolbar (only available for text scenarios)
Graphics Toolbar Displays the Graphics toolbar (only available for graphical scenarios).
Properties Bar Displays the Properties window (only available for graphical scenarios).
Status Bar Displays the Status bar.
Generation
Run Scenario Test the compiled script.
Stop Scenario Immediately stop the running script.
Preview Trace Display the trace.

Window

New Window Opens another instance of the Main Window.
Cascade Displays all open Main windows in cascaded format.
Tile Displays all open Main windows in tiled format. You can choose 

horizontal or vertical tiling later.
Arrange Icons Arranges Main window icons at bottom of display area.
windows Displays a list of open windows.
Help
About TrainerApp Displays version information.
Links (This menu is only available for graphical scenarios.)
Create link Add a link to the current Graphical Scenario at the cursor position.
Create Yes link Add a Yes link to the current Graphical Scenario at the cursor position.
Create No link Add a No link to the current Graphical Scenario at the cursor position.
Break link Remove the selected link.
Flip Link Direction Change the direction of the selected link.
Link label Enter a label for the selected link.

Menu/Option Function
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14.5 Tool Bar
The Main window Tool bar provides quick access to most UWBTrainer software functions. 
You can learn the function of each button by passing the mouse pointer over it. Button 
descriptions appear on the Status bar at the bottom of the window and as tooltips above 
each button. 

Figure 14.3 Main Window Toolbar

Main Toolbar Buttons

View Toolbar Buttons

Open New Graphical Scenario

Save New Text Scenario

Cut Copy

Paste

Print About

View Toolbox window 
(toggle)

View Output window 
(toggle)

View Errors window 
(toggle)
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Script Toolbar Buttons

UWBTrainer Buttons

Graphics Toolbar Buttons

Undo Find

Redo Replace

Toggle Bookmark Find Next

Next Bookmark Options

Previous Bookmark Compile

Clear All Bookmarks

UWBTracer Trace Preview

Record Stop Record

Run Stop

Show or hide ID Snap to Grid

Create link Create Yes link

Link label Create No link

Break link Flip link direction

Zooming In Zooming Out

Set Default 
Zoom Level
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14.6 Beginning Traffic Generation
To begin traffic generation:

Text Scenario
To use a text file:

Step 1 Open a traffic generation script file (extension .uwbg) by selecting 
 
File > Open or clicking the Open button  to display the script in the 
window. 

Figure 14.4 Main Window Toolbar with Traffic Generation Script

 
Alternatively, you can click the  New Text Scenario button or select 
File > New Text Scenario to display a blank script window.

The file name appears on the tab for the file. You can open more than one file.
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Step 2 Edit the script. See the next chapter for how to create and edit a traffic 
generation script.

Step 3 To compile the script, click the  Compile button or select 
Build > Compile. The file has the .uwbg extension.

After you click Compile, any errors appear in the Errors tab, with the file name, 
line number, and error description.

Output appears in the Output tab. You can Copy or Print the output.

The UWBTrainer Status bar at the bottom of the screen shows the current state 
of the script run. The lower right corner shows whether the Number Lock, Caps 
Lock, and Scroll Lock are on or off.

Note: The next chapter describes how to create and edit text scenarios.



UWBTracer/Trainer User Manual Chapter 14: Traffic Generation Overview

LeCroy Corporation  235

Graphical Scenario
To use a graphical editor:

Step 1 Click the  New Graphical Scenario button or select 
File > New Graphical Scenario to display a graphical layout with a 
Declarations Default object, a Begin object, and an End object. 

Step 2 Use the tools to build a graphical scenario. See the next chapter for how 
to create and edit a graphical scenario.

Step 3 Save the scenario. 

The scenario has the .ugg extension. 

When you save, the application makes a text script of the same name. The script 
file has a .uwbg extension.

Note: The next chapter describes how to create and edit graphical scenarios.
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14.7 Generating Traffic
After you create or edit, then compile and save a script, you can run the script.

To generate traffic:

Step 1 Click  or select Generation > Run Scenario to start executing 
the script. 

As the script executes, the Status bar displays the script's progress. 
The Current script position field displays the command description and trace 
packet number currently being generated.  

Step 2 To cancel the script, click  or select Generation > Stop Scenario.

You can also see a Trace Preview. Use the Trace Preview button  or select 
Generation > Trace Preview.
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Chapter 15:  Creating and Editing 
Generation Files
After you open an existing generation script file or create a new text scenario in the 
UWBTrainer™ Script Editor, or open an existing graphical scenario or create a new 
graphical scenario in the UWBTrainer™ Graphical Scenario Editor, use the following 
steps to edit or build a script.

15.1 Script Editor
The Script Editor offers several features to simplify the process of editing.

Highlighting
All known commands and parameters are highlighted in blue.

All predefined values and command modifiers are highlighted in brown.

Comments are in green.

Errors are in red.

Text Editing Commands
The Script Editor supports standard editor commands using toolbar buttons and Edit 
menu commands: 

• Cut/Copy/Paste: Also available by right-clicking a command to display a menu
• Undo/Redo
• Find/Replace/Find Next
• Bookmarks: Show/Hide, Previous/Next, and Clear All

Help
Right-click a command to display a menu from which you can choose Help.

Properties Window
The Properties window lists all parameters and their values for the selected script 
command. Parameters/values can be changed by entering text into the text boxes or by 
selecting items from pull-down menus.

File Tabs
At the top of the Script Editor window is a tab with the name of the open generation file. 

If there are Include statements in the generation file that link it to other generation files, 
these files automatically open and display as tabs at the top of the window. You can click 
the tabs to toggle between the open generation files.
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Errors
When you compile a script and have an error, the error appears in the Error tab at the 
bottom of the application window. Each error has a file name, line number, and 
description. Double-clicking the error jumps to the line number.

A red square appears next to the line number that contains the error.

A yellow square appears next to the line number that has a warnings.

Note:  You cannot run a script that has syntax errors.

Output
When you compile a script that generates output or when the application sends you a 
message, the information appears in the Output tab. 

Options Menu
You can set text options in the Options menu by clicking : 

• Enable Outlining: Adds a hierarchy of levels to the script.
• Show Line Numbers: Displays the line numbers at the left of the window.
• Show Tooltips: When you place the cursor over an item, information about the item 

appears.
• Enable IntelliSense: Starts the IntelliSense program.
• Toggle Outlining: If Enable Outlining is checked, allows you to expand or collapse 

the outlining levels.

Outlining
If you enable outlining at the Options button, you can collapse or expand code blocks. 
You can toggle outlining at the Options button or by right-clicking a command to display 
a menu from which you can choose Toggle Outlining.

Line Numbers
If you enable line numbers at the Options button, each line has a line number.

Tooltips
If you show tooltips at the Options button, tooltips appear when you place the cursor over 
a button or command.

IntelliSense
If you enable IntelliSense at the Options button, the Intellisense application prompts for 
known predefined values/literals when you type = or { after a known key.
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Text Snippets
Text snippets appear in the Text Snippets window. You can drag and drop a text snippet 
into the script. The available text snippets are:

• Start Timer: Enter Timeout Value, AutoReset, and TimeVar Index.
• Stop Timer: Has no options.
• Reset Timer: Has no options.
• Reg Rx Frm Cnd: For Register Rx Frame Condition, enter a Template Name, 

Condition Name, AutoReset, Counter, and TimeVar Index.
• Reg Tx Frm Cnd: For Register Tx Frame Condition, enter a Template Name, 

Condition Name, AutoReset, Counter, and TimeVar Index.
• Reset Cnd: For Reset Condition, enter a condition.
• Revoke Cnd: For Revoke Condition, enter a condition.
• Start Recording: Enter the Recorded Options File Path and Name and the Trace 

File Path and Name.
• Stop Recording: Enter 0 (no WaitForUpload) or 1 (WaitForUpload).
• Trigger Analyzer: Has no options.
• Wait For Super Frm: Wait For SuperFrame has no options
• Packet Size: Enter an integer.
• Pattern Size: Enter an integer.
• Field Size: Enter an integer.
• If(Any) Condition: First select one or more conditions, then require Any of the 

selected conditions.
• If(All) Condition: First select one or more conditions, then require All of the 

selected conditions.
• Else Condition: Select a condition.
• Until(Any): First select one or more conditions, then require Any of the selected 

conditions.
• Until(All): First select one or more conditions, then require All of the selected 

conditions.

Note:  In the syntax for Text Snippets, the /* and */ stand for comment marks. Do 
not use either the / or * when you enter a parameter. For example in: 
   If_Condition(/*condition_name_1*/)  
the entry might look like this: 
   If_Condition(Condition3)  
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Figure 15.5 Traffic Generation Script Text Snippets

Note: For information about each command, see the 
UWBTrainer Exerciser - Generation Script Language Reference Manual or consult the 
UWBTrainer Exerciser Generation Script Language online help.
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15.2 Creating a Script using the Script Editor
Before creating a script, read the UWBTrainer Generation Script Language Reference 
Manual or the UWBTrainer Generation Script Language online help to become familiar 
with all parts of a script and their order, learn about the commands and their parameters, 
and see an example script.

To create a script, do the following in the UWBTrainer window:  

Step 1 Click the  New Text Scenario button or select 
File > New Text Scenario to display a blank script. 

Figure 15.1 New Text Scenario for a Traffic Generation File

The file name appears on the tab for the file.
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Step 2 Enter file information in the beginning comment lines:

####################################################### 
# FILE INFORMATION: 
#   FILE:     
#   DESCRIPTION:     
#   REVISION HISTORY:  
#######################################################

Step 3 Add a comment line by starting the line with #:

# INCLUDE FILES:

Step 4 To include main definitions and some WUSB templates, add an include 
file line:

%include "Generation\Include\UwbGeneration.ginc"

Step 5 Add constants:

Const SOME_HEX_DATA   = 0xAABBFFEE 
Const SOME_DEC_DATA   = 12

Step 6 Add data patterns: 

DataPattern SetAddrReq   = { 00 05 00 00 00 00 00 00 }

Step 7 Add frame and structure templates:

struct DeliveryID 
{ 
    Sel : 1 = 1     # Stream Index 
    Val : 3 
}

Step 8 (optional) Add global variables.

Step 9 (optional) Add generation settings.
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Step 10Add the Main generation procedure, such as the following example: 

Main 
{ 
    # parser numeric variables 
    dest_address = 0x0080 
    host_address = 0xBEEF 
    endpoint     = 4 
    direction    = IN  
    # parser for loop 
    for( i = 0, i < 2, i++ ) 
    { 
        # parser If directive 
        if( i == 1 ) 
        { 
            host_address = 0xABCD 
            endpoint = 5 
        } 
        # parser Call of another generation procedure 
           Call Inquiry( host_address, dest_address,  
                         endpoint, direction ) 
    } 
}

Note: You can use the Text Snippets on the left Text Snippets panel to add 
commands and their parameters.
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Step 11Add other generation procedures, such as Inquiry.

For how to set up other generation procedures, see Appendix A of the 
UWBTrainer Exerciser - Generation Script Language Reference Manual or the 
UWBTrainer Exerciser Generation Script Language online help.

Figure 15.2 Traffic Generation Script Example

Step 12(optional) You can use the Text Snippets on the left Text Snippets panel 
to add commands and their parameters. 

Step 13Click the Compile button or select Build > Compile to check the file for 
errors. The application lists any errors in the Errors tab.

Step 14Click the Save button or select File > Save to save the file. 

Note: Saving the file automatically compiles it.

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.
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15.3 Graphical Scenario Editor
The Graphical Scenario Editor offers several features to simplify the process of editing.

Highlighting
The currently selected module is highlighted.

Modules with associated errors are red.

Links
You can add a link using the small L in a square of an element, selecting a link from the 
Links menu, or clicking a link on the Graphics toolbar.

To have a valid scenario, a series of links must connect the Begin block to the End block 

Each element in a scenario can receive at most one input link (inbound arrow), and the 
interface does not allow you to make one than one input link. This requirement makes the 
graphical scenario compatible with the scripting language, so that the graphical scenario 
.ugg file and its associated text scenario .uwbg file are always equivalent.

An If element, Else element, and Loop element have a Yes link and a No link. The Yes 
link must lead to a terminator element:

• The Yes link of an If element must terminate with an End If element.
• The Yes link of an Else element must terminate with an End Else element.
• The Yes link of a Loop element must terminate with a Continue Loop element.

The No link of an If element, Else element, or Loop element must not have a terminator 
element and must be on the path to the End block.

You can delete a link using Links > Break link or the Break Link button.

You can flip a link direction using Links > Flip link direction or the Flip Link Direction 
button.

You can label a link using Links > Link label or the Link Label button.

Links can only be horizontal or vertical. To make a diagonal, use two links through a 
Connector.

Tooltips
Tooltips appear when you place the cursor over a module.
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Elements
The available elements appear in the left window:

• Send Frame Elements: Outputs the specified Frame in accordance with the 
parameters.

• Wait for Frame/Header Elements: Defines a condition that will be waited for. The 
condition is registered and later revoked automatically.

• Condition Register Elements: Defines a condition that will be branched on or 
waited for in loop and flow control.

• Flow Elements: About timing, waiting, conditions, loops, settings, and recording
• Recently Used Elements: Lists the most recently used elements.

All elements have an Element Type and an Element Unique ID, and these cannot be 
changed for any element.

All elements have editable Comments and Descriptions. By default, the Element 
Comment is Default. You can enter a Description of up to 30 characters. Click Return to 
store entered values.

Note: For information about each command, see the UWBTrainer Exerciser - Generation 
Script Language Reference Manual or consult the UWBTrainer Exerciser Generation 
Script Language online help.



UWBTracer/Trainer User Manual Chapter 15: Creating and Editing Generation Files

LeCroy Corporation  247

Flow Elements
The Flow Elements are about timing, waiting, conditions, loops, settings, and recording. 
Figure 15.3 shows all the Flow elements. 

Figure 15.3 Flow Element Examples
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The Flow Elements window has:

• Timer Reg (Timer Registration): Defines a timer condition that will be branched on 
or waited for.

• Start Timer: Causes the Analyzer to start a timer named TIMER.
• Stop Timer: Causes the Analyzer to stop the timer named TIMER. 
• Reset Timer: Causes the Analyzer to reset the timer named TIMER and continue 

timing.
• Wait Condition: Wait for condition(s) to be met before continuing scenario 

execution. Wait Cond_Any continues if any of the conditions is met, while 
Wait Cond_All continues only if all conditions are met.

• Wait For SuperFrame: Waits for a specific SuperFrame number before continuing 
scenario execution.

• Reset Condition: Resets a Registered Condition to the Charged (waiting for 
trigger) state.

• Revoke Condition: Removes a Registered Condition from existence, so it will no 
longer be monitored. This provides better performance for the Exerciser.

• If: Used for conditional branching. If_Any branches if any of the conditions is met, 
while If_All branches only if all conditions are met. The Yes link is the direction of 
branching if the condition is met. Otherwise, the No link path taken is taken. 
Optionally, you may immediately follow this element along the No link with an Else 
element, to provide If-Then-Else capability.

• End If: Terminates the Yes link of the If branch. Control will continue along the No 
link of the If that created this branch.

• Else: For conditional branching in conjunction with the If element. If it is used, it 
must directly follow an If_Any or If_All element, along the No link of the If. The Else 
path is executed along the Yes link if the preceding If_xx condition is NOT executed. 
Once the Else path is executed, control returns to the NO link of the If element. (If 
the preceding If condition is met (True), the Else Yes link path is NOT followed.) The 
combination of the If and Else elements provides the commonly desired 
If-Then-Else behavior of a structured programming language.

• End Else: Terminates the Yes link of the Else branch. Control will continue along the 
No link of the Else that created this branch.

• Until Loop: Executes a sequence until a condition is met. The scenario follows the 
Yes link until the condition is met, then continues along the No link. Until_Any loops 
until at least one condition is met, while Until_All loops until all the conditions are 
met.

• Counted Loop: Executes a sequence a number of times, including infinite. The 
scenario follows the Yes link until the count reaches the value specified, then 
continues along the No link. Note that defining no value implies Infinite looping.

• Continue Loop: Terminates the Yes branch of a Counted Loop or an Until Loop and 
continues execution back at the beginning of the loop until the condition is met.

• Settings: Allows changing the settings or overriding the global settings during 
scenario execution.

• Start Trace: Causes the Analyzer to begin capturing traced data.
• Stop Trace: Causes the Analyzer to quit capturing traced data.
• Tx Sleep: Causes the Analyzer to sleep between items in the transmit FIFO. This 

gives greater precision between transmitted frames.
• Trigger: Causes the Analyzer to be triggered.
• Connector: Changes link direction in the editor. It does not alter the behavior.
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• Declarations: Contains all the %include statements of all the default definition 
files, along with global settings values. You can %include your own definition files. 
This element does not link to the rest of the scenario but is required.

• Begin: Is the first element in a scenario diagram. There is one and only one of these 
in a scenario.

• End: Terminates the scenario. One and only one is required.

Timer Elements
The timer elements are Start Timer, Stop Timer, and Reset Timer.

For the Start Timer element, you can enter:

• Timeout Value: Specifies the timer timeout in microseconds. Timeout must 
be set to a non-zero value to register a Timer condition. Default is 
UNDEFINED.

• AutoReset: Select ON to automatically reset the timer. Select OFF to not 
reset the timer. Default is OFF.

• TimeVar Index: Enter the index name of the Time variable in which to keep 
the condition timestamp when it is triggered or leave UNDEFINED. Default is 
UNDEFINED (timestamp is not saved).

The Stop Timer element has no specific options. 

The Reset Timer element has no specific options.

Wait Elements
The wait elements are Wait Condition and Wait For SuperFrame.

For the Wait Condition element, first select one or more conditions that you previously 
entered. TIMER can be a condition. Then require Any or All of the selected conditions.

The Wait For SuperFrame element has no specific options. 
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Condition Elements
The condition elements are Reset Condition, Revoke Condition, If, End If, Else, and Else 
If.

For the Reset Condition element, you can select a previously entered condition.

For the Revoke Condition element, you can select a previously entered condition.

For the If element, first select one or more conditions that you previously entered. TIMER 
can be a condition. Then require Any or All of the selected conditions.

The Else element has no specific options. 

The End If element has no specific options. 

The End Else element has no specific options.

Loop Elements
The loop elements are Until Loop, Counted Loop, and Continue Loop.

For the Until Loop element, first select one or more conditions that you previously 
entered. TIMER can be a condition. Then require Any or All of the selected conditions

For the Counted Loop element, select the number of loops.

The Continue Loop element has no specific options. 
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Settings Element
For the Settings element, you can enter or select:

• UwbTxPower: Enter an integer to indicate the UWB transmitter power in 
watts. Possible values are 0 (no transmitting) to 15 (max level). Default value 
is 0.

• UwbTxChannel: Select a UWB transmitter channel from the list to specify the 
wireless channel that UWBTrainer uses to transmit WiMedia traffic. The 
setting value for channel mapping includes Band Group (6 bits) and TF Code 
(3 bits) as specified in the WiMedia PHY Specification. Default value is AUTO 
(UWBTrainer uses the currently specified channel.)

• UwbRxChannel: Select a UWB receiver channel from the list to specify the 
wireless channel that UWBTrainer uses to receive WiMedia traffic. The setting 
value for channel mapping includes Band Group (6 bits) and TF Code (3 bits) 
as specified in the WiMedia PHY Specification. Default value is AUTO 
(UWBTrainer uses the currently specified channel.)

• SuperFrame Period: Enter an integer to indicate the SuperFrame period in 
microseconds. Possible values are 0 to 0xFFFFFF. Default value 0.

• FrameDelay: Enter an integer to specify the default delay in nanoseconds 
between transmitted frames. Default value: 0 (Frames are transmitted without 
delay.) Note: This value can be overridden by the Delay parameter in a Send 
Frame instruction. 

• AddMissingFields: Select On to instruct the script parser to add any missing 
frame template fields for Send Frame instructions. Missing TX frame template 
fields might include FCS. Missing RX frame template fields might include FCS 
+Rx packet end report fields (such as RSSI and LQI), which are used in 
conditions. Select OFF to not add fields. Select UNDEFINED to turn off this 
feature. Default value is ON.

Recording Elements
The recording elements are Start Trace, Stop Trace, Tx Sleep, and Trigger.

For the Start Trace element, enter the Recorded Options File Path and Name and the 
Trace File Path and Name. You can select to KeepOldTrace.

For the Stop Trace element, enter No (no WaitForUpload) or Yes (WaitForUpload).

For the Tx Sleep element, enter a Time in microseconds (default = 0) and (optionally) a 
Fine Time Adjustment in nanoseconds (default = 0).

The Trigger element has no specific options.

Connector Element
The Connector element is used only to allow a link to change direction.
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Send Frame Elements
The Send Frame Elements send frames. Figure 15.4 shows all the Send Frame 
elements.

Figure 15.4 Send Frame Element Examples

The Send Frame Elements window has:

• Send Beacon
• Send Data
• Send Command
• Send Control
• Send Agg_Data
• Send WUSB_MMC
• Send WUSB_Data_Out
• Send WUSB_Hand
• Send WUSB_DN
• Send WUSB_Data_In
• Send <User_Defined>
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The Send Frame Elements have the properties:

• Frame Type: Beacon, Data, Command, Control, Agg_Data, WUSB_MMC, 
WUSB_Data_Out, WUSB_Hand, WUSB_DN, WUSB_Data_In, 
<User_Defined>

• Template Name: Select first from a list of defined templates.

• Send Time Method: Select Delay to set the Delay time (in nanoseconds) to 
wait before sending the frame. Select SFOffset to set the Offset (in 
microseconds) of the frame to be sent, in SuperFrame. Select AbsTime to set 
the Absolute time (in microseconds) at which the frame is to be sent.  Note: 
When using the AbsTime time mode parameter, make sure that the first frame 
sent has a time value greater than or equal to 10 microseconds, to ensure 
correct timing between the first few frames of the scenario.

• Send Time Method Value (us): Enter an integer.

• Fine Time Adjustment (ns): Enter an integer.

• Burst: BURST_BEGIN specifies the start of a burst sequence. 
BURST_CONTINUE specifies that the burst sequence does not end. 
BURST_END specifies the end of a burst sequence. IGNORE means not to 
use a burst sequence.

• Overrides: Specifies a bitmap that instructs the UWBTrainer to set values for 
the TFC/BG, FCS, Scr, and Length fields from the frame template, rather than 
calculating them automatically.

• Overrides OVR_TFC: Check or uncheck.

• Overrides OVR_FCS: Check or uncheck.

• Overrides OVR_SCR: Check or uncheck.

• Overrides OVR_LEN: Check or uncheck.

• TimeVar Index: Enter the index name of the Time variable in which to keep 
the condition timestamp when it is triggered or leave UNDEFINED. Default is 
UNDEFINED (timestamp is not saved).

• Rate: Select from list.

• Reserved0: Enter an integer. Default is 0.

• Reserved1: Enter an integer. Default is 0.

• BG_Isb: Enter an integer. Default is 0.

• PreType: Select from list.

• BM: Select from list.

• Reserved2: Enter an integer. Default is 0.

• Reserved3: Enter an integer. Default is 0.

• RETRY: Select from list.

• CtrlType: Select from list.

• FrameType: Enter a type.

• AckPolicy: Select from list.
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• SECURE: Select from list.

• Version: Enter an integer. Default is 0.

• DestAddr: Enter an integer. Default is 0.

• SrcAddr: Enter an integer. Default is 0.

• Reserved4: Enter an integer. Default is 0.

• MoreFrag: Select from list.

• SeqNum: Enter an integer. Default is 0.

• FragNum: Enter an integer. Default is 0.

• AccMthd: Select from list.

• MoreFrms: Select from list.

• Duration: Enter an integer. Default is 0.

• MacAddrLower: Enter an integer. Default is 0.

• MacAddrUpper: Enter an integer. Default is 0.

• SlotNumber: Enter an integer. Default is 0.

• SecurityMode: Select from list.

• Reserved_BP: Enter an integer. Default is 0.

• Signaling Slot: Select from list.

• Movable: Select from list.

• IE_ID: Select from list.

• BPOIE_IE_CODE: Enter a code.

• BPOIE_Len: Enter an integer. Default is 0.

• BPOIE_val: Enter an integer. Default is 0.
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Condition Register Elements
The Condition Register Elements set conditions that can be used in loop and condition 
flow control. Figure 15.5 shows all the Condition Register elements. 

Figure 15.5 Condition Register Element Examples

The Condition Register Elements window has:

• Cnd Reg Beacon
• Cnd Reg Data
• Cnd Reg Command
• Cnd Reg Control
• Cnd Reg Agg_Data
• Cnd Reg WUSB_MMC
• Cnd Reg WUSB_Data_Out
• Cnd Reg WUSB_Hand
• Cnd Reg WUSB_DN
• Cnd Reg WUSB_Data_In
• Cnd Reg <User_Defined>
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The Condition Register Elements have the properties:

• Frame Type: Beacon, Data, Command, Control, Agg_Data, WUSB_MMC, 
WUSB_Data_Out, WUSB_Hand, WUSB_DN, WUSB_Data_In, 
<User_Defined>

• Template Name: Select first from a list of defined templates.

• Condition Name: Enter a unique name.

• AutoReset: Select Yes to automatically reset the condition after it is triggered. 
Select No to not reset the condition after it is triggered. Select UNDEFINED 
to turn off AutoReset. Default is UNDEFINED.

• Counter: Enter an integer to specify the number of times the condition event 
occurs before the condition is triggered. Default is 1.

• TimeVar Index: Enter the index name of the Time variable in which to keep 
the condition timestamp when it is triggered or leave UNDEFINED. Default is 
UNDEFINED (timestamp is not saved).

• Rate: Select from list.

• Reserved0: Enter an integer. Default is 0.

• Len7_0: Enter an integer. Default is 0.

• Scr: Enter an integer. Default is 0.

• Reserved1: Enter an integer. Default is 0.

• Len11_8: Enter an integer. Default is 0.

• BG_Isb: Enter an integer. Default is 0.

• TFCode: Select from list.

• PreType: Select from list.

• BM: Select from list.

• Reserved2: Enter an integer. Default is 0.

• Reserved3: Enter an integer. Default is 0.

• RETRY: Select from list.

• CtrlType: Select from list.

• FrameType: Enter a type.

• AckPolicy: Select from list.

• SECURE: Select from list.

• Version: Enter an integer. Default is 0.

• DestAddr: Enter an integer. Default is 0.

• SrcAddr: Enter an integer. Default is 0.

• Reserved4: Enter an integer. Default is 0.

• MoreFrag: Select from list.
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• SeqNum: Enter an integer. Default is 0.

• FragNum: Enter an integer. Default is 0.

• AccMthd: Select from list.

• MoreFrms: Select from list.

• Duration: Enter an integer. Default is 0.

• MacAddrLower: Enter an integer. Default is 0.

• MacAddrUpper: Enter an integer. Default is 0.

• SlotNumber: Enter an integer. Default is 0.

• SecurityMode: Select from list.

• Reserved_BP: Enter an integer. Default is 0.

• Signaling Slot: Select from list.

• Movable: Select from list.

• IE_ID: Select from list.

• BPOIE_IE_CODE: Enter a code.

• BPOIE_Len: Enter an integer. Default is 0.

• BPOIE_val: Enter an integer. Default is 0.

• RSSI_Lo: Enter an integer. Default is 0.

• RSSI_Hi: Enter an integer. Default is 0.

• LQI_Lo: Enter an integer. Default is 0.

• LQI_Hi: Enter an integer. Default is 0.

• Duration_Lo: Enter an integer. Default is 0.

• Duration_Hi: Enter an integer. Default is 0.

• Reserved_0: Enter an integer. Default is 0.

• Errors: Enter an integer. Default is 0.
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Wait For Frame/Header Elements
The Wait For Frame/Header Elements cause a wait for the data type.  
Figure 15.6 shows all the Wait For Frame/Header elements. 

Figure 15.6 Wait For Frame/Header Element Examples

The Wait for Frame/Header Elements window has:

• Wait for Beacon
• Wait for Data
• Wait for Command
• Wait for Control
• Wait for Agg_Data
• Wait for WUSB_MMC
• Wait for WUSB_Data_Out
• Wait for WUSB_Hand
• Wait for WUSB_DN
• Wait for WUSB_Data_In
• Wait for <User_Defined>
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The Wait For Frame/Header Elements have the properties:

• Frame Type: Beacon, Data, Command, Control, Agg_Data, WUSB_MMC, 
WUSB_Data_Out, WUSB_Hand, WUSB_DN, WUSB_Data_In, 
<User_Defined>

• Template Name: Select first from a list of defined templates.

• Timeout: Enter an integer to specify the time to wait in microseconds. Default 
is 0.

• Counter: Enter an integer to specify the number of times the condition event 
occurs before the wait is triggered. Default is 1.

• TimeVar Index: Enter the index name of the Time variable in which to keep 
the timestamp when it is triggered or leave UNDEFINED. Default is 
UNDEFINED (timestamp is not saved).

• Match on Rx Frame Info: Enter Yes to match the Rx Frame information or 
no to not match. Default is Yes.

• Rate: Select from list.

• Reserved0: Enter an integer. Default is 0.

• Len7_0: Enter an integer. Default is 0.

• Scr: Enter an integer. Default is 0.

• Reserved1: Enter an integer. Default is 0.

• Len11_8: Enter an integer. Default is 0.

• BG_Isb: Enter an integer. Default is 0.

• TFCode: Select from list.

• PreType: Select from list.

• BM: Select from list.

• Reserved2: Enter an integer. Default is 0.

• Reserved3: Enter an integer. Default is 0.

• RETRY: Select from list.

• CtrlType: Select from list.

• FrameType: Enter a type.

• AckPolicy: Select from list.

• SECURE: Select from list.

• Version: Enter an integer. Default is 0.

• DestAddr: Enter an integer. Default is 0.

• SrcAddr: Enter an integer. Default is 0.

• Reserved4: Enter an integer. Default is 0.

• MoreFrag: Select from list.
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• SeqNum: Enter an integer. Default is 0.

• FragNum: Enter an integer. Default is 0.

• AccMthd: Select from list.

• MoreFrms: Select from list.

• Duration: Enter an integer. Default is 0.

• MacAddrLower: Enter an integer. Default is 0.

• MacAddrUpper: Enter an integer. Default is 0.

• SlotNumber: Enter an integer. Default is 0.

• SecurityMode: Select from list.

• Reserved_BP: Enter an integer. Default is 0.

• Signaling Slot: Select from list.

• Movable: Select from list.

• IE_ID: Select from list.

• BPOIE_IE_CODE: Enter a code.

• BPOIE_Len: Enter an integer. Default is 0.

• BPOIE_val: Enter an integer. Default is 0.

• RSSI_Lo: Enter an integer. Default is 0.

• RSSI_Hi: Enter an integer. Default is 0.

• LQI_Lo: Enter an integer. Default is 0.

• LQI_Hi: Enter an integer. Default is 0.

• Duration_Lo: Enter an integer. Default is 0.

• Duration_Hi: Enter an integer. Default is 0.

• Reserved_0: Enter an integer. Default is 0.

• Errors: Enter an integer. Default is 0.
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Properties Window
The Properties window lists all properties and their values for the selected module. 
Parameters/values can be changed by entering text into the text boxes or by selecting 
items from pull-down menus.

For example, the Declarations Default has the properties:

• Type: Click Enter to store string entry.
• Element Type: Declarations.You cannot modify the number.
• include file name list: Default is Uwbgeneration.Ginc and 

other_frame_templates.ginc. You can add more .ginc files.
• Description: Enter a description.
• Element Comment: Default is “Default”. Enter further comments.
• Element Unique ID: Default is 16. You cannot modify the number.

Begin has the properties:

• Type: Click Enter to store string entry.
• Element Type: Begin.You cannot modify this.
• Description: Enter a description.
• Element Comment: Enter comments.
• Element Unique ID: Default is 3. You cannot modify the number.

End has the properties:

• Type: Click Enter to store string entry.
• Element Type: End.You cannot modify this.
• Description: Enter a description.
• Element Comment: Enter comments.
• Element Unique ID: Default is 6. You cannot modify the number.

The fields which are part of Frame Templates are shown in one of the two following ways 

• FieldName : n (where n is the number of bits in the fixed-length field. Bit fields 
always have a fixed length.)

• FieldName :  m Bytes (where m is the number of bytes that you specify. Byte fields 
may have from 0 to any number of blank separated hex values.)
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15.4 Creating a Graphical Scenario using the Graphical 
Scenario Editor

Before creating a graphical scenario, read the UWBTrainer Exerciser - Generation Script 
Language Reference Manual or the UWBTrainer Exerciser Generation Script Language 
online help to become familiar with all parts of a script and their order, learn about the 
commands and their parameters, and see an example script.

Making graphical scenario involves:

1. Making templates before using the graphical scenario editor.

2. Making declarations

3. Using links and elements to go from the Begin block to the End block

As you add elements and link them, the Graphical Scenario Editor prompts you to add 
constants, data patterns, struct and frame templates, the Main generation procedure, and 
other generation procedures, or adds them automatically as needed.

Saving a graphical scenario (.ugg extension) generates a valid generation script of the 
same name (.uwbg extension).

Note: Using the Graphical Scenario Editor to create graphical scenarios provides an 
alternative way to build relatively simple traffic generation scripts. To build complex traffic 
generation scripts, use the Script Editor and emulate the methods shown in the 
UWBTrainer Exerciser - Generation Script Language Reference Manual. 
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To create a graphical scenario, do the following in the UWBTrainer window:  

Step 1 Click the  New Graphical Scenario button or select 
File > New Graphical Scenario to display the default graphical 
scenario. 

Figure 15.7 New Graphical Scenario

The graphical scenario name appears on the tab.
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Step 2 (optional) Click the Declarations Default region to display its properties 
in the Properties window.

Figure 15.8 Properties Window

By default, the graphical scenario includes the 
Generation\Include\UwbGeneration.ginc and other_frame_templates.ginc 
generation include files. Enter another generation include file name to include 
that file.

Note: The Element Type is Declarations, which has Element Unique ID 16. All 
elements have an Element Type and an Element Unique ID, and you cannot 
change them for any element.

Note: By default, the Element Comment is Default, which you can change. You 
can also enter a Description of up to 30 characters. All elements have editable 
Comments and Descriptions. 

Click Return to store entered values.
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Step 3 (optional) Click the Begin region to display its properties in the 
Properties window. By default, the Element Comment is blank, which 
you can change.You can also enter a Description of up to 30 characters. 
All elements have editable Comments and Descriptions. Click Return to 
store entered values.

The Begin block has a small L in a square. This indicates the start of a link. A link 
ends on the border of an element.

Note: You cannot edit any properties of the End Element.

Step 4 Select the main Wait or Send element, which is the action element. For 
example, select a Send element: 

Figure 15.9 Graphical Scenario Example - Action

Set the parameters for the Wait or Send element. For example, if you use a Send 
element, select the Template Name from a list of defined templates.Optionally 
set the time with the Send Time Method, Send Time Method Value, and Fine 
Time Adjustment parameters, the Burst parameter, any Overrides, or the 
TimeVar Index parameter.
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Step 5 If you will use a condition in the flow, select a Condition Register 
element: 

Figure 15.10 Graphical Scenario Example - Condition

Select the Template Name from a list of defined templates. 

Enter a unique Condition Name. 

Optionally set the AutoReset, Counter, or TimeVar Index parameter.
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Step 6 If needed, select a Flow element, such as an If element. 

Figure 15.11 Graphical Scenario Example - Flow

For the If element, select the condition that you previously entered. 

Then require Any or All of the selected conditions. (In this example, it does not 
matter, because there is only one condition.)
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Step 7 Terminate the If element using an End If element. 

Figure 15.12 Graphical Scenario Example - Links
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Step 8 Make a pathway from the Begin to the End. 

Figure 15.13 Graphical Scenario Example - Links

Make link from Begin. 

Make a link from the Condition element. 

Make the Yes Link and the No link of the If element. 

Make a link from the Send element to the End If, so the If element has a 
termination.
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Figure 15.14 shows a second example of a simple Looping graphical scenario. 
It uses a Send Frame Beacon element, Counted Loop element, and a 
Continue Loop element to transmit a single beacon frame 500 times.

Figure 15.14 Looping Scenario Syntax

The Continue Loop element terminates the Counted Loop element.
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Figure 15.15 shows how to make an If-Then-Else graphical scenario. Put an 
Else element immediately after an If element and link from the No link of the If 
element to the Else element.

The Yes link of the If element must terminate on an End If element.  
The Yes link of the Else element must terminate on an End Else element.

The No link of an If or Else element must not have a terminator element and 
must be on the path to the End block.

If the If condition is met, the scenario follows the Yes link of the If element. If the 
If condition is NOT met, the scenario follows the No link of the If element to the 
Else element. If the Else condition is met, the scenario follows the Yes link of the 
Else element. If the Else condition is NOT met, the scenario follows the No link 
of the Else element.

The figure also illustrates Loop elements. The Yes link of a Loop element must 
terminate with a Continue Loop element. The No link of a Loop element must not 
have a terminator element and must be on the path to the End block.

Figure 15.15 If-Then-Else Example

Step 9 To save the graphical scenario and make a generation script file, click 
the Save button or select File > Save. The application lists any errors in 
the Errors tab.
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15.5 Exporting a Trace to a Traffic Generation File
A simple way to create a script file is to open a trace and then to export the trace data to 
a generation file. 

To export WiMedia packets to a UWBTrainer script file (extension .uwbg), see the 
instructions in Chapter 3 in the section “Exporting Packets to UWBTrainer Script” on 
page 42.
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Chapter 16:  Updates and Licensing
This chapter describes how to update the UWBTracer/Trainer™ software and how to 
obtain a software license key from LeCroy. 

16.1 Updates Overview
From time to time as modifications are made to the UWBTracer Analyzer, it may become 
necessary to update the UWBTracer/Trainer software. You can obtain new software from 
the LeCroy website: 

www.LeCroy.com
When you download new UWBTracer/Trainer software, the most recent firmware, 
BusEngine™, and Plugin Init files are included in the software package. After software 
installation, you can compare the Plugin Init, firmware, and BusEngine version numbers 
against what is currently loaded on the analyzer. If those files do not match, you can 
download the latest versions using the manual or automatic process described later in 
this chapter.

Note:  LeCroy analyzers include a Three-Year Investment Protection Agreement 
that entitles users to new software during that period. To update software 
after that period, you must renew the LeCroy Maintenance Agreement. 
Contact LeCroy for details.

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.
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16.2 Software, Firmware, and BusEngine Versions
The Readme file on the installation CD and on the installed directory on your hard drive 
gives last-minute information about the current release. As mentioned, the software 
package for each release includes the most recent downloadable images of the firmware, 
BusEngine, and Plugin Init. 

After the UWBTracer Analyzer has completed the self diagnostics and is connected to the 
PC, you can check the latest versions of the firmware, BusEngine, and Plugin Init.

To check information about the current software:

• Select About UWBTracer/Trainer… from the Help menu to display the About 
UWBTracer/Trainer window (Figure 16.1). 

Figure 16.1About UWBTracer/Trainer Window

About UWBTracer/Trainer details revisions of the following software and hardware:

• UWBTracer/Trainer Software Version, Build Number
• UWBTrainer Firmware Version, Build Number
• Platform Firmware Version, Build Number
• BusEngine Version
• Plugin Init Version
• Unit Serial Number

Note:  When contacting LeCroy for technical support, please have available all the 
revisions reported in the About UWBTracer/Trainer window.
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16.3 Software Updates
When a new software release is available, it is posted on the Support page of the LeCroy 
website at www.LeCroy.com/support.html.
To update the software: 

Step 1 Find the latest released software version on the LeCroy website under 
Support.
If you are running the latest version of the software, no further action is needed. 
If you are not running the latest version, continue to Step 2.

Step 2 Download the Zip file from the website.

Step 3 Unzip the files into a directory.

Step 4 Click Start, then Run, and browse to where you unzipped the files.

Step 5 Select the program named Setup and click Open.

Step 6 Click OK to run the Setup and begin the installation.

Step 7 Follow the on-screen instructions to complete the installation.

Step 8 Read the Readme file for important information on changes in the 
release.
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16.4 BusEngine, Firmware, and Plugin Init Updates
Often you need to update BusEngine, firmware, and Plugin Init files when you update the 
UWBTracer/Trainer software. The software Readme file indicates if Plugin Init, 
BusEngine, and/or firmware updates are necessary.

Note:  Within a new software release, it might also be necessary to update the 
BusEngine hardware of the analyzer. The Readme file lets you know if this 
is necessary. 

Automatic Update of BusEngine, Firmware, and Plugin Init
When you update UWBTracer/Trainer software, the new version might not match (be 
compatible with) the Plugin Init, BusEngine, and firmware currently installed on the 
analyzer. As the software is loaded, it determines if there is a mismatch. If so, the 
software initiates automatic update of the Plugin Init, firmware, and BusEngine.

A dialog box appears to confirm that you want to proceed with the update. If so, click OK. 
The update is executed.
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Manual Update of BusEngine, Firmware, and Plugin Init
You also can manually load Plugin Init, firmware, and BusEngine files using the 
Update Device command on the Setup menu. 

To update manually: 

Step 1 From the Setup menu, select Update Device to display the 
Update UWBTracer/Trainer dialog box: 

Figure 16.2Update UWBTracer/Trainer Dialog Box

You can update the Firmware, BusEngine, and/or Plugin Init (PHY Initialization 
data). 

Step 2 Select whether to update Firmware, BusEngine, and/or Plugin Init, and 
browse to the file if necessary. 

Step 3 Click Update to confirm that you want to proceed with the update. The 
update is executed.
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16.5 License Information
You can view license information for UWBTracer/Trainer by selecting 
Display License Information from the Help menu. The License Information window 
indicates the maintenance expiration data for UWBTracer/Trainer. It also provides a list 
of the named features supported by the current software version. 

Named features enabled on your PC are indicated by Yes in the Purchased column. 
Named features that are not enabled on your PC are indicated by No in the Purchased 
column. Whether or not named features are enabled depends on the license key stored 
in your analyzer. 

Figure 16.3License Information Window
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If you try to use a feature for which you do not yet have a license, the program displays 
the License Protection Message (Figure 16.4). Named features that are not enabled on 
your PC are indicated by No in the Purchased column. To use the feature, you must 
purchase a license. 

Figure 16.4License Protection Message
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16.6 Updating the Software License
A current license agreement with LeCroy entitles the Analyzer owner to continued 
technical support and access to software updates as they are published on the LeCroy 
website. 

If your license expires, you must obtain a license key from LeCroy (refer to the contact 
information at the back of this manual.) 

After you obtain a license key, follow these steps to install it:

Step 1 From the Help menu, select Update License to display the 
Update License dialog box. 

Step 2 Enter the path and filename for the license key.

 OR 

Use the Browse button to navigate to the directory that contains the license key 
and select the *.lic file. 

Step 3 Click Update.
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Section 4. Appendices
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Appendix A:  MPI
This appendix describes the pin assignments for the MPI Cables and connectors 
supported in the LeCroy MPI Kit.

The tables in this appendix describe only the pins used for the MPI signals specified in 
the WiMedia specifications. Other pins are marked as Reserved, Not Used, or 
NA (Not Applicable). 

Note: Pins marked as Reserved, Not Used, or NA (Not Applicable) may be used by 
PHY and MAC vendors to implement additional propriety data and control protocols. The 
following tables do not specify such proprietary signals. For more information about such 
pins, refer to vendor documentation. 

A.1 Cable Adapter Pin Assignments
Table A.1, Table A.2, and Table A.3 show connector pin assignments for the 68-pin, 
60-pin, and 40-pin probe cables.

Section 11.2, “Connecting Cables and Adapters” on page 162 shows how the cables are 
connected to the analyzer and adapter. 
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Table A.1 Adapter Pin Assignments: 68-Pin Probe Cable
Pin Definition Pin Definition

A1 N/C B1 N/C

A2 GND B2 GND

A3 DATA[0] B3 PHY_RESET

A4 GND B4 GND

A5 DATA[1] B5 N/C

A6 GND B6 GND

A7 DATA[2] B7 MCTL

A8 GND B8 GND

A9 DATA[3] B9 SERIAL_DATA

A10 GND B10 GND

A11 DATA[4] B11 CCA_STATUS

A12 GND B12 GND

A13 DATA[5] B13 CCA_REQ

A14 GND B14 GND

A15 DATA[6] B15 N/C

A16 GND B16 GND

A17 DATA[7] B17 N/C

A18 GND B18 GND

A19 PCLK B19 N/C

A20 GND B20 GND

A21 N/C B21 N/C

A22 GND B22 GND

A23 TX_EN B23 N/C

A24 GND B24 GND

A25 RX_EN B25 N/C

A26 GND B26 GND

A27 FSYNC B27 N/C

A28 GND B28 GND

A29 PHY_ACTIVE B29 N/C

A30 GND B30 GND

A31 DATA_EN B31 +5V

A32 GND B32 GND

A33 EOF B33 +V5

A34 GND B34 GND
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Table A.2 Adapter Pin Assignments: 60-Pin Probe Cable
Pin Definition Pin Definition

1 CCA_STATUS 2 Reserved

3 Reserved 4 SERIAL_DATA

5 PCLK 6 DGND

7 PHY_RESET 8 PHY_TX_EN

9 SLEEP 10 +3.3V

11 DATA[0] 12 PHY_RX_EN

13 DATA[2] 14 DGND

15 DGND 16 DATA_EN

17 DATA[4] 18 DATA[1]

19 DATA[6] 20 DATA[3]

21 +3.3V 22 DATA[5]

23 PHY_ACTIVE 24 DATA[7]

25 Reserved 26 DGND

27 NA 28 NA

29 NA 30 NA

31 NA 32 DGND

33 NA 34 +3.3V

35 NA 36 NA

37 NA 38 NA

39 NA 40 NA

41 NA 42 NA

43 DGND 44 NA

45 +3.3V 46 NA

47 NA 48 NA

49 NA 50 NA

51 +3.3V 52 DGND

53 Reserved 54 NA

55 Reserved 56 NA

57 DGND 58 Reserved

59 NA 60 NA
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Table A.3 Adapter Pin Assignments: 40-Pin Probe Cable

A.2 Input Load of UWBTracer/Trainer MPI
Each MPI signal pin has a 220 ohm tapping resistor followed by a CMOS buffer with 10pF 
of input capacitance. The resistor and buffer are within 2 inches of the connector on the 
Cable Adapter or Board Adapter. 

PHY MPI pin ------------------ Connector pin
                             |
                             |
                             |------ Resistor ------ Buffer
                             |
                             |
MAC MPI pin ------------------ Connector pin

Pin Definition Pin Definition
1 RESET 2 GND

3 DATA0 4 NC

5 DATA1 6 PWR

7 DATA2 8 PWR

9 DATA3 10 PWR

11 DATA4 12 PWR

13 DATA5 14 PWR

15 DATA6 16 PWR

17 DATA7 18 NC

19 GND 20 KEY

21 PCLK 22 GND

23 TX_EN 24 GND

25 RX_EN 26 GND

27 PHY_ACT 28 NC

29 DATA_EN 30 GND

31 CCA_ST 32 GND

33 SE_DAT 34 GND

35 STOP_C 36 GND

37 RSVD1 38 GND

39 RSVD2 40 GND
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Appendix B:  Legacy Script Decoding
Earlier LeCroy USB Analyzers used .REQ and .DSC script files to decode class and 
vendor requests. 

• .REQ stands for Requests.
• .DSC stands for Descriptors.

This method uses fixed definitional structures. 

LeCroy provided .req files for the following requests and classes:

• Standard Requests (standard.req)
• Hub Class (hub.req)
• HID Class (hid.req)
• Printer Class (printer.req)
• Communications Class (communication.req)
• Audio Class (audio.req)
• Bluetooth USB HCI commands and events (bluetooth.req)
• Vendor Request definition file (vendor.req)

Note:  .req files are no longer used in LeCroy USB Analyzers and are not 
compatible with the UWBTracer/Trainer application. 
The new script decoding for LeCroy USB Analyzers uses 
Script Decoder version .dec files. 
Only .dec files are compatible with the UWBTracer/Trainer application.  
For information about .dec files and the new script decoding, see 
“Class and Vendor Definition Files” on page 79.

See Section 3.18 "Directory Structure on Windows XP and Vista" on page 45.
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Appendix C:  WiMedia Platform 
Compliance Tests

This appendix describes the UWBTrainer™ TX-only Test System Exerciser scenarios 
and UWBTracer™ VSE Compliance scripts for test cases from the 
WiMedia Compliance and Interoperability (C&I) Platform Test Specification 1.1. 

For information about running UWBTrainer exerciser scenarios, see Chapter 14 “Traffic 
Generation Overview” on page 225. 

For information about running verification scripts, see See Section 9.8 "Running 
Verification Scripts" on page 137. 

C.1 UWBTrainer TX-only Exerciser Scenarios
All TX-only tests from the WiMedia Platform Test Specification 1.1 are available. 

Note: The current LeCroy implementation of Test Case 6 differs slightly from the test 
specification. However, it still invokes the correct responses from compliant devices.

C.2 UWBTracer VSE Compliance Scripts
The following VSE compliance scripts are available: 

• Background Checks.vse: This script implements the Beacon Format checks 
(BFC) and Beacon Protocol checks (BPC) of the WiMedia Platform Test 
Specification 1.1. In addition, this script checks for DevAddr collisions, beacon slot 
collisions, and HCS error slot collisions.

• Verify Test Case [nn].vse: This set of scripts verifies the Test System output for 
TX-only test cases, as defined in the WiMedia Platform Test Specification 1.1.  
Note: These scripts are not designed to verify behaviors of a DUT or INTD.

 
The following scripts, which were included in previous versions of UWBTracer, are 
obsolete and are superseded by the Background Checks.vse script:

• Beacon Format Test.vse
• Beacon Period Synchronization.vse
• Beacon Protocol Observation Background Tests.vse
• Beacon Slot Collision Test.vse
• Clock Accuracy.vse
• Generated DevAddr Conflict Test.vse
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Appendix D:  Specifications
The following specifications describe a combined CATC 5K Analyzer and UWB Analyzer 
Plug-in.

D.1 Package

D.2 Power Requirements
12 VDC, 60 W maximum 

D.3 Environmental Conditions

Dimensions CATC 5K: 
9.8 x 6.5 x 2.0 inches (24.9 x 16.5 x 5.1 cm)
UWB Analyzer Plug-in:  
4.0 x 5.0 x 1.3 inches (10.2 x 12.7 x 3.3 cm)

Connectors CATC 5K: 
12 VDC power connection 
External I/O and trigger connection (Mini DIN-9) 
External Sync IN connection (Mini DIN-4) 
External Sync OUT connection (Mini DIN-4) 
Antenna RF SMA Connector 
PC connection (USB2.0, type “B”)
UWB Analyzer Plug-in: 
MPI Adapter port

Weight CATC 5K: 
Approximately 2 lbs. 9 oz. (1.2 kg)
UWB Analyzer Plug-in: 
Approximately 3 oz. (0.1 kg)

Operating Temperature 0 to 40°C (32 to 104°F)

Storage Range -20 to 80°C (-4 to 176°F)

Operating Humidity 10 to 90%, non-condensing

Operating Altitude Up to 6560 feet (2000 meters)
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D.4 China Restriction of Hazardous Substances Table
The following tables are supplied in compliance with China's Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative (“you” or 
“your”), fully complete and return the registration card 
provided with the applicable hardware product or peripheral 
hardware products (each a “Product”) within fifteen days of 
the date of receipt from LeCroy or one of its authorized 
representatives, LeCroy warrants that the Product will be free from defects in materials 
and workmanship for a period of three years (the “Warranty Period”). You may also 
complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of 
the date of delivery by LeCroy of a Product to a common carrier for shipment to you or to 
LeCroy's authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, damage 
during shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems 
with electrical power, including power surges and outages, servicing not authorized by 
LeCroy, usage or operation not in accordance with Product instructions, failure to perform 
required preventive maintenance, software related problems (whether or not provided by 
LeCroy), problems caused by use of accessories, parts or components not supplied by 
LeCroy, Products that have been modified or altered by someone other than LeCroy, 
Products with missing or altered service tags or serial numbers, and Products for which 
LeCroy has not received payment in full.

Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty that are 
returned directly to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy 

Customer Support 
3385 Scott Blvd. 
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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How to Obtain Warranty Service
To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report your 
covered warranty claim by contacting LeCroy Technical Support or its authorized 
representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at 
support@catc.com. You may also refer to the LeCroy website at http://www.lecroy.com 
for more information on how to contact an authorized representative in your region. If 
warranty service is required, LeCroy or its authorized representative will issue a Return 
Material Authorization Number. You must ship the Product back to LeCroy or its 
authorized representative, in its original or equivalent packaging, prepay shipping 
charges, and insure the shipment or accept the risk of loss or damage during shipment. 
LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the 
repaired or replacement Product to you freight prepaid by LeCroy if you are located in the 
continental United States. Shipments made outside the continental United States will be 
sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy 
does not accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or 
reconditioned parts, at its sole discretion, made by various manufacturers in performing 
warranty repairs. If LeCroy repairs or replaces a Product, the Warranty Period for the 
Product is not extended.

If LeCroy evaluates and determines there is “no trouble found” in any Product returned 
or that the returned Product is not eligible for warranty coverage, LeCroy will inform you 
of its determination. If you thereafter request LeCroy to repair the Product, such labor and 
service shall be performed under the terms and conditions of LeCroy's then current repair 
policy. If you chose not to have the Product repaired by LeCroy, you agree to pay LeCroy 
for the cost to return the Product to you and that LeCroy may require payment in advance 
of shipment.
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General Provisions
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY 
FOR DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND 
REPLACEMENT AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. 
EXCEPT AS EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY PRODUCT 
INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF AND 
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF 
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME 
JURISDICTIONS MAY NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS, SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN 
THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, ANY LIABILITY 
FOR THIRD PARTY CLAIMS AGAINST YOU FOR DAMAGES, PRODUCTS NOT 
BEING AVAILABLE FOR USE, OR FOR LOST DATA OR SOFTWARE. LECROY'S 
LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR THE 
PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO 
YOU.

The limited warranty on a Product may be transferred for the remaining term if the then 
current owner transfers ownership of the Product and notifies LeCroy of the transfer. You 
may notify LeCroy of the transfer by writing to Technical Support at LeCroy, 3385 Scott 
Blvd., Santa Clara, CA 95054 USA or by email at: support@catc.com. Please include the 
transferring owner's name and address, the name and address of the new owner, the 
date of transfer, and the Product serial number.



 Limited Hardware Warranty UWBTracer/Trainer  User Manual

296 LeCroy Corporation

                                                       [blank page]



UWBTracer/Trainer  User Manual  Index

LeCroy Corporation 297 

Index

Symbols
.dec decoder files 99
.dec files 79
.dl files 128
.dsc files 287
.lic file 280
.opt files 75, 77
.req files 287
.uwbg files 233
.uwbg traffic generation files 226

A
Abbreviated data frames 99
Abort or Continue Uploading dialog box 218
About UWBTracer/Trainer

command 274
window 274

Abstract Control Model .dec file 79
Accumulators section 121, 122
Action

button 195
pop-up menu 195
Properties dialog 196

actions
assigning 193
events 193, 198

Actions submenu 197
Adapter Cable for SCSI 13
Add Analyzer Network Node dialog box 157
Add command 131, 132
Add Connection Context dialog box 132
Add Counter option 197
Add New Device button 129, 135, 168
Add New Device dialog box 129, 168
Add New WSS dialog box 135
Add Temporal Key dialog box 131
AddMissingFields parameter 251
Addr field 83
Advance the Sequence button 196
Agreements 273

Alias field 129
All Connected Devices command 154
All Markers window 35
Analyzer checkbox 154
Analyzer Devices dialog box 154
Analyzer Network Chat 160
Analyzer Network Chat Bar command 160
Analyzer Network Chat dialog 160
Analyzer Network command 156
Analyzer Network dialog box 156
Analyzer Plug-in Module 8, 11
Analyzer Speed options 184
analyzers

cable connection 159
multiple 153
synchronization 158

AND events 71
ANT connector 15, 17
antenna 8, 11
antenna connector 15, 17
Any Device checkbox 181
API 3
application programming interface 3
ARP 99
Array data types 227
assigning actions 193
Association frames 99
ATM Networking Control Model .dec file 79
Audio Class .dec file 79
Audio Class decoding 2.0 79
audio.req file 287
Auto-Detect speed 185
automatic update 276
Automation API 3
AutoReset property 256
AUXILIARY Connector 17
Available Events Area 186

B
Background Checks.vse file 289
Band Group/TF Code field 179
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Band IDs field 179
basic components 8
Beacon Format checks 289
Beacon Format Test.vse script 289
Beacon Period Synchronization.vse script 289
Beacon Period view 145
Beacon Protocol checks 289
Beacon Protocol Observation Background 
Tests.vse script 289
Beacon Slot 152
Beacon Slot Collision Test.vse script 289
beacon slot collisions 289
Beacon Slot Frame field 152
beacon switch 181
Beacon/WUSB Timing Analysis command 142
Beep When Trigger Occurs option 175
binary files, debugging 175
Bit Order section 77
blue highlight 237
bluetooth.req file 287
Board Adapter for Hirose 608-pin Connectors 13
Board Adapter for Hirose 68-pin Connectors 13
Board Adapter for IDE 40-pin Connectors 13
Bookmarks 237
Both Decrypted and Original option 181, 183
BPOIE contents 145
BPST Delta field 152
BPST field 152
branching 210
Break Link command 245
Bridge 134
brown highlight 237
BT .dec file 82
buffer 176

size 176
Buffer Size slide bar 176
Build menu 229
build number 274
Bulk/Int Transfer field 85
burst preamble 181
Burst property 253
Bus Utilization 75, 123
BusEngine

files 273
updating 276

BusEngineRawTracexxxx.dat file 175
buttons

bus utilization 124

C
C&I Platform Test Specification 289
Cable Adapter 12
Cable Based Association Framework .dec file 82
cables

pin assignments 283
Calculate button 106
Calculate Delta Time from the Previous Frame 74
calculating timing 34
CAPI Control Model .dec file 79
Carrying case 8
CATC 5K platform 8
CATC BusEngine protocol processor 3
CDID 132
CDID field 133
CD-ROM for installation 8
Cell pop-up menu 194
cells 191

highlight 192
types 191

Certified Wireless-USB protocol 6
Certified WUSB 131
Certified WUSB hosts and devices 167
Change Default Location command 177
channel

selecting 179
Channel 0 Speed 185
channel change 181
Channel field 44, 121, 122, 179
Channel Sync Mode section 179
Channel Time Axis 149
Chart Title 146, 149, 151
CHID field 132
chirp detection 185
CK 132
class definition files 79, 287
Class request, decode 93
Class/Vendor decoding 83
Class/Vendor Decoding field 83
Class/Vendor Decoding Groups menu 84
Class/Vendor Endpoint Decoding

field 85
menu 86

Class/Vendor endpoint RPipes decoding 89
classes 287
clean.uwb files 23
Clear marker command 33
Clock Accuracy.vse script 289
collapse 238
Color section 76
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Color, Format, and Hiding tab 75
colors

options 29
setting 76

command modifiers 237
Command Properties window 237, 261
commands 237
comma-separated-values text file 40
Comment field 31
Comment for an element 246
comments 31, 227, 237
Communication Device Subclass/EEM .dec file 79
communication.req file 287
Communications and CDC Control .dec file 79
Communications Device Class (CDC) Data 81
Communications Device Class (CDC) Data .dec file 
81
Compile command 244
Compliance and Interoperability Platform Test 
Specification 289
Compliance scripts 289
components 8
condition elements 250
Condition Name property 256
Condition Register Elements 255
Condition Register Elements window 246, 255
Config Status Indicator 186
Configuration Name setting 75
configuring

Exerciser 225
Connection Context 167
connection context 131
connection contexts 130, 132, 133, 134
connection device 167
connection host ID 167
connection key 167
connections

devices 162
Connector element 251
connectors 291
Context area 72
Continue capturing MPI signals during PHY Reset 
Cycle 182
Continue Loop element 250
Continue option 218
Control frames 99
Control Transfer field 90
Copy Event to option 197
copying events 197
copyright notice ii
Counted Loop element 250

Counter property 256, 259
counters 197

setting 206
cross triggering 158
CS bus 185
CTAs 148
CTRL key 109
Current script position field 236
Current Text Panel 146, 149, 151
Custom tab 76

D
data

formats 76
invalid 76
traffic 39

Data frames 99
Data options 75
data types 76
data.uwb file 39
date and time data 76
debug binary file 175
Debug section 175
Decode

buttons 27
decoding options 83
general options for requests 90

decode
class request 93
endpoint 94
endpoint RPipes 89
hub status 94
layout 97
request recipient 83
Request RPipe 88
requests 92
standard request 92
toolbar 28
vendor requests 94

Decode ... Request command 93
Decode as ... Endp command 94
Decode Standard Request command 92
decoded traffic 47
decoder files 79
decoding

assigning 83
refresh 90

Decrypted (Secured) + Non-Secured Traffic Only 
option 181
Decrypted (Secured) Traffic Only option 183
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decryption 167
default file name 39
default values 227
default.rec recording options file 177
delay values for the PHY 183
Delete button 197
Delete Device button 136
Delete This Event option 197
deleting events 197
Delta Time field 152
deriving temporal keys 167
Description for an element 246
Description of element 261
DevAddr 171
DevAddr collisions 289
device address 171
Device Address field 129
Device List dialog box 168
Device List window 128
Device Management Model 79
Device Tracking section 181
Device Type field 129, 169
Device Wire Adapter .dec file 82
devices

adding 129
connections 162
deleting 136
editing 133

Devices to Track section 181
device-specific errors 119
dimensions 291
Direct Line Control Model .dec file 79
direction

search 39
Direction field 85
Direction of find 72
disclaimer notice ii
Display License Information 278
Display Options

command 73
General tab 74
loading 77
saving 77
window 73

displaying traces 47
downloading 275
dragging buttons 191
DRP reservation rule 152
DRP Tm field 152
Duration Axis 146
DUT checkbox 169

DUTs checkbox 129

E
Edit Comment command 31
Edit Device button 133, 136
Edit Device dialog box 168
Edit Marker command 33
Edit Marker for Frame # comment window 33
Edit menu 229
Edit script command 140
Edit Trace Comment Dialog box 31
editing

script 237
electronic text messages 160
Element Comment 246, 261
Element Type 246, 261
Element Unique ID 246, 261
elements 246
Else element 250
Enable IntelliSense option 238
Enable Outlining option 238
Enable Tips setting 74
encrypted traffic 167
Encrypted/Decrypted Recording 181, 183
encryption

keys 130
End Else element 250
End If element 250
Endp field 85
Endpoint RPipes

dialog box 89
tab 89

Endpoints
dialog box 85
tab 85

endpoints
decoding 94
RPipes 89

environmental conditions 291
Error Occurrences graph 119
Error Report setting 74
Error Summary command 105
Errors

Header 120
PHY Payload 119
PHY Unsupported Rate 119
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errors 237, 238
count 105
device-specific 119
general 119
summary 105

Errors occurrences graph 116
Errors report 107
Errors window 234
Ethereal/Wireshark format 40
Ethernet Networking Control Model .dec file 79
Ethernet protocol data units 99
Ethernet subfolder 101
EUI-48 field 129
Event buttons

creating 190
dragging 191

Event Groups pane 62
Event Navigation

menu 110
options 110

Event pop-up menu 197
Event Properties dialog 197
Event Trigger recording type 175
events 198

actions 193, 198
buttons 190
context 72
copying 197
deleting 197
displaying 53
examples 204
filters 209
finding 61
logical relations 71
moving 197
OR 207
searching 53, 61

examples
events 204

exclusion of events 71
executing 236
Exerciser

configuring 225
Exerciser plug-in module 11
expand 238
Expand All Timing Analysis Fields 152
Expand Timing Analysis 152
expiration

maintenance 278
Export Options section 41
Export To Script button 43

Export to UWBTrainer Exerciser Script dialog box 
43
exporting 40

Trace to a Traffic Generation File 272
Exporting Packets to CSV Text 40
Exporting Packets to Ethereal/WireShark Format 
40, 42
Exporting Packets to Text 40
expressions 227
EXT DATA connector 18
External Trigger Input option 175
External Trigger Pulse

HIGH option 196
LOW option 196
TOGGLE option 196

External Trigger signal 199
External Trigger Signal behavior 203
External Trigger Signal dialog 200

F
false chirp detection 185
features 4, 21

named 278
physical 7

fields
formats 76
hiding 77
options 75

File Information window 104
File menu 23, 229
file name

default 39
File Tabs 237
files

.dsc 287

.req 287
BusEngine 273
decoder 79
firmware 273
sample 22
script 79, 287
Script Decoder 82
trace 177

Filter In
action 195
option 195

Filter Out
action 195
option 195

filtering in 209
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filters 186
events 209

Find
command 61
window 62

Find All option 72
Find Next Occurrence command 90
Find window 61
Fine Time Adjustment property 253
firmware

files 273
updating 276

Flip Link Direction command 245
Flow Elements 247
Flow Elements window 246, 248
Flush option 218
Follow Beacon Switch checkbox 181
Follow Burst Preamble checkbox 181
Follow Channel Change checkbox 181
Fonts

changing 75
options 75

Force Resynchronization checkbox 180
Format

options 29
section 76

formats
field 76

formatting traces 28
Four-Way-Handshake protocol 167
Four-Way-Handshakes 131
frame duration 152
Frame left-click menu 142
Frame Occurrences graph 117, 118
Frame Type property 253
FrameDelay parameter 251
Frame-Level view 48, 51
frames

beginning 39
displaying 54
markers 55
marking 31

Frm Duration field 152
From Frame field 44
front panel 14, 17
FS terminations 185
FS_K state 185
Full Buffer button 219
Full speed 185

G
General buttons 26
general errors 119
General Miscellaneous dialog box 175
General Settings tab 129, 168
General Statistics area 114, 121
General tab

Display Options 74
Recording Options 173, 174

Generated DevAddr Conflict Test.vse script 289
generating 225, 236

theory 226
Generation menu 230
Generator Script files 227
Go to

command 56
Frame/Packet/Transaction/Transfer command 

54
Marker command 31, 55
Trigger command 53

Graph area 114
Graph Area Properties dialog box 116
Graphical Scenario Editor 245
Graphics Toolbar buttons 232
graphs

Graph Areas menu 126
green comments 237
Grid Lines option 109
Grid View 128
Group and Color column 76
group axis 149
Group Temporal Keys 171

H
Hand for timing analysis 144
handshakes 131
HCS error slot collisions 289
Header Error 120
Headers 48
Help command 237
Help menu 25, 230, 274
HID .dec file 80
hid.req file 287
Hidden checkbox 77
Hide

buttons 27
options 29

Hide WiMedia PHY-MAC headers for decoded 
frames 74
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Hiding section 77
Hierarchy Lines setting 74
High Speed

recordings 185
High speed 185
highlighting 237, 245
HOST connector 18
Host field 83
Host Wire Adapter .dec file 82
HS bus 185
HS terminations 185
HTML or a Grid Format button 128
HTML View 128
Hub .dec file 80
hub.req file 287
humidity 291
HUT .dec file 80

I
IFS field 152
Include statement 226
Include statements 237
independent sequences 215
Insert Time Markers button 144
Installation CD-ROM 8
Integer literals 227
Intellisense 238
Interface Association Descriptor .dec file 82
inter-frame spacing 152
Internet Protocol units 99
intersection of events 71
invalid data 76
Investment Protection Agreement 273
IP 99
IP LAN 155
IP subfolder 101
Item Under Cursor window 146, 149, 151

K
Keep Across Recordings checkbox 84
KeepOldTrace 251
keys

temporal 130, 167

L
L graphic 245
LAN 155
language 227
Launch WireShark/Ethereal in Full Screen 41

layout 97
Layout command 98
LeCroy website 275
LED 14
left mouse button 28
Legend 146, 149, 151
levels

traces 48, 51
license

agreement 280
information 278
key 273, 280
updating software 280

License Information window 278
License Protection Message 279
line numbers 238
Link Label command 245
linking states 196
links 245
Links menu 230, 245
literals 227
local area network 155
loop elements 250
looping 210
Loss-of-Sync Timeout field 180
Low speed 185
LQI By Device section 121, 122

M
MAC Addr (Address) Mask field 181
MAC-PHY Interface bus 3
MAC-PHY Interface Frame trace viewing level 48, 
51
Main Display Area 186
Main Toolbar buttons 231
main window 21
Maintenance Agreement 273
maintenance expiration 278
Manual Trigger

recording type 175
Map Endpoint to Class/Vendor Decoding command 
85
Map Request Recipients to Class/Vendor Decoding 
command 83
Marker bar 33
markers 31

clearing 33
displaying 55
editing comments 33
setting 31
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Mass Storage .dec file 80
Match on Rx Frame Info parameter 259
menu bar 23, 229
menus

graph areas 126
view settings 125

merge 158
messages 160

recording 39
Misc button 175
MMC packets 148
Mobile Direct Line Model 79
Monitor .dec file 80
Move Event to option 197
Move right within header 152
moving events 197
MPI

checkbox 182
section 182
tab 173

MPI ADAPTER connector 15
MPI Adapter connector 15
MPI bus 3
MPI button 48, 51
MPI channel 14
MPI indicator 14
MPI Kit 12
MPI section 182
MPI Wire Activity section 121
Multi-band OFDM

technology 5
multichannel analyzer 158
Multi-Channel Control Model .dec file 79
multiple analyzers 153
multiple channels 158
multi-state sequences 189, 210
MUXProtocols folder 100

N
navigating

frames and packets 112
network 155
Network Chat 160
New Event

button 190
option 194
pop-up menu 190

New script command 140
No Decoding option 84
No link 245

NOT event 71
not secured traffic 181, 183
notation 227
Notifications and Help segment 36
number data 76
Number of analyzer devices connected section 
121, 122
numbers 76

O
OBEX Model 79
Only DUT checkbox 181
Open Recording Options in a dialog link 104
open trace, verification script 137
operating range 291
options

checkboxes 175
recording 177

Options button 238
Traffic Summary 109

options files 75
recording 177

Options menu 238
Options Name field 177
OR events 71, 207
Origin of find 72
Original (Secured or Non-Secured) Traffic only 
option 181, 183
original traffic 181, 183
outlining 238
out-of-synchronization 180
output signals 196
Output tab 234
output windows 139
Override property 253

P
packet errors 76
packets

displaying 54
Pair-wise Temporal Key 167
panels 14, 17
parameters 237
Partial option 218
Partial Upload 218
Partial Upload button 218, 219
Path to WireShark/Ethereal 41
Payload 48
PCLK clock pulse 182
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Photographic and Imaging Manufacturers 
Association 81
PHY Payload Error 119
PHY Timing 183
PHY Unsupported Rate 119
PHY/MAC Headers 48
PhyActiveDelay PHY Timing parameter 183
Physical .dec file 80
physical features 7
Physical Interface .dec file 80
Picture Transfer Protocol .dec file 81
PIMA 81
pin assignments

cables 283
platform 8

status 14
PLCP/Packet/Transaction/Transfer dialog box 54
Plugin Init files 273, 276
Plug-in Module 8, 11
Point of Sale Devices .dec file 80
Pointer for timing analysis 144
pop-up menus 28

Recording Rules 187
position

initial 39
post-process analysis 137
post-triggering

percentages 176
Power .dec file 80
POWER 12 VD connector 18
power requirements 291
power supply 8
predefined values 237
Printer .dec file 80
printer.req file 287
Prior BP column 145
Probe Cable for IDE 40-pin Connectors and Hirose 
68-pin Connectors 13
probe cables

pin assignments 283
probe connector 4
program

starting 21
Progress Bar and Progress Report segment 36
Progress Indicator 38
Prompt each time option 110
Properties

Graph Area 116
option 194

Properties options
actions 196
events 197

Property Dialog option 146, 147, 151
protocol

information 107
units 114

PTK 131
PTK values 130
PTP .dec file 81
Pulse High format 196
Pulse Low format 196
Purchased column 278

R
range

by type 110
Readme file 274
Real-Time Statistics

buttons 115
setting 75
window 114
window tool bar 115

rear panel 18
Recently Used Elements window 246
Recipient field 83
Record menu 24
Recorded Data files 39
recording

activity 39
messages 39
multiple traces 160
progress 38
starting 217
status 39
stopping 217

Recording button 217
recording elements 251
Recording Multi-Trace Files 160
Recording Options

command 173
default 177
miscellaneous 182
window 173

Recording Rules 198
page 186, 189
pop-up menus 187
tab 173
toolbar 186, 188

Recording Status window 39
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Recording Type box 175
red errors 237, 245
red square 238
reference points 34
refresh 90
Refresh Decoding for this Trace File command 90
registration card 293
remote access 155
Remote Analyzers Over an IP Network 156
Remote Bridge 134
Remote NDIS 82
Remote Network Driver Interface Specification 
(RNDIS) 82
Remove Identifying Info from Trace Files 23
Report menu 24, 103
reports 103
Reports buttons 27
Request Recipient and Endpoints dialog box 83
Request RPipes 88

dialog box 88
tab 88

requests 287
Reset Condition element 250
Reset Range to Whole Trace button 44
Reset Timer element 249
Restart All option 196
restart options 196
Restart the Sequence option 196
Restore Factory Presets command 75
Return Material Authorization Number 294
Reupload command 219
Reuploading 219
Revoke Condition element 250
RF

tab 173
RF and MPI

recording options 178
RF channel 14
RF checkbox 178
RF indicator 14
RF tab 178
Right click cell context menu setting 74
right mouse button 29
ring 158
Row Selection option 109
rows

timestamped 47
RPipe field 88
RPipes 88

endpoints 89
RSSI By Device section 121, 122

rules
restarting 196
validity 186

Run scripts command 139
Run verification script command 140
Run Verification Scripts command 137
Run verification scripts dialog 138

S
sample files 22
Samples on Negative Edge of PCLK checkbox 182
Save as Default button 177
Save exported data in file field 44
Save External Interface Signals option 175
Scan Channels checkbox 179
Scan Time per Channel field 180
scheduled time windows 148
script 236

editing 237
language 227
syntax 227

Script Decoder
files 82
Manual 82

Script Decoding language 82
Script Edit Window 237
Script Editor

tooltips 238
script files 79, 99, 287
script list 139
Script Toolbar buttons 232
script-based decoders 99
scripts 225
Scripts directory 79, 99
scroll bar 30
SCSI/Bulk Protocol .dec file 80
Search

command 53
menu 24, 53

search
all 72
direction 39, 72
hidden 72
origin 72

Search Direction segment 36
searching 53
secured decrypted traffic 181, 183
secured traffic 167
Select Sync Channel window 179
Selected Item window 146, 149, 151



UWBTracer/Trainer  User Manual  Index

LeCroy Corporation 307 

Selected Text Panel 146, 149, 151
Send button 160
Send Frame Elements 252
Send Frame Elements window 246, 252
Send Time Method property 253
Send Time Method Value property 253
Sequence cells 191
sequences

independent 215
restarting 196

serial number 274
servicemarks ii
Set External Trigger button 199
Set Marker feature 31
settings

views 30
Settings command 140, 141
Settings dialog 141
Settings element 251
Setup menu 23, 277
Show Channel Time Axis option 149
Show Chart Title option 146, 149, 151
Show Current Text Panel option 146, 149, 151
Show Description window command 140
Show Duration Axis 146
Show Grid command 140
Show hidden items option 110
Show in Timing Analysis View command 143
Show Legend option 146, 149, 151
Show Line Numbers option 238
Show Output command 140
Show Selected Text Panel option 146, 149, 151
Show Slots Axis 146
Show SuperFrame Axis 146
Show Superframe Axis option 151
Show Time Axis 146
Show Title Axis option 146, 149
Show Tooltips option 238
Show Trans Group Axis option 149
Show/Hide ... when Timing Analysis is Collapsed 
152
Signal Capture section 182
signals

output 196
single-state sequence 189
Skip hidden items option 110
Slot Offset 152
Slots Axis 146
Smart Card .dec file 81
Smart Card Class 81
Snapshot recording type 175

software
features 21
license 280
license key 273
starting 21
updating 273, 275
version checking 274

specifications 291
Specify Action option 197
Specify Trace File Name dialog box 177
SrcID (Source ID) Mask field 181
Standard colors 76
Standard data frames 99
standard.req file 287
Start command 175, 217
Start Export command 41, 44
Start Recording button 175
Start Timer element 249
Start Trace element 251
starting

software 21, 228
State cells 191
states

linking 196
Status bar 36, 234, 236
STATUS indicator 14
Status segment 36
Still Imaging Class .dec file 80
Stop button 217, 218
Stop command 217, 218
Stop option 218
Stop Recording button 175
Stop Timer element 249
Stop Trace element 251
storage range 291
Store into Raw Data Debug file checkbox 175
String literals 227
summary

statistics 114
traffic 107

SuperFrame Axis 146
Superframe Grid view 150
SuperFrame index 146
SuperFrame Period parameter 251
Support 294

page 275
SYNC IN connector 18
SYNC OUT connector 18
Sync to Channel checkbox 179
SyncDelay PHY Timing parameter 183
synchronization 158
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Synchronization Cable 9
synchronizing 144
syntax 227

T
tabs 237
TCP 99
Technical Support 294
Telephone Control Model .dec file 79
Template Name property 253
Temporal Key tab 130
temporal keys 130, 131, 167

group 171
ID 171
pair-wise 167

Test Case 6 289
Test System output 289
testing 225
text 76
text file 40
Text Snippets window 239
text-editing commands 237
theory 226
three analyzers 159
Three-Year Investment Protection Agreement 273
Tight Columns option 109
Tiiming Analysis fields left-click menu 152
Time Axis 146
time axis 146, 149
Time from Marker command 34
time marker 144
time selection 144
time windows 148
timeout period 180
Timeout property 259
TIMER conditon 249
timer elements 249
times 76
Timestamp At The Beginning setting 74
Timestamp field 152
time-stamped rows 47
timestamps

synchronization 158
TimeVar Index property 253, 256, 259
timing 106

calculations 34
events 34

timing analysis 142
fields 152
synchronizing 144
time marker 144
time selection 144
views 145
zoom 144

Timing Analysis button 142
Timing Analysis buttons 144
Timing Analysis Display Options for Beacon Period 
View menu 146
Timing Analysis Display Options for WUSB Detail 
menu 149, 151
Timing Analysis toolbar 144
Timing Analysis window 142
Timing and Bus Usage Calculator 34
Timing Calculations command 106
Timing Calculator 106
tiny-J 185
Title Axis 146, 149
TK 131
TKID 131
To Frame field 44
Toggle Outlining option 238
Tool Tips 22
Toolbar 26, 231

Recording Rules 186
tooltips 238, 245
trace files 177

names 177
opening 22
recordings 177

Trace View 4
displaying 73

Trace Viewing Level
icons 47
section 47
setting 74
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traces
decoded 47
displaying 73
displays 47
file information 104
finding 61
formatting 28
items 56
levels 48, 51
manipulating 47
merging 158
multiple recording 160
navigating 112
navigation 110
range 110
reading 47
searching 53
statistics 114
tooltips 22
viewing levels 48, 51

trademarks ii
traffic

analyzing 103
data 39
decoded 47
encrypted 167
generating 225, 236
secured 167
summary 107

traffic generation prep 233
Traffic heading 149
Traffic Summary

Email 108
errors 105
example 108
navigating 112
options 108, 109
range 108, 110
setting 74
toolbar 108
window 107

Trans Group Axis 149
transaction group axis 149
Transaction Group heading 149
transfers

displaying 54
transitions

displaying 54

Trigger
button 175
event 175
option 195
options 196
position 176

Trigger Cable 9, 161
Trigger element 251
trigger events

displaying 53
Trigger Position

settings 176
slide bar 176

triggering 39
across 158

triggers
displaying 53
position 176
setting 186

TRIG-IN/TRIG-OUT BNC Y-cable 161
two analyzers 159
two copies 153
Tx Sleep element 251
TX-only tests 289
Type field 83

U
UDP 99
UFI(floppy)/CBI Protocol .dec file 80
Unhide Cells command 29
union of events 71
UnitAgent application 158
units 114
Universal Serial Bus Specification 93
Until Loop element 250
Update button 277
Update command 280
Update Device command 277
Update License

command 280
dialog box 280

Update UWBTracer/Trainer dialog box 277
updates

license 278
updating

automatic 276
BusEngine 276
firmware 276
manual 277
software 273, 275
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upload
automatic 217
partial 218

Upload Again with New Buffer Settings dialog box 
219
Upload Selection button 219
uploading 39

activity 39
USB

cables 153
connections 153

USB Assoc Capture Settings checkbox 184
USB Assoc tab 173
USB Assoc. page 184
USB Association Capture Settings recording 
options 184
USB bus 185
USB Connected Analyzers 154
USB Device Requests 90
USB Implementers Forum 6, 93
USB TRA button 49
USB XFR button 50
USB/WUSB Device Request menu 90
USB-IF 6, 93
User input 225
User Notes field 129
UWB .dec file 82
UWB Analyzer Plug-in Module 8, 11
UWB Device List Saved File 128
UWB technology 3, 5
UwbRxChannel parameter 251
UWBTrainer buttons 26, 232
UwbTxChannel parameter 251
UwbTxPower parameter 251

V
vendor definition files 79, 287
vendor.req file 287
verification script 137
Verification Script Engine Reference Manual 137
Verify Test Case.vse file 289
version

checking 274
number 273

Vertical Stand 8
Video Class .dec file 81
Video CONTROL .dec file 81
Video INTERFACE COLLECTION .dec file 81
Video STREAMING .dec file 81
View ... Fields Dialog Layout dialog box 98

View Fields for ... Class Requests text box 93, 94
View Fields for ... Endp text box 94
View Fields for Standard Request text box 92
View menu 25, 230
View Toolbar buttons 231
viewing levels 48, 51
views

settings 30
timing analysis 145

VSE Compliance scripts 289

W
WAddr field 88
Wait commands 225
Wait Condition element 249
wait elements 249
Wait For Frame/Header Elements 258
Wait for Frame/Header Elements window 246, 258
Wait For SuperFrame element 249
Warnings 238
warranty

coverage 293
limited 293
period 293
service 294
transferring 295

WASEG button 50
WAXFR button 50
website 273

LeCroy 3
USB-IF 6
WiMedia 5

weight 291
WiMedia Alliance 5
WiMedia Compliance and Interoperability Platform 
Test Specification 289
WiMedia Frame level 51
WiMedia UWB specification 6
WiMedia UWB specifications 5
WiMedia-compliant devices 3
window

main 21
Window menu 25, 230
Wire Adapter .dec file 82
Wire Adapter devices 6
Wire Adapter Multifunction Peripheral programming 
interface 82
Wireless Controller .dec file 82
Wireless Handset Control Model 79
Wireless Personal Area Network 5
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Wireless USB view 148
Wireless-USB devices 5
Wireless-USB protocol 6
WireShark/Ethereal format dialog box 41
WireShark/Ethereal Options section 41
WLP button 51
WLP Frame level 51
WLP frame types 99
WLP level 99
WLP overview 6
WLP Settings 134
WLP subfolder 100
WLP_Devices line 135
WLP_Settings tab 134
WNETH button 52
WNIP button 52
WPAN network 5
Wrap setting 74
wrapping 30
WSS Group

editing 136
WSS group 135
WUSB Connection Context 131
WUSB Device Requests 90
WUSB devices 5, 167
WUSB Four-Way-Handshakes 131
WUSB hosts 167
WUSB Packet-Level view 49
WUSB PKT button 49
WUSB Settings 131
WUSB Settings tab 132
WUSB Transaction-Level view 49
WUSB Transfer-Level view 50
WUSB Wire Adapter Segment-Level view 50
WUSB Wire Adapter Transfer-Level view 50
www.LeCroy.com/support.html file 275

Y
yellow square 238
Yes link 245

Z
Zip file 275
Zoom Level setting 74
Zoom timing analysis 144
zooming 30
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